# Table Of Contents

## Getting Started .................................................................................. 1

- What's New in this Release .........................................................................1
- Previous Enhancements ............................................................................1
  - Voice Announcement Manager Release 5.0 ..............................................1
  - Voice Announcement Manager Release 4.0 ..............................................1
  - Voice Announcement Manager Release 3.1 ..............................................2
  - Voice Announcement Manager Release 3.0 ..............................................3
  - Voice Announcement Manager Release 2.1 ..............................................3
  - Voice Announcement Manager Release 2.0 ..............................................3
  - VAL Manager Release 1.3 .......................................................................4
  - VAL Manager Release 1.2 .......................................................................5
  - VAL Manager Release 1.1 .......................................................................5

- What can I do with Voice Announcement Manager? ..................................6
  - Basic Features .........................................................................................6
  - Understanding Announcements with Voice Announcement Manager .........6
  - What Do You Want To Do? ......................................................................6

- Where do I Begin? ....................................................................................8

- Understanding the Voice Announcement Manager Main Window ...............9
  - Related Topics .......................................................................................9

- Main Window Details ..............................................................................10
  - Voice Announcement Manager Toolbar ................................................10
  - Menus ......................................................................................................12
  - Voice Announcement Manager Tree ......................................................18
    - What can I do with this tree? ..............................................................18
  - Display Area ..........................................................................................19
    - What can I do with this display area? ................................................19
  - Status Pane ............................................................................................20

- How Voice Announcement Manager Works .............................................21
  - Connecting to your voice system ............................................................21
  - Administering Announcements ..............................................................21
    - Backing up and Restoring Audio Files and Announcement Properties ... 21

- Voice Announcement Over the LAN (VAL) .............................................23

- What is a Virtual VAL Board? .................................................................24
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing Virtual VAL Board Status</td>
<td>46</td>
</tr>
<tr>
<td>Related Topic</td>
<td>46</td>
</tr>
<tr>
<td>Voice Announcement Manager Security</td>
<td>47</td>
</tr>
<tr>
<td>Testing Connectivity</td>
<td>48</td>
</tr>
<tr>
<td>Testing a Connection</td>
<td>49</td>
</tr>
<tr>
<td>Troubleshooting Voice Announcement Manager</td>
<td>50</td>
</tr>
<tr>
<td>Connection Errors</td>
<td>50</td>
</tr>
<tr>
<td>Related Topics</td>
<td>50</td>
</tr>
<tr>
<td>Error Messages</td>
<td>51</td>
</tr>
<tr>
<td>Access Denied</td>
<td>51</td>
</tr>
<tr>
<td>ASG is Enabled</td>
<td>52</td>
</tr>
<tr>
<td>ASG is not Enabled</td>
<td>53</td>
</tr>
<tr>
<td>General Communications Error</td>
<td>54</td>
</tr>
<tr>
<td>Incorrect Login</td>
<td>55</td>
</tr>
<tr>
<td>Invalid Password</td>
<td>56</td>
</tr>
<tr>
<td>Network Connection Failed</td>
<td>57</td>
</tr>
<tr>
<td>Password has Expired</td>
<td>59</td>
</tr>
<tr>
<td>Data is Locked</td>
<td>60</td>
</tr>
<tr>
<td>Remote Reset</td>
<td>61</td>
</tr>
<tr>
<td>Too Many Users Logged In</td>
<td>62</td>
</tr>
<tr>
<td>Unexpected Response from Device</td>
<td>63</td>
</tr>
<tr>
<td>Using Ping</td>
<td>64</td>
</tr>
<tr>
<td>Using Tracert</td>
<td>65</td>
</tr>
<tr>
<td>Troubleshooting a Computer Network Cable</td>
<td>66</td>
</tr>
<tr>
<td>Troubleshooting Computer Network Problems</td>
<td>67</td>
</tr>
</tbody>
</table>

**Using Voice Announcement Manager** .......................... 69

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a Voice System Login for Voice Announcement Manager</td>
<td>69</td>
</tr>
<tr>
<td>Creating a New Announcement</td>
<td>72</td>
</tr>
<tr>
<td>Copying Audio Files to and from a Voice System</td>
<td>73</td>
</tr>
<tr>
<td>Viewing Announcement Properties</td>
<td>74</td>
</tr>
<tr>
<td>Entering New Announcement Properties</td>
<td>75</td>
</tr>
<tr>
<td>Changing Announcement Names</td>
<td>76</td>
</tr>
<tr>
<td>Changing Announcement Properties</td>
<td>78</td>
</tr>
<tr>
<td>Deleting Audio Files</td>
<td>79</td>
</tr>
<tr>
<td>Deleting Announcement Properties</td>
<td>80</td>
</tr>
<tr>
<td>Deleting Voice Systems from Voice Announcement Manager</td>
<td>81</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Creating an Audio Group</td>
<td>115</td>
</tr>
<tr>
<td>Modifying an Audio Group</td>
<td>116</td>
</tr>
<tr>
<td>Deleting an Audio Group</td>
<td>117</td>
</tr>
<tr>
<td>Moving Audio Groups into Different Folders</td>
<td>118</td>
</tr>
<tr>
<td>Searching</td>
<td>119</td>
</tr>
<tr>
<td>Searching for Audio Files</td>
<td>119</td>
</tr>
<tr>
<td>Searching for Announcement Property Files</td>
<td>120</td>
</tr>
<tr>
<td>Searching for VAL Sources in an Audio Group</td>
<td>122</td>
</tr>
<tr>
<td>Replacing VAL Sources in an Audio Group</td>
<td>123</td>
</tr>
<tr>
<td>Scheduling</td>
<td>124</td>
</tr>
<tr>
<td>Creating a Task</td>
<td>124</td>
</tr>
<tr>
<td>Modifying a Task</td>
<td>125</td>
</tr>
<tr>
<td>Deleting a Task</td>
<td>126</td>
</tr>
<tr>
<td>Stopping a Scheduled Task</td>
<td>127</td>
</tr>
<tr>
<td>Deleting Completed Tasks</td>
<td>128</td>
</tr>
<tr>
<td>Using Templates</td>
<td>129</td>
</tr>
<tr>
<td>Creating a Template</td>
<td>129</td>
</tr>
<tr>
<td>Modifying a Template</td>
<td>130</td>
</tr>
<tr>
<td>Deleting a Template</td>
<td>131</td>
</tr>
<tr>
<td>Screen Reference</td>
<td>133</td>
</tr>
<tr>
<td>Voice Announcement Manager Toolbar</td>
<td>133</td>
</tr>
<tr>
<td>Menus</td>
<td>135</td>
</tr>
<tr>
<td>Voice Announcement Manager Tree</td>
<td>141</td>
</tr>
<tr>
<td>What can I do with this tree?</td>
<td>141</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>142</td>
</tr>
<tr>
<td>Announcement Properties Window</td>
<td>143</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>144</td>
</tr>
<tr>
<td>Announcement Property Dialog Box</td>
<td>145</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>146</td>
</tr>
<tr>
<td>Back Up Audio Files and Announcements Properties Dialog Box</td>
<td>147</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>147</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>147</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>147</td>
</tr>
<tr>
<td>Back Up Selected VAL Boards and Groups Dialog Box</td>
<td>148</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>148</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>148</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>148</td>
</tr>
</tbody>
</table>
Voice Announcement Manager User Reference

Broadcast Announcement Files - Select Files by Extension Dialog Box .....149
  How can I view this dialog box? .............................................................149
  How do I use this dialog box? .............................................................149
  What do you want to do? .................................................................149

Broadcast Announcement Files - Select Files Dialog Box ..................150
  How can I view this dialog box? .............................................................150
  How do I use this dialog box? .............................................................150
  What do you want to do? .................................................................151

Broadcast Announcement Files - Select Voice System Dialog Box ........152
  How can I view this dialog box? .............................................................152
  How do I use this dialog box? .............................................................152
  What do you want to do? .................................................................153

Broadcast Announcement Files - Select Boards by Extension Dialog Box ..154
  How can I view this dialog box? .............................................................154
  How do I use this dialog box? .............................................................154
  What do you want to do? .................................................................155

Browse Extension Dialog Box ................................................................156

Configure Application Specific E-mail Notification Dialog Box ............157
  How can I view this dialog box? .............................................................157
  How do I use this dialog box? .............................................................157
  What do you want to do? .................................................................158

Configure E-mail Notification Dialog Box .............................................159
  How can I view this dialog box? .............................................................159
  How do I use this dialog box? .............................................................159
  What do you want to do? .................................................................160

Connect At Startup Dialog Box ..............................................................161

Copy/Delete Announcement Files Dialog Box ......................................162
  How can I view this dialog box? .............................................................162
  How do I use this dialog box? .............................................................162
  What do you want to do? .................................................................163

Create/Edit Group Dialog Box ..............................................................164
  How can I view this dialog box? .............................................................164
  How do I use this dialog box? .............................................................164

Create New Task Dialog Box ...............................................................166
  How can I view this dialog box? .............................................................166
  How do I use this dialog box? .............................................................166
  What do you want to do? .................................................................167

Create Task Dialog Box ......................................................................168
  How can I view this dialog box? .............................................................168
  How do I use this dialog box? .............................................................168
  What do you want to do? .................................................................168
<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Template Dialog Box</td>
<td>169</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>169</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>169</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>170</td>
</tr>
<tr>
<td>Edit Application Properties Dialog Box</td>
<td>171</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>171</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>172</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>173</td>
</tr>
<tr>
<td>Edit Voice System Properties Dialog Box</td>
<td>174</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>175</td>
</tr>
<tr>
<td>Edit VAL Board Properties Dialog Box</td>
<td>176</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>176</td>
</tr>
<tr>
<td>Export Data - Filters Dialog Box</td>
<td>177</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>177</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>177</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>178</td>
</tr>
<tr>
<td>Export Data - Fields Dialog Box</td>
<td>179</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>179</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>179</td>
</tr>
<tr>
<td>Export Data - Announcement Properties Dialog Box</td>
<td>180</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>180</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>180</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>180</td>
</tr>
<tr>
<td>Export Data - Summary Dialog Box</td>
<td>181</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>181</td>
</tr>
<tr>
<td>File Transfer Connections Dialog Box</td>
<td>182</td>
</tr>
<tr>
<td>SFTP Configuration Tab</td>
<td>182</td>
</tr>
<tr>
<td>Select SFTP file transfer protocol for VAL boards</td>
<td>183</td>
</tr>
<tr>
<td>Remove SFTP File transfer protocol for VAL boards</td>
<td>183</td>
</tr>
<tr>
<td>SCP Configuration tab</td>
<td>183</td>
</tr>
<tr>
<td>Select SCP file transfer protocol for VAL boards</td>
<td>184</td>
</tr>
<tr>
<td>Remove SCP File transfer protocol for VAL boards</td>
<td>184</td>
</tr>
<tr>
<td>Import Announcement Properties Wizard Dialog Box</td>
<td>186</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>186</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>186</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>187</td>
</tr>
<tr>
<td>Import Data - Select Announcement Fields Dialog Box</td>
<td>188</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>188</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>188</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>188</td>
</tr>
<tr>
<td>Dialog Box</td>
<td>Page</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Search Results for Groups Dialog Box</td>
<td>204</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>204</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>204</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>204</td>
</tr>
<tr>
<td>Search Task Dialog Box</td>
<td>205</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>205</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>205</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>206</td>
</tr>
<tr>
<td>Select Frequency Dialog Box</td>
<td>207</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>207</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>207</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>207</td>
</tr>
<tr>
<td>Select VAL Boards to be Backed Up Dialog Box</td>
<td>208</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>208</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>208</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>208</td>
</tr>
<tr>
<td>Select VAL Boards/Groups to be Restored Dialog Box</td>
<td>209</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>209</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>209</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>209</td>
</tr>
<tr>
<td>SNMP User Editor</td>
<td>210</td>
</tr>
<tr>
<td>Add an SNMP v3 User</td>
<td>210</td>
</tr>
<tr>
<td>View or Modify an SNMP v3 User Credentials or List of Boards</td>
<td>211</td>
</tr>
<tr>
<td>Delete an SNMP v3 User</td>
<td>211</td>
</tr>
<tr>
<td>SNMP User Configuration</td>
<td>212</td>
</tr>
<tr>
<td>ssh Key Generation Dialog Box</td>
<td>214</td>
</tr>
<tr>
<td>Task Editor Dialog Box</td>
<td>215</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>215</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>215</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>216</td>
</tr>
<tr>
<td>Template Editor Dialog Box</td>
<td>217</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>217</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>217</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>217</td>
</tr>
<tr>
<td>View Audio File Properties Dialog Box</td>
<td>218</td>
</tr>
<tr>
<td>How can I view this dialog box?</td>
<td>218</td>
</tr>
<tr>
<td>How do I use this dialog box?</td>
<td>218</td>
</tr>
<tr>
<td>What do you want to do?</td>
<td>218</td>
</tr>
</tbody>
</table>
Virtual VAL Boards Status Dialog Box.................................................................219
  How can I view this dialog box? ......................................................................219
  How do I use this dialog box? ........................................................................219
  What do you want to do? ................................................................................219

Contacting Us.....................................................................................................221
Notice ..................................................................................................................221
Before You Call ..................................................................................................222
  Related Topics .................................................................................................222
General Contact Information................................................................................223
  Related Topics .................................................................................................223
Technical Support................................................................................................224
  For customers located in the US: ...................................................................224
  For customers located outside the US .............................................................224
  Related Topics .................................................................................................224
Contacting us for Documentation .......................................................................225
  Related Topics .................................................................................................225
Contacting us about Training .............................................................................226
  For customers located in the US: ...................................................................226
  For customers located outside the US .............................................................226
  Related Topics .................................................................................................226
Giving us Your Feedback .....................................................................................227
  Related Topics .................................................................................................227
What I Want to do Isn't Listed Here .................................................................228

Index .................................................................................................................229
Getting Started

What's New in this Release

Voice Announcement Manager Release 5.0 Service Pack 1 introduces the following enhancements:

- Support for Avaya Communication Manager Release 5.1.
- Support for the S8510 server.
- Support for the S8400B server.
- Support for the new G350 media gateway CPU.

Previous Enhancements

Voice Announcement Manager Release 5.0

Voice Announcement Manager Release 5.0 introduced the following enhancements:

- New SFTP and SCP setup screens.
- New Browse Extension dialog box that lets you select a range and then select a specific extension for the announcement.
- Support for the following new media gateways:
  - G450 Media Gateway
  - IG550 Integrated Gateways (with Juniper routers J2320, J2350, J4350, J6350)
  - Samsung Ubigate iBG Router

Voice Announcement Manager Release 4.0

Voice Announcement Manager Release 4.0 introduced the following enhancements:

- Support for the following new media servers:
  - S8300C (Includes support for 0 TN2501AP boards, 50 media gateways, and 3000 announcements.)
  - S8500C (Includes support for 10 TN2501AP boards, 250 media gateways, and 3000 announcements.)
  - S8720XL (Includes support for 128 TN2501AP boards, 250 media gateways, and 9000 announcements.)
- Disable FTP and telnet services by default for secure connectivity. In Avaya Communication Manager Release 4.0, FTP and telnet are disabled by default.
- The ability to set up external, single-point authentication using an AAA Server for access to Avaya Communication Manager. Includes Radius/LDAP Support (Common Prompts & SecurID and SafeWord Clients for Automatic Login)
- Improvements to Avaya Communication Manager logging. All OSSI connections to voice systems running Avaya Communication Manager Release 4.0 will be identified as “vam” in the secondary user name in the syslog. This feature will enable you to determine which commands came from Avaya Voice Announcement Manager.
- Support for a 13-digit dial plan in Avaya Communication Manager Release 4.0.
- Support for up to 128 TN2501AP boards in an S8720XL server.
- Support for up to 9000 announcements on an S8720XL server.
- Support for up to 1024 announcement files on a TN2501AP board.
- Increase size of audio groups to 378 members.
- Use of and sorting by extension number as default. Announcement number is no longer supported.
- The ability to associate a notes file with each announcement file. The notes file can be a simple text file.
- Display of License Information in Help > About screen.
- Voice Announcement Manager Release 4.0 displays a popup warning message upon initial launch following an upgrade that informs a user that Avaya Communication Manager Release 4.0 no longer has telnet and ftp enabled by default. That could cause problems with Voice Announcement Manager connectivity.

This screen displays only once after upgrade.

**Voice Announcement Manager Release 3.1**

Voice Announcement Manager Release 3.1 introduced the following enhancements:

- Support for the S8400 server.
- Support for the S8720 server.
- Support for the G250-DCP media gateway.
- Support for the G250-DS1 media gateway.
- Support of SCP for secure file transfer.

*Note:* The G700 media gateway does not support SCP.

- The ability to place your audio groups into folders.
- The ability to export specific announcement properties.
- The ability to move specific announcement properties from one source to another source.
- The ability to move multiple audio files at a time.
- The ability to find and replace a VAL source within audio groups in a voice system.
- The ability for non-administrative Windows users to access and use Avaya Voice Announcement Manager.
- The ability for users to change the language of the text displayed in Avaya Voice Announcement Manager. All of the text strings that appear in Avaya Voice Announcement Manager are now contained in an external file. You can access these text strings from the Properties (or resource) file. The default text strings are provided in U.S. English. If you have a Properties file that has been translated for your locale and language, Avaya Voice Announcement Manager will use that file and display the text strings from that file in your language. The Properties file is located in the Resources folder and is named \VAM_<language>_.<locale>.properties.
Voice Announcement Manager Release 3.0

Voice Announcement Manager Release 3.0 introduced the following enhancements:

- Support for the S8500B server.
- Support for the S8710 server.
- Support for the G250 media gateway.
- Support for the G250 BRI media gateway.
- Support for SFTP communication with TN2501 boards.
- The ability to specify the maximum number of minutes that you want Voice Announcement Manager to maintain its connection to the voice system.
- The ability to specify the timeout interval for which you want Voice Announcement Manager to try connecting to the voice system.
- The ability to create, view, and manage audio groups.
- Support for locally sourced Music.
- Easier movement of announcement properties from one source to another.
- The ability to record an announcement to an extension and then broadcast that WAV file to an audio group (Broadcast by Extension) or to any other extension (Broadcast to Extension).

Voice Announcement Manager Release 2.1

Voice Announcement Manager Release 2.1 introduced the following enhancements:

- The ability to rename audio files.
- The ability to rename announcement properties.
- The ability to schedule import tasks.
- The ability to schedule export tasks.
- The ability to start a user-specified audio player/editor application from Voice Announcement Manager.
- Use of a standard encryption algorithm for password encryption.
- Use of SSH2
- Automatic and secure authentication of both ends of the connection. Both the server and the client are authenticated to prevent identity spoofing.
- Secure terminal sessions utilizing strong encryption.
- Connection to a Linux-based voice system on port 5022.

Voice Announcement Manager Release 2.0

Voice Announcement Manager Release 2.0 introduced the following enhancements:

- The ability to support G350 virtual VAL boards.
- The ability to support the S8500 Media Server with both TN2501AP and G700 Media Gateway announcement sources.
- The ability to search for announcement properties and audio files on a voice system.
- The ability to import announcement properties from a comma-separated values (CSV) file.
- The ability to export announcement properties to a comma-separated values (CSV) file.
- The ability to print announcement properties and audio files.
Voice Announcement Manager User Reference

- The ability to view up to five Announcement Properties windows at once.
- FTP moves will be blocked if the audio filename length is greater than 27 characters.
- A persistent status pane.
- A warning will be displayed if Scheduled Tasks exist when you exit Voice Announcement Manager.
- The ability to configure the Voice Announcement property file from the Voice Announcement Manager window.
- Support for Windows XP.

VAL Manager Release 1.3

VAL Manager Release 1.3 introduced the following enhancements:

- The ability to support 260 boards (250 virtual VAL boards and 10 VAL boards) for Avaya G700 Media Gateway in the Avaya S8700 Media Server configuration.
- The ability to support 50 virtual VAL boards for Avaya G700 Media Gateway in the Avaya S8300 Media Server configuration.
- The ability to move announcement files from one VAL board to another on the same voice system.
- The ability to move an announcement property file from one VAL board to another on the same voice system.
- The ability to broadcast announcement files onto VAL boards from various voice systems.
- The ability to back up selected VAL/virtual VAL boards on a voice system.
- The ability to restore selected VAL/virtual VAL boards on a voice system.
- A Task Editor, which enables you to create and schedule backup and broadcast tasks. You can schedule these tasks to run on a specified date and time or at a selected frequency (for example, daily, weekly, or monthly).
- The ability to notify users via email about the outcome of scheduled tasks.
- A Template Editor, which enables you to create templates of tasks you want to perform regularly (such as a backup task).
- A property file that allows you to configure the following settings:
  - The file size for the status logs. Use the `VAL.logLimit=x` property (where `x` is the maximum number of MB for the status logs) in the VALProp file to set the file size for the status logs. By default, the file size for the status logs is 5 MB.
  - The maximum number of threads spawned per voice system at a time. The threads perform FTP operation on a VAL board. By default, the value for this property will be 10.
  - The FTP mode (ACTIVE or PASSIVE).
  - Improved logging, with messages being stored for two weeks. The messages will be logged in the file `val_status.txt`. If the file size reaches the limit you set in the `VAL.logLimit` property, the file `val_status.txt` will be copied to the file `val_status.txt.old`, and Voice Announcement Manager will start logging messages in the new `val_status.txt` file. If the file `val_status.txt.old` already exists, that file will be overwritten.

⚠️ Note: ⚠️

In VAL Manager Release 1.3, Microsoft Windows 98 and Microsoft Windows NT are not supported.
VAL Manager Release 1.2

VAL Manager Release 1.2 introduced the following enhancements:

- This release offers support for Avaya G700 Media Gateway in the Avaya S8300 Media Server configuration and the Avaya S8700 Media Server configuration.
- In the VAL Manager main window, if you right-click a voice system and that voice system supports Avaya G700 Media Gateways, then a new pop-up menu option appears called "View Status." Selecting this option displays, for each virtual VAL board (that is, G700 Media Gateways), whether it is enabled for announcements or disabled for announcements.
- In the above situation, if you right-click a virtual VAL board, VAL Manager displays two new pop-up menu options, "Enable" and "Disable." These options appear only for G700 Media Gateways.

VAL Manager Release 1.1

VAL Manager Release 1.1 introduced the following enhancements:

- This release allows you to launch VAL Manager using a web browser
- This release adds a new Toolbar
- This release adds keyboard shortcuts
- When you start VAL Manager for the first time, this release does not require that you add voice systems immediately.
- When you add a voice system to VAL Manager, this release of VAL Manager does not connect to the voice system until you tell it to.
- This release allows you to specify whether VAL Manager should connect to a given voice system on startup.
- This release allows you to double-click a board to see announcement properties for that board.
- This release accepts 7-digit extensions.
- In this release, the status bar is at the bottom of the VAL Manager window.
What can I do with Voice Announcement Manager?

Voice Announcement Manager is a stand-alone application that lets you copy audio files and announcement properties from the Voice Announcement Manager computer to a voice system or back.

Basic Features

Voice Announcement Manager offers the following basic features:

- Simplified administration to add, change, and remove Communication Manager announcement information.
- The ability to back up and restore announcement information.
- The ability to view the status of announcement on your voice system’s new VAL boards (TN2501AP).
- The ability to support virtual VAL boards for the Avaya G450, G350, G250, G250-DCP, G250-DS1, J2320, J2340, J4350, J4360, and Samsung AMRB Media Gateways, the Avaya G700 Media Gateway in the Avaya S8700 Media Server configuration, and the Avaya G700 Media Gateway in the Avaya S8300 Media Server configuration.

Voice Announcement Manager allows you to see how many announcements are associated with a given voice system or VAL/virtual VAL board (a.k.a., circuit pack), the names of your voice systems and their VAL/virtual VAL board locations, the names of audio files on the computer and on the VAL/virtual VAL boards, and the announcement properties (that is, the values of the Communication Manager fields named Filename, Repeating, Extension, Location, COR, TN, Queue, Protected, Rate, Length, Size, Timestamp, and On Board). Voice Announcement Manager also offers a History Log that lists Voice Announcement Manager status.

Understanding Announcements with Voice Announcement Manager

With your new VAL/virtual VAL board, "announcements" have two parts:

- an audio file – stored on a VAL/virtual VAL board and/or on the Voice Announcement Manager computer
- announcement properties – stored on a voice system and/or on the Voice Announcement Manager computer.

Everything you do in Voice Announcement Manager requires that you understand this two-part concept.

What Do You Want To Do?

Configuring Voice Announcement Manager:

- Add voice systems to Voice Announcement Manager
- Delete voice systems from Voice Announcement Manager
- View or change voice system information in Voice Announcement Manager
- Test connectivity
- Troubleshoot connectivity

Using Voice Announcement Manager:

- View announcement properties
- Change announcement properties
- Delete announcement properties
• Copy audio files
• Back up
• Restore
• View a history of Voice Announcement Manager activities
• View Voice Announcement Manager version
• View the size of audio files
• Move announcements between VAL boards
• Move the announcement property between VAL boards
• Broadcast announcement files to VAL boards
• View or change the status of virtual VAL boards
• Create, manage, and schedule tasks
• Create, manage, and use templates
• Configure Voice Announcement Manager to send email notification for scheduled tasks
• Exit
Where do I Begin?

To understand how to set up and use Voice Announcement Manager, we recommend that you read Voice Announcement Manager’s online help topics in the following order. You can see these topics if you click the “Table of Contents” tab (left-most) in the online help window.

1. Set up Voice Announcement Manager by reading the online help booklet called, "Configuring Voice Announcement Manager." Read the topics in the order that they appear in the booklet.

2. To use Voice Announcement Manager, open the booklet called "Using Voice Announcement Manager" and double-click the help topic corresponding to the activity that you want to perform.

If you don’t see a topic for the activity you want to perform, click the Index tab and search for a term. If that doesn’t work, click the Search tab and enter the term to search for. If that doesn’t work, please send us feedback so we can improve the documentation!
Understanding the Voice Announcement Manager Main Window

Please wait a moment for the graphic below to load. Then, click an area on the graphic to learn more about Voice Announcement Manager.

Related Topics
- The Menu Bar
- The Tool Bar
- The Tree
- The Status Pane
- The Display Area
Main Window Details

Voice Announcement Manager Toolbar

The Toolbar lets you perform common activities with the click of a button.

<table>
<thead>
<tr>
<th>Button</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Register" /></td>
<td>Click this button to register a new voice system with Voice Announcement Manager.</td>
</tr>
<tr>
<td><img src="image" alt="Add Announcement" /></td>
<td>Click this button to add a new announcement to the VAL board that you select in the Voice Announcement Manager tree.</td>
</tr>
<tr>
<td><img src="image" alt="Edit Announcement Properties" /></td>
<td>Click this button to make changes to the properties of the selected announcement in the Voice Announcement Manager window.</td>
</tr>
<tr>
<td><img src="image" alt="Move Announcement Properties" /></td>
<td>Click this button to move the properties of the selected announcement in the Voice Announcement Manager window.</td>
</tr>
<tr>
<td><img src="image" alt="Rename Announcement Property" /></td>
<td>Click this button to rename the selected announcement property in the Voice Announcement Manager window.</td>
</tr>
<tr>
<td><img src="image" alt="Delete Announcement Property" /></td>
<td>Click this button to delete the selected announcement property in the Voice Announcement Manager window.</td>
</tr>
<tr>
<td><img src="image" alt="Save Changes" /></td>
<td>After you make changes to the properties of any announcement associated with a VAL board, click this button to save your changes.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh Screen" /></td>
<td>Click this button to refresh the screen and display any updates to the data on screen.</td>
</tr>
<tr>
<td><img src="image" alt="Print Announcement Properties" /></td>
<td>Click this button to print the announcement properties.</td>
</tr>
<tr>
<td><img src="image" alt="View Printed Properties" /></td>
<td>Click this button to view how the announcement properties will be printed.</td>
</tr>
<tr>
<td><img src="image" alt="Create Modify Delete Templates" /></td>
<td>Click this button to create, modify, delete, and manage templates.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Button" /></td>
<td>Click this button to broadcast announcement files on to various VAL boards on different voice systems.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Button" /></td>
<td>Click this button to view the Voice Announcement Manager log file.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Button" /></td>
<td>Click this button to view the release number of the Voice Announcement Manager software you are using.</td>
</tr>
</tbody>
</table>
## Menus

<table>
<thead>
<tr>
<th>File Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File&gt;Save Announcement Properties</strong></td>
<td>This option saves changed data in the announcement table to the Voice Announcement Manager computer and to the selected voice system.</td>
</tr>
<tr>
<td><strong>File&gt;Print Announcement Properties</strong></td>
<td>This option prints the announcement properties.</td>
</tr>
<tr>
<td><strong>File&gt;Print Preview Announcement Properties</strong></td>
<td>This option enables you to see the format in which the announcement properties will be printed.</td>
</tr>
</tbody>
</table>
| **File>Edit Application Properties** | This option enables you to configure the following settings in the Voice Announcement Manager properties file:  
  - the maximum size for the activity log.  
  - the maximum number of threads spawned per voice system at a time.  
  - the FTP mode (ACTIVE or PASSIVE).  
  - the FTP log option (check to show detailed logs of FTP/SFTP operations)  
  - the number of messages to be displayed in the Status pane.  
  - the editing software you want to use to view the activity log.  
  - the audio player/editor software you want Announcement Manager to start when you select **Launch Audio player/Editor** from the File menu.  
  - the maximum number of minutes that you want Voice Announcement Manager to maintain its connection to the voice system.  
  - the timeout interval for which you want Voice Announcement Manager to try connecting to the voice system.  
  - whether you have to log into Voice Announcement Manager via a password. You can set Voice Announcement Manager to prompt you for a password every time you start Voice Announcement Manager. If you password protect Voice Announcement Manager, you must also specify an email address so Voice Announcement Manager can email you a copy of your password on request (for example, if you forget your password).  
  - If you enter the wrong password five consecutive times, Voice Announcement Manager will close. If you are unable log into Voice Announcement Manager (that is, you cannot remember your password), you... |
must delete the file “ValManager.dat” and then start Voice Announcement Manager. Your tasks, templates, and other settings are preserved, but all of the voice system information is removed. You must re-enter the voice system information.

**Note:**

*If you want to password protect Voice Announcement Manager, you must first configure the outgoing mail server information for Voice Announcement Manager.*

<table>
<thead>
<tr>
<th>**File&gt;**Edit SCP Server Configuration</th>
<th>This option enables you to configure the settings to use SCP for secure file transfer.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td><strong>SCP is only supported for G450, G350, G250, G250-DCP, G250-DS1, J2320, J2340, J4350, J4360, and Samsung AMRB media gateways.</strong></td>
</tr>
<tr>
<td>**File&gt;**Launch Audio player/Editor</td>
<td>This option opens the audio player/editor application you specified in the Edit Application Properties dialog box.</td>
</tr>
<tr>
<td>**File&gt;**Exit</td>
<td>This option closes the application. Voice Announcement Manager displays a warning if you have changed any data in the announcement table but forgotten to save it.</td>
</tr>
</tbody>
</table>

### View Menu

| **View>**Refresh Announcement Properties | This option makes Voice Announcement Manager contact the voice system, update the announcement table with any changes, and re-display the table. |
| **View>**Edit Properties                | Select this option to view the VAL Board Properties dialog box for the VAL board that you selected in the Voice Announcement Manager tree. |
| **View>**View Logs                      | Select this option to view the Voice Announcement Manager activity log. |
| **View>**View Audio Files Properties    | In the Voice Announcement Manager tree, select the specific VAL board associated with the announcement properties you want to view, and then select this option. When you do, Voice Announcement Manager will display these announcement properties in View Audio File Properties dialog box. |
### View Menu

<table>
<thead>
<tr>
<th>View Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View&gt;View Announcement Properties</td>
<td>In the Voice Announcement Manager tree, select the specific VAL board, and then select this option. The Voice Announcement Manager presents the Announcement Properties window, which you can use to create new announcements, modify existing announcements, delete announcements, or transfer announcement files corresponding to the announcements.</td>
</tr>
<tr>
<td>View&gt;View Virtual VAL Boards Status</td>
<td>In the Voice Announcement Manager tree, select the voice system, and then select this option. Voice Announcement Manager presents a dialog box that displays the status each virtual VAL board on the selected voice system. From this dialog box, you can change the status of the VAL boards.</td>
</tr>
<tr>
<td>View&gt;View Voice System Tree</td>
<td>This option lets you display or hide the left pane (the Tree) of the main window.</td>
</tr>
<tr>
<td>View&gt;View Status Pane</td>
<td>This option lets you display or hide the bottom pane (the Status pane) of the main window.</td>
</tr>
</tbody>
</table>

### Edit Menu

<table>
<thead>
<tr>
<th>Edit Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit&gt;New Announcement Property</td>
<td>Select this option to add a new announcement to the selected voice system.</td>
</tr>
<tr>
<td>Edit&gt;Edit Announcement Property</td>
<td>Select this option you to modify to the properties of the selected announcement in the Voice Announcement Manager window.</td>
</tr>
<tr>
<td>Edit&gt;Move Announcement Property</td>
<td>Select this option to move the properties of the selected announcement in the Voice Announcement Manager window.</td>
</tr>
<tr>
<td>Edit&gt;Rename Announcement Property</td>
<td>Select this option to rename the selected announcement property in the Voice Announcement Manager window.</td>
</tr>
<tr>
<td>Edit&gt;Delete Announcement Property</td>
<td>Select this option to delete the selected announcement in the Voice Announcement Manager window.</td>
</tr>
</tbody>
</table>

### System Menu

<table>
<thead>
<tr>
<th>System Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System:Register Voice System</td>
<td>Select this option to add a new voice system to Voice Announcement Manager.</td>
</tr>
<tr>
<td>System&gt;Delete Voice System</td>
<td>In the Voice Announcement Manager tree, select the voice system you want to remove, and then select this option. Deleting a voice system using this option does not affect the</td>
</tr>
</tbody>
</table>
### System>Get VAL Board Information

In the Voice Announcement Manager tree, select a VAL board, and select this option. The Edit VAL Board Properties dialog box appears, displaying the properties for the selected board.

### System>Connect At Startup Configuration

Select this option if you want to specify which voice systems Voice Announcement Manager should connect to upon startup.

### System>Email Configuration

Select this option to configure the default email addresses to which Voice Announcement Manager will send email when scheduled tasks are performed.

### System>Search Announcement Property/File

Select this option to search for announcement properties and audio files on a voice system. You can specify to search all of your voice systems.

### System>Import Announcement Properties

Select this option to import voice announcement properties from a comma-separated values (CSV) file.

### System>Export Announcement Properties

Select this option to export voice announcement properties to a comma-separated values (CSV) file.

### System>Sort Voice Systems By Name

Select this option to display the voice systems in alphabetical order.

---

### Actions Menu

<table>
<thead>
<tr>
<th>Actions Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions&gt;Back Up</td>
<td>In the Voice Announcement Manager tree, select the voice system that contains the announcement properties and audio files you want to copy to the Voice Announcement Manager computer, and then select this menu option.</td>
</tr>
<tr>
<td>Actions&gt;Back Up All Voice Systems</td>
<td>This option lets you copy announcement properties from all of the voice systems to Voice Announcement Manager’s &quot;persistent storage&quot; and lets you copy audio files from all of the VAL boards (that you have registered with Voice Announcement Manager) to the directories that you associated with these VAL boards.</td>
</tr>
<tr>
<td>Actions&gt;Restore</td>
<td>In the Voice Announcement Manager window, select the voice system to which you want to copy the announcements from the Voice Announcement Manager computer, and then select this menu option.</td>
</tr>
<tr>
<td>Actions&gt; Restore All</td>
<td>This option copies all announcement properties from the Voice Announcement Manager’s &quot;persistent storage&quot; to the</td>
</tr>
</tbody>
</table>
## Voice Systems

appropriate Communication Manager forms, and copies all audio files from the Voice Announcement Manager computer to the appropriate VAL boards.

| Actions>Copy/Delete Audio Files | In the Voice Announcement Manager window, select the VAL board to which you want to copy audio files from the Voice Announcement Manager computer or vice versa, and then select this menu option. Using this menu option, you can also delete audio files. |
|--------------------------------|
| Actions>Move Audio Files | In the Voice Announcement Manager tree, select the VAL board that contains announcement files you want to move, and then select this option. Voice Announcement Manager presents the Move Announcement Files - Select Files To Move dialog box. |
| Actions>View/Rename Audio Files | In the Voice Announcement Manager tree, select the VAL board that contains announcement files you want to move, and then select this option. Voice Announcement Manager presents the Move Announcement Files - Select Files To Move dialog box. |
| Actions>Enable Virtual VAL Board | In the Voice Announcement Manager tree, select the virtual VAL board you want to enable, and then select this option. |
| Actions>Disable Virtual VAL Board | In the Voice Announcement Manager tree, select the virtual VAL board you want to disable, and then select this option. |
| Actions>Create/Edit Group | Using this menu option, you can create a new audio group or modify an existing audio group for the selected voice system. |
| Actions>Search/Replace VAL Sources in Group | Using this menu option, you can find VAL sources in an audio group in a voice system and replace VAL sources in an audio group in a voice system. |
| Actions>Move Announcement Properties | This option enables you to move the announcement/administration/properties (and the associated announcement file) from one VAL board to another on the same voice system. In the Voice Announcement Manager tree, select the specific VAL board, and then select this option. |
| Actions>Broadcast | Using this menu option, you can broadcast announcement files onto various VAL boards on different voice systems. |
| Actions>Scheduler | Using this menu option, you can create, modify, delete, and manage tasks that you can schedule to be performed at specific times and intervals. |
| Actions>Template Editor | Using this menu option, you can create, modify, and delete |
### Window Menu

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Window&gt;Cascade</strong></td>
</tr>
<tr>
<td><strong>Window&gt;Tile Horizontally</strong></td>
</tr>
<tr>
<td><strong>Window&gt;Tile Vertically</strong></td>
</tr>
<tr>
<td><strong>Window&gt;Close All</strong></td>
</tr>
<tr>
<td><strong>Window&gt;Open Announcement Properties</strong></td>
</tr>
</tbody>
</table>

### Help Menu

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Help&gt;Contents</strong></td>
</tr>
<tr>
<td><strong>Help&gt;About</strong></td>
</tr>
</tbody>
</table>
Voice Announcement Manager Tree

This area of the main Voice Announcement Manager window lets you see:

- the voice systems you have added to Voice Announcement Manager
- the audio sources (VAL boards) on those voice systems
- the audio groups on those voice systems
- the audio group folders that you created on those voice systems

What can I do with this tree?

- Change voice system information
- Delete a voice system from Voice Announcement Manager
- Create an audio group
- Modify an audio group
- Delete an audio group
- Back up announcement properties and audio files
- Restore announcement properties and audio files
- Search for audio files
- Search for announcement property files
- View or change the status of a virtual VAL board
- Import announcement properties
- Export announcement properties
Display Area

This area displays all of the announcements associated with a given VAL board, if you right-click the VAL board in the Voice Announcement Manager Tree and choose View Announcement Properties from the popup menu.

Each VAL board will have its own window. You can view the announcements for up to five VAL boards at one time.

What can I do with this display area?

- View announcement properties
- Change announcement properties
- Add announcement properties
- Delete announcement properties
- Move announcement properties
Status Pane

To view status messages from Voice Announcement Manager or the voice system you are working with, simply scroll through the entries in the Status pane.

By default, 51 messages will be displayed in the Status pane. You can change the number of messages displayed.
How Voice Announcement Manager Works

This information is provided for those customers who are curious about what Voice Announcement Manager does, when, and how.

Connecting to your voice system

Voice Announcement Manager attempts to connect to your voice system after you complete the Register Voice System dialog box and click OK. When you click OK, Voice Announcement Manager uses the information you entered to gather and display information about your systems, boards, and announcements, as follows.

On each voice system for which you have provided connectivity information, Voice Announcement Manager issues the command `list config all` to obtain a list of VAL boards on that system and their locations. It then searches the Board Type field for VAL boards, and when it finds a VAL board, it obtains the board location from the Port field. Once it has the board locations, Voice Announcement Manager then issues the command `display ip-interfaces` and searches the Slot field for the value that matches the Port field in the previous screen. When it finds a match, it gathers the value from the Node Name field. When it has the node names, Voice Announcement Manager issues the command `display node-names ip` and determines each board’s IP address from the IP Address field. Finally, Voice Announcement Manager issues the `list integrated-annnc-boards` command and gathers the values from the Time Remaining at 64 Kbps field.

Voice Announcement Manager updates and re-presents all of this information for each VAL board each time the application is started, and any time you click the Refresh button on the Voice Announcement Manager interface.

Administering Announcements

Voice Announcement Manager does not enable you to record or play announcements; use your third-party recording software for that. However, Voice Announcement Manager does enable you to:

- copy audio files to your VAL boards
- delete audio files from your VAL boards
- view and change announcement properties on a voice system
- back up and restore audio files and announcement properties

To perform the above activities, Voice Announcement Manager executes the following steps:

- For new and changed announcement properties: Voice Announcement Manager issues the `change announcement` command and submits the data.
- For deleted announcement properties: Voice Announcement Manager issues the `change announcement` command and clears the Ext and Type fields of the appropriate announcement (determined by announcement number).

Backing up and Restoring Audio Files and Announcement Properties

Voice Announcement Manager lets you:

- back up announcement properties and audio files for a single VAL board, or
- back up announcement properties and audio files for all VAL boards on all of your voice systems (just the ones that Voice Announcement Manager knows about).

To do so, Voice Announcement Manager executes the following steps:
1. Voice Announcement Manager issues the `enable filesystem board <VAL board location><login><password>` command to access the FTP server on the board.

2. Voice Announcement Manager issues the `ftp VALip_address` command and enters the login and password.

3. Voice Announcement Manager issues a `get filename, mget*.wav, or mput*.wav` command as the situation dictates.

4. Voice Announcement Manager issues a `list directory` command to collect and display the new list of announcements in Voice Announcement Manager screens.

5. Voice Announcement Manager quits the FTP session.

6. Voice Announcement Manager issues a `disable filesystem board <VAL board location><login><password>` command.

Unless you specify a different directory, announcements are backed up to, and restored from, the `\Program Files\Avaya\val\data` directory, in a folder with the name of the voice system, and a subfolder with the VAL board name, on the Voice Announcement Manager computer.
Voice Announcement Over the LAN (VAL)

VAL stands for Avaya Voice Announcement Over the LAN, our newest technology for storing and delivering announcements on network-enabled voice systems.
What is a Virtual VAL Board?

In this help system, when we say "virtual VAL board" we mean the Avaya G700 Media Gateway and the Avaya G450, G350, G250, G250-DCP, G250-DS1, J2320, J2340, J4350, J4360, and Samsung AMRB Media Gateways. We call it a "virtual VAL board" because although there is no physical VAL board present, the Media Gateways act as a VAL board. The Avaya Media Gateways have announcements capabilities like the physical TN2501AP VAL board and use the same firmware and software as used by the TN2501AP VAL board.
Configuring Voice Announcement Manager

Configuration Overview

The first time you start Voice Announcement Manager, it automatically displays a dialog box into which you can enter the information that Voice Announcement Manager needs so it can connect to a supported voice system.

You can enter the information immediately or cancel the dialog box and enter the information later. However, Voice Announcement Manager functionality is greatly diminished until you enter the connectivity information.

We recommend that you set up Voice Announcement Manager in the following order:

1. Prepare Communication Manager software for use with Voice Announcement Manager.
2. Start Voice Announcement Manager and enter voice system information into the dialog box that automatically appears (the first time you start Voice Announcement Manager).
3. Test connectivity.
4. Troubleshoot any problems.

   If problems occur, there is usually a Help button on the error message that appears. Click the Help button for troubleshooting ideas.
Preparing Communication Manager Software for Voice Announcement Manager

Voice Announcement Manager will not work with the Communication Manager software on your voice system until you have properly prepared the Communication Manager software for use with Voice Announcement Manager. Specifically, you must set up your Communication Manager software with the new VAL boards (G700, G450, G350, G250, G250-DCP, G250-DS1, J2320, J2340, J4350, J4360, and Samsung AMRB and TN2501AP) as well as set up the Communication Manager software so you can access it over your LAN/WAN via a C-LAN board.

To prepare your Communication Manager software for Voice Announcement Manager, perform the following steps:

1. Install voice systems, if you have not already.
   Refer to MCC on the following website: http://made-easy.avaya.com/

2. Install C-LAN circuit pack(s).
   Refer to Administration for Network Connectivity for Avaya Communication Manager Software. A copy of this document is available on the Avaya Integrated Management Software CD. Optionally, you can search for it as described in Contacting Us for Documentation.

3. Test C-LAN connectivity to the LAN.
   Refer to Administration for Network Connectivity for Avaya Communication Manager Software. A copy of this document is available on the Avaya Integrated Management Software CD. Optionally, you can search for it as described in Contacting Us for Documentation.

4. Install VAL circuit pack(s).
   Refer to the "Non-volatile storage of announcements on VAL" in the chapter "Managing Announcements" in the Administrator's Guide for Avaya Communication Manager Software, 555-233-506. A copy of this document is available on the Avaya Integrated Management Software CD. Optionally, you can search for it as described in Contacting Us for Documentation.

5. If you want to use Access Security Gateway (ASG), have Avaya enable it on your voice systems.

6. If you want Voice Announcement Manager to have a separate login to your voice system (so you can track Voice Announcement Manager activities using the Communication Manager History Log), then create a login for that purpose for each voice system.
Communication Manager Details

Determining if ASG is Enabled on Your Voice System

ASG is an optional security feature that prevents unauthorized persons from accessing your voice system. To determine if the ASG feature is enabled on your voice system, complete the following steps:

1. Log in to your voice system.
2. Type `display system-parameters customer-options` and press Enter.
   - If the Access Security Gateway field has a value of `y`, then your voice system has the ASG feature.
   - If the Access Security Gateway field has a value of `n`, your voice system doesn’t have ASG, but you can get it.
Enabling ASG on Your Voice System

If your voice system does not have the ASG feature enabled, and you want it, you can order it by completing the following steps:

1. Call Avaya.
2. Give Avaya your Installation Location (IL) number.
3. Request that Avaya turn on the ASG customer option for this voice system.
Avaya Customer Software Administration Center Numbers

Call these numbers ONLY to request that Avaya turn on the ASG customer option on one of your voice systems.

<table>
<thead>
<tr>
<th>If you are calling from the United States:</th>
<th>Dial:</th>
</tr>
</thead>
<tbody>
<tr>
<td>CT, DC, DE, MA, ME, NH, NJ, NY, PA, RI, VA, VT, WV</td>
<td>1-800-632-0900</td>
</tr>
<tr>
<td>AL, AR, FL, GA, KS, KY, MO, MS, NC, SC, TN</td>
<td>1-800-922-1523</td>
</tr>
<tr>
<td>IA, IL, IN, LA, OK, MI, MN, ND, NE, OH, SD, TX WI</td>
<td>1-800-572-0036</td>
</tr>
<tr>
<td>AK, AZ, CA, CO, ID, HI, MT, NM, NV, OR, UT, WA, WY</td>
<td>1-800-829-8888</td>
</tr>
</tbody>
</table>

If you are calling from outside the United States, contact your Avaya representative.
Assigning and Changing Communication Manager Administrators

The system allows you to add or change user logins as needed. When you want to add or change a login, remember the following Communication Manager system security requirements:

- A login must be 3 to 6 alphanumeric characters in length
- A password must be from 4 to 11 alphanumeric characters in length and contain at least one non-alphabetic character

Note that to create or change logins for G3V3 and later releases, you must login as a superuser with administrative permissions.

Related Topics

- Assigning new Communication Manager logins and passwords
- Setting Communication Manager login permissions
- Changing Communication Manager passwords
- Changing Communication Manager logins
Assign New Communication Manager Logins and Passwords

As you work as an administrator, you may be fortunate enough to have help administering your voice system or you may want to have an assistant make changes to the voice system while you are out of the office. In these cases, you should set up a new user in the system and limit what this individual can do. As you'll see, adding logins is very easy.

You increase system security when you choose the longest possible password with a mix of lowercase and uppercase numbers and letters.

The following example shows you how to add a new login called angi3 with a password of b3stm0m.

To add this user and password, log in with a superuser ID and complete the following steps:

1. Use your favorite administration tool to access the voice system you want to administer.
2. Type `add login angi3` and press Enter.

   Use the new login name as part of the `add` command.

   The Login Administration screen appears. The Login’s Name field shows the name you typed in the add command; other fields contain defaults.

3. Complete the following fields:
   - Password of Login Making Change
     - This is your password.
   - Login’s Password
     - Assign an initial password for the new login. We'll type in b3stm0m as part of our example. The password does not appear on the screen as you type.
   - Re-enter Login’s Password

4. Press Enter to save your changes.

Related Topics

- Assigning and changing Communication Manager administrators
- Setting Communication Manager login permissions
- Changing Communication Manager passwords
- Changing Communication Manager logins
Changing Communication Manager Passwords

You should change your passwords often.

Tip:
To force users to change passwords, set password aging in the Login Administration screen.

To change the password (b3stm0m) for angi3:

1. Use your favorite administration tool to access the voice system you want to administer.
2. Type change password angi3 and press the ENTER key. The Password Administration screen appears.
3. Complete the following fields:
   - Password of Login Making Change
     This is your password that you used to login to the session.
   - Login Name
   - Login’s Password
   - Reenter Login’s Password
4. Press Enter to save your changes.

Related Topics

- Assigning and changing Communication Manager administrators
- Assigning new Communication Manager logins and passwords
- Setting Communication Manager login permissions
- Changing Communication Manager logins
Changing Communication Manager Logins

Occasionally you’ll need to change permissions for a user’s login. For example, you may want to change a login so that the user must change their password every 30 days (a good rule of thumb).

To change the password aging for our new login, angi3:

1. Use your favorite administration tool to access the voice system you want to administer.
2. Type `change login angi3` and press the ENTER key.
   The Login Administration screen appears with the current information for angi3.
3. Type `30` in the Password Aging Cycle Length (Days) field.
4. Press `Enter` to save your changes.

Related Topics

- Assigning and changing Communication Manager administrators
- Assigning new Communication Manager logins and passwords
- Setting Communication Manager login permissions
- Changing Communication Manager passwords
Setting Communication Manager Login Permissions

Once you add the new user, you should review the user’s command permissions and modify them, if necessary.

To review command permissions for our new example login:

1. Use your favorite administration tool to access the voice system you want to administer.

2. Type `change permissions angi3` and press the ENTER key.
   
   Use the new login name as part of the add command. The Command Permission Categories screen appears.

3. If you want the default permissions, click Cancel.

4. If you want to change any permissions, enter `y` to give the user access or `n` to restrict access for each permission type.

5. Press Enter to save your changes.

Related Topics

- Assigning and changing Communication Manager administrators
- Assigning new Communication Manager logins and passwords
- Changing Communication Manager passwords
- Changing Communication Manager logins
Determining if ASG is Enabled on a Login

To find out if a given login on your voice system has ASG enabled, complete the following steps:

1. Using your favorite system administration tool, log in to the voice system and type `list logins`.

2. Find the login name you are interested in and see whether there is a check mark in the ASG field.
Determining IP Network Port

To determine the IP network port number of the C-LAN board on a voice system running Communication Manager 2.0 or later software, complete the following steps:

1. Log in to the voice system.
2. Type `list ip-interface` and press Enter.
3. Look for the C-LAN board that you want to use and note the value in the `Node Name` field.
4. Type `display ip-services` and press Enter.
5. In the `Local Node` field, look for the `Node Name` you noted from the previous screen. Next to it, in the `Local Port` field, will be the IP Network Port number for that C-LAN board.

You may see several entries for the same C-LAN board. If you do, they will probably all have the same IP Network Port number, which you should use. If they don’t, however, you can probably determine which Port to choose by examining the `Remote Node Name` field, which lists the Node Name of the device that that particular C-LAN/Port combination communicates with. For example, you may have to choose between 3 entries for the same C-LAN board, but one of them might have “Voice Announcement Manager” in the `Remote Node Name` field. Choosing the Port number for that entry would probably be correct.

To determine the IP network port number of the C-LAN board on a voice system running software earlier than Communication Manager 2.0 (for example, MultiVantage 1.3 software), complete the following steps:

1. Log in to the voice system.
2. Type `display ip-interfaces` and press Enter.
3. Look for the C-LAN board that you want to use and note the value in the `Node Name` field.
4. Type `display ip-services` and press Enter.
5. In the `Local Node` field, look for the `Node Name` you noted from the previous screen. Next to it, in the `Local Port` field, will be the IP Network Port number for that C-LAN board.

You may see several entries for the same C-LAN board. If you do, they will probably all have the same IP Network Port number, which you should use. If they don’t, however, you can probably determine which Port to choose by examining the `Remote Node Name` field, which lists the Node Name of the device that that particular C-LAN/Port combination communicates with. For example, you may have to choose between 3 entries for the same C-LAN board, but one of them might have “Voice Announcement Manager” in the `Remote Node Name` field. Choosing the Port number for that entry would probably be correct.
Determining IP Address

To determine the IP address assigned to a voice system running Communication Manager 2.0 or later software:

1. Using your favorite system administration tool, log in to the voice system.
2. Type `list ip-interface` and press Enter.
3. Look for the C-LAN board that you want to use and note the value in the `Node Name` field.
4. Type `list node-names` and press Enter.
5. Look for the Node Name you noted from the previous screen.
   Next to it will be the IP Address for that C-LAN board.

To determine the IP address assigned to a voice system running software earlier than Communication Manager 2.0 (for example, MultiVantage 1.3 software):

1. Using your favorite system administration tool, log in to the voice system.
2. Type `display ip-interfaces` and press Enter.
3. Look for the C-LAN board that you want to use and note the value in the `Node Name` field.
4. Type `list node-names` and press Enter.
5. Look for the Node Name you noted from the previous screen.
   Next to it will be the IP Address for that C-LAN board.
Hardware and Software Requirements

Any computer you use to run Voice Announcement Manager should meet the following requirements:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows 2000 or Windows XP</td>
</tr>
<tr>
<td>RAM</td>
<td>32 MB</td>
</tr>
</tbody>
</table>
| Available Disk Space | 100MB + 15MB per VAL board  
                        | 100MB + 32MB per VAL board if you will have an hour’s worth of recordings on a board. |
| CD-ROM Drive       | Yes                                                                          |
| Extra Software     | pcAnywhere for remote support                                                 |

Additional Requirements

1. Voice Announcement Manager works with Communication Manager Release 2.0 and higher, DEFINITY voice systems Release 9.5 and higher, and MultiVantage™ solutions voice systems.

2. Your systems must have a C-LAN board installed, with asynchronous links configured, and the C-LAN board and configuration must be tested and fully functioning.

3. Your Voice Announcement Manager computer(s) and your Communication Manager voice systems must be on the same LAN/WAN.

See Preparing Communication Manager software for Voice Announcement Manager for more information.
Entering and Changing Voice System Information

The first time you run Voice Announcement Manager, the Select Option dialog box appears. Clicking the Yes button will display the Register Voice System dialog box. In this dialog box, enter the connection information for each voice system you want Voice Announcement Manager to support, and click OK.

- To add another voice system, choose System->Register Voice System. Voice Announcement Manager will then display the Edit Voice System Properties dialog box.

- To view or change the basic settings for a voice system you have already added to Voice Announcement Manager, right-click on a voice system in the Voice Announcement Manager tree and choose Edit Properties. Voice Announcement Manager will then display the Edit Voice System Properties dialog box.

- To view or change the file transfer modes for a voice system you have already added to Voice Announcement Manager, right-click on a voice system in the Voice Announcement Manager tree and choose File Transfer Modes. Voice Announcement Manager will then display the File Transfer Connections dialog box.

- To view or change the SNMP User Configuration for SCP enabled VAL boards, right-click on a voice system in the Voice Announcement Manager tree and choose SNMP User Configuration. Voice Announcement Manager will then display the SNMP User Editor dialog box.
Specifying Whether to Connect on Startup

Voice Announcement Manager Release 1.1 introduced a feature that lets you decide whether Voice Announcement Manager should connect to a given voice system upon startup, or not.

There are two ways to specify this: when you add a voice system to Voice Announcement Manager, or after. Either way, you follow the instructions for adding a voice system to Voice Announcement Manager, and check or clear the check box called “Connect at Startup.”
Viewing and changing VAL board properties

After you enter connection information in the Register Voice System dialog box and click OK, you can connect to any of the voice systems you added. When Voice Announcement Manager connects, it can collect and display information about each VAL board associated with that voice system.

**Viewing**

To view the VAL Board Properties dialog box, complete the following step:

1. Right-click the appropriate VAL board in the Voice Announcement Manager Tree and select **Edit Properties** from the popup menu.

**Changing**

The only information you can change in the Edit VAL Board Properties dialog box is the backup directory. To change this information, complete the following steps:

1. Right-click the appropriate VAL board in the Voice Announcement Manager Tree and select **Edit Properties** from the popup menu.
2. Change the backup directory.
3. Click **OK**.
I Can't See My VAL Boards

The most likely explanations are that either Voice Announcement Manager has not connected to the voice system, or you have not clicked the "lever" next to the voice system.

1. **Have you added the voice system to Voice Announcement Manager?**
   You must do so before Voice Announcement Manager can connect to the voice system and gather information about the VAL boards on it.

2. **Has Voice Announcement Manager connected to the voice system?**
   After you add a voice system to Voice Announcement Manager, there are two ways to connect to it.
   
   a. You can set up Voice Announcement Manager so that it connects automatically to the voice system each time you start Voice Announcement Manager. To do so, select the checkbox called "Connect at startup" on the Voice System Properties screen.
   
   b. You can connect to the voice system "manually." To do so, perform one of the following steps:
      
      ☐ Select the voice system you want Voice Announcement Manager to connect to, and choose **Get VAL Board Information** from the **System** menu.
      
      ☐ Right-click on the voice system you want Voice Announcement Manager to connect to, and choose **Get VAL Board Information** from the popup menu.

3. **Have you clicked the "lever" next to the appropriate voice system?**
   The first time Voice Announcement Manager starts, it displays all of the voice systems that have been added, but it does not "expand" the voice systems to display the VAL boards that are on them.
   
   To "expand" each voice system, click the lever to the left of the voice system. Voice Announcement Manager will display a list of the VAL boards on that system.
Replacing Your TN750 with the New VAL Board

If you are replacing a TN750C announcement circuit pack with the new VAL board (TN2501AP), convert the audio files on the old board to the new board by completing the following steps:

**CAUTION!**

Before you remove a TN750A or B circuit pack from its carrier, ensure that you have backed up the announcements that are stored on it. Once you remove the circuit pack from the carrier, power is lost along with the announcements.

1. Get a list and description of the announcements stored on the TN750C circuit pack.
2. Re-record any announcements currently resident on the TN750 circuit packs that you are replacing.
   
   You cannot transfer or restore TN750 announcements from flash card, tape, or optical disk to the VAL board.
3. Remove previous announcement administration (change announcements).
4. Record new announcements for the VAL board.
Setting up Automatic Login

You can set up Voice Announcement Manager so that each time you start it, it automatically connects to the voice systems that you specify, if you have entered the voice system information for that system.

There are two ways to set up Voice Announcement Manager so that it automatically connects.

**Option 1**

1. When you enter the voice system information, or anytime that you access the Edit Voice System Properties dialog box, simply check the Connect At Startup field.

**Option 2**

1. From the System menu, choose Connection At Startup Configuration.
2. In the window that appears, place a check mark next to each voice system that you want Voice Announcement Manager to automatically connect to upon startup.
3. Click OK.
Enabling and Disabling Virtual VAL Boards

Purpose of Enabling and Disabling
In traditional voice systems, if you do not need the announcement capabilities of your VAL board, all you have to do is to remove the board from the slot. Since the Avaya G700 Media Gateway has no physical VAL board present, removing "the board" is not an option. Since, for security reasons, there must be some other mechanism to prevent the "virtual VAL board" from being used for announcements, 2 commands have been implemented on systems with "virtual VAL boards." These commands are:

- enable announcement board <mediagatewaynumber>
- disable announcement board <mediagatewaynumber>

There is one important difference between enabling/disabling a virtual VAL board and removing a TN2501AP VAL board from a slot. Whether or not the virtual VAL board is enabled or disabled, you can still add/edit/delete announcement properties or FTP announcement files to the virtual VAL board. However, you can't play an announcement if the virtual VAL board is disabled. In a traditional system, if you remove the VAL board, you can add/edit/delete the announcement properties file, but you cannot initiate an FTP file transfer.

Prerequisites
The enable command enables the virtual VAL board announcement capabilities. The disable command disables the virtual VAL board announcement capabilities. Before these commands can be issued, the virtual VAL board must be registered for gateway-announcement.

To register the virtual VAL board for gateway-announcement, the Media Gateway must be registered with Media Gateway Controller. Then, using your favorite system administration tool, execute the command change media-gateway<MGnumber>. On the form that appears, go to field labeled V9 and change the value to gateway-announcement. An attempt to enable an announcement element that has not been registered with the Media Gateway Controller will be denied.

Procedure
To enable or disable a virtual VAL board, complete the following steps:

1. Right-click a virtual VAL board from the list displayed in the main window.
2. Click Enable or Disable.

Voice Announcement Manager 2.0 supports 260 boards (250 virtual VAL boards and 10 VAL boards) for S8700 voice systems and 50 virtual VAL boards for S8300 voice systems.

You can also enable/disable a virtual VAL board via the Virtual VAL Board Status dialog box.

Related Topic
- Viewing virtual VAL board status
Viewing Virtual VAL Board Status

You can view the status of a virtual VAL board by completing the following step:

- Right-click a voice system in the main window and choose View Virtual VAL Board Status from the popup menu.

The View Status option appears only if the voice system has virtual VAL boards. Voice Announcement Manager establishes a connection with the voice system that hosts the given virtual VAL board, and displays a list of all of the virtual VAL boards for that system, and their status.

Related Topic

- Enabling or disabling virtual VAL boards
Voice Announcement Manager Security

Voice Announcement Manager has no login and password protection. Unauthorized use of this product is prevented only through the login and password required by Windows, and the logins and passwords required by your voice systems. Once Voice Announcement Manager has been installed and configured, it stores the login IDs and passwords of your voice systems. From that point forward, only your Windows security prevents unauthorized users from gaining access to these devices.

If you have a service agreement with Avaya, or if you want Avaya support during Voice Announcement Manager’s warranty period, you must install a copy of pcAnywhere on the Voice Announcement Manager computers you want Avaya to support. For the required version number of pcAnywhere, see Hardware and Software Requirements. If used incorrectly, pcAnywhere can be a security risk. It is your responsibility to protect your network from unauthorized use. Before installing pcAnywhere, see the guidelines in pcAnywhere Security,
Testing Connectivity

You can test Voice Announcement Manager’s connections to a voice system anytime. Doing so verifies that the LAN/WAN connections are working between the Voice Announcement Manager computer and the selected voice system, and that Voice Announcement Manager has the correct connectivity information.

We recommend that you test Voice Announcement Manager’s connections after you first configure it, but before you use Voice Announcement Manager in day-to-day operations. We also recommend that you test Voice Announcement Manager’s connections after changing any connectivity information about the given voice system.

To test connectivity to a voice system, either:

- Click OK after you complete the Register Voice System dialog box for the first time, or
- In the Voice Announcement Manager tree, right-click on the voice system you want to connect to, and choose Get VAL Board Information from the popup menu.

If the connection is functional, you should be able to perform operations like view or change announcement properties. If the connection is not functional, Voice Announcement Manager will display an error message. For help understanding the error and fixing it, click the Troubleshooting button on the error message, and follow the instructions.
Testing a Connection

If you already have a connection set up, you can test it by:

- Viewing or changing announcement properties
- Copying or deleting audio files
Troubleshooting Voice Announcement Manager

This topic summarizes Voice Announcement Manager troubleshooting resources and provides links to more information. This topic covers only problems that may occur with the Voice Announcement Manager application, and between Voice Announcement Manager and the voice system it supports.

Note:
This topic does not cover problems that may occur on the VAL board or on the Communication Manager system.

Connection Errors

The following errors may appear as "message boxes" when Voice Announcement Manager fails to connect to a Communication Manager system. If one of these errors occurs, Voice Announcement Manager displays the message, and you can click the Troubleshoot button to view the associated help topic. These topics are listed again here for your reference, only.

- Too many users logged in
- Incorrect login
- Password has expired
- Remote reset
- Network connection failed
- Data is locked
- ASG is not enabled
- ASG is enabled
- Access denied
- Unexpected response from device
- Invalid password
- General communications error

Note:
If you try to connect to a non-SSH based voice system (that is, a non-Linux based system) via an SSH connection, you will receive a connection failure error. In this case, try to connect to the voice system via a normal connection.

Related Topics

- I can't see my VAL boards
Error Messages

Access Denied

The voice system you are trying to reach has denied you access. Check the login name and password or secret key for this connection.

For security reasons, the system that you are trying to connect to has not given a specific reason why your access has been denied. If you are sure that your login and password (or login and ASG Secret Key) are correct, then you should contact the administrator of the system you are connecting to for help.
ASG is Enabled

The voice system indicates that ASG not enabled for this login, but you have specified in the Voice System Properties screen that it is not enabled.

Voice Announcement Manager will display this error message if, in the Voice System Properties screen, you entered a login name that has ASG enabled and then incorrectly specified that Voice Announcement Manager should supply the system with a password. To fix the problem, either:

- Specify a login that does not use ASG, or
- Leave the login name as is, and check the ASG option instead of the password option. Then enter the appropriate 20-digit octal key for that system and login.
ASG is not Enabled

The voice system indicates that ASG is not enabled for this login, but you have specified in the Voice System Properties screen that it is enabled.

Voice Announcement Manager will display this error message if, in the Voice System Properties screen, you entered a login name that does not have ASG enabled and then incorrectly specified that ASG was enabled for this login. To fix the problem, either:

- Specify a login that uses ASG, or
- Leave the login name as is, and check the Password option instead of the ASG option. Then enter the appropriate password.
General Communications Error

A communications-related error has been detected and reported by your computer. For more information, see Voice Announcement Manager’s Status Pane, which is usually located at the bottom of the Voice Announcement Manager main window.
Incorrect Login

The voice system or messaging system you are contacting indicates that the login ID you have specified is not recognized.

You may want to:

- Check the spelling of the login ID in the Voice System Properties screen.
- Check that your login exists and is enabled on the system you want to connect to.

To do so, use your favorite system administration tool to log in with a different login ID and password (if you know one) that has permission to view the login information.
Invalid Password

The voice system or messaging system has informed Voice Announcement Manager that the password you supplied is invalid.

Try re-entering your password in the Voice System Properties screen.
Configuring Voice Announcement Manager

Network Connection Failed

Voice Announcement Manager has encountered a problem initiating a network connection to the voice system. Voice Announcement Manager cannot reach the system, or cannot find the system with the details you have provided in the Voice System Properties screen.

Note:

If you try to connect to a non-SSH based voice system (that is, a non-Linux based system) via an SSH connection, you will receive a connection failure error. In this case, try to connect to the voice system via a normal connection.

Perform the following steps:

1. You may want to re-try the connection. There may be a temporary problem with your computer network.

2. If Windows Networking is set up on you computer, do you have access to your normal network services (like e-mail or the web)?

   If you do, and they are working as you expect them to, then your Windows Networking is probably OK. If you do not have access, then you may want to troubleshoot your Windows Networking setup.

3. Check that the host system you are trying to connect to exists on your network and is operating.
   - Check the spelling of the host and port number in the Voice System Properties screen for the system you are trying to connect to.
   - Check that the system you are trying to connect to can be reached from your computer by pinging it. If the system does not respond to the ping, then:
   - Check that the system you are trying to connect to is working. Check its power and use the manufacturer’s instructions to check the health of the system.
   - Try to ping another well-known system (like your department server). If the system does not respond, then troubleshoot your Windows Networking setup.
   - Check your network cable.
   - If you are operating in an environment without a Domain Name Server (DNS) or in an environment where your DNS is untrustworthy, then you should use the IP address of the system you wish to connect to instead of the host name in the Voice System Properties screen (i.e., Use 123.192.10.17 instead of mysystem or mysystem.mycompanyname.com).

4. Check that the port number you are using is correct in the Voice System Properties screen for the system you are trying to connect to. Check with your system administrator or the system’s manual to determine what the correct port number is.

5. Check how many network connections the system that you are trying to reach supports.

   The system you are connecting to may only support a limited number of network connections. If the system has reached the maximum number of connections, then it will refuse connections and display this error message. The documentation for the system you are connecting to will indicate the connection limitations of that system. In this situation, you will be able to connect if another user disconnects.
If you have defined several network connections to the same system, then you may be the person who is holding a connection open. If a system only supports one network connection, and you define two network connections, your second connection will fail.
Password has Expired
The password for the account you are using has expired.

You may want to:

- Use your favorite system administration tool to log in and change the password. Then go to Voice Announcement Manager’s Voice System Properties screen and change the password to the one you just created.

- Alternately, ask your administrator to change your password. After you get the new password, make sure that you enter the new one in the appropriate Voice System Properties screen within Voice Announcement Manager.
Data is Locked

Voice Announcement Manager can not perform the requested action because someone else is performing an activity that takes exclusive control of resources on the voice system that you are connected to.

Wait for the command that is holding the resource to finish.
Remote Reset

Voice Announcement Manager has been unexpectedly disconnected by the remote system. This is generally a TCP/IP communications problem in which some component of the computer network, or the voice system (or messaging system), loses power or malfunctions.

1. Try re-connecting to the system. The problem may be temporary.
2. If you can, check that the voice system is powered up and functioning properly.
3. Check that your computer network is functioning properly by ping the voice system.
   c. If the voice system responds to the ping, you might want to retry the connection.
   d. If the system does not respond, or the ping requests time out, then either:
      ⊗ make sure your cable connection to the computer network is secure and is functioning properly.
      ⊗ contact the person responsible for your computer network.
4. In the worst case, you may have to reset the system you are connecting to.

To find out how to diagnose system health, see the Communication Manager software documentation online. Or search for it as described in Contacting Us for Documentation.
Too Many Users Logged In

There is a restriction on the number of administrators that can be logged in to the system you are trying to reach and this limit has been reached. Voice Announcement Manager has received a message from the system indicating that the limit was reached prior to your login attempt.

You may want to:

- Ask other administrators to drop their connection to the system that you want to connect to.
- Consult the system’s administration and maintenance guides for help with clearing administrator connections.
Unexpected Response from Device

When logging into a system, Voice Announcement Manager encountered a response that it was not expecting.

Try logging in manually using your favorite system administration tool, to diagnose the login problem. It may be that you are connecting to the wrong system, or the system you are connecting to is behaving strangely.
Using Ping

The Windows' ping utility enables you to determine the state of a connection between one point on a TCP/IP network and another. You can use ping to determine if your computer can reach the voice system that you specify.

To execute ping:

1. Use the Start menu's Programs->Command Prompt to get a command prompt.
2. At the command prompt, enter: ping <hostname or IP address>
   Where <hostname or IP address> is the voice system you are trying to reach. An example hostname might be: mycomputer or mycomputer.mycompany.com. An example IP address might be: 123.121.9.18.
   - If you get a message that states "request timed out" then the following may apply:
     - The system you are trying to connect to is down, or not responding.
     - You have misspelled, or left off the domain name (company.com) of the host you are trying to connect to.
     - You have entered the wrong IP address.
     - Your computer’s networking parameters are not set up correctly.
     - The host you are trying to connect to is behind a firewall.
   - If you get a message that states "host unreachable" then the following may apply:
     - You have misspelled, or left off the domain name (company.com) of the host you are trying to connect to.
     - You have entered the wrong IP address.
     - Your computer’s networking parameters are not set up correctly.
     - The host you are trying to connect to is behind a firewall.
Using Tracert

Tracert (trace route) is a Windows utility that can be of use to your computer network administrator for diagnosing problems in the computer network between your computer and the system you are trying to connect to. Tracert shows a trace of the network devices on the route that data takes when travelling between your computer and the system you are trying to connect to. If data travels over a variety of network devices before it gets to the system you are trying to connect to, tracert can help you determine if one of these has failed.

To execute tracert:

1. Use the Start menu’s Programs->Command Prompt to get a command prompt.
2. At the command prompt, enter: tracert <hostname or IP address>
   Where <hostname or IP address> is the voice system you are trying to reach. An example hostname might be: mycomputer or mycomputer.mycompany.com. An example IP address might be: 123.121.9.18.
Troubleshooting a Computer Network Cable

One of the best ways to diagnose your network cable is to find a computer that has a working network connection, and swap your suspect cable for the good one on the computer that has networking that works. Follow these steps to determine whether your cable is faulty:

1. On a computer with a working network and network cable, ping the voice system or messaging system you are trying to reach.

2. Remove the cable from this computer and replace it with the suspect cable.

3. Ping the voice system or messaging system again, using the exact same information as in Step 2.

   If the system does not respond, then the cable is faulty and you should repair or replace it. If the system does respond, then the suspect cable is OK, and you should investigate other potential problems.

4. Replace the original cable.
Troubleshooting Computer Network Problems

To determine whether there is a problem with your computer network, answer the following question:

1. Are you able to use a web browser or collect email from your computer?
   - If yes, then chances are there is no problem between your computer and the computer network. Instead, the problem is likely to be somewhere else on the computer network.
   - If no, then your computer may not be set up correctly to connect to the network. Try the following:
     - If you are connected to a LAN or WAN, ask your computer network administrator to help you check your computer’s Windows’ networking settings.
     - If you do not have access to your computer network administrator, you can get help from the Windows network troubleshooting tool. To use it, complete the following steps:
       a. Go to the Windows Start Menu and select the "Help" item.
       b. Select the "Contents" tab and open the troubleshooting topic.
       c. Open the topic named "If you have trouble using the network".
          This opens the Microsoft network troubleshooting tool which will take you through a simple set of steps to set up new networking cards or diagnose Windows-related networking problems.
          - If you are using dial-up networking (that is, connecting to a TCP/IP computer network using a modem), ask your computer network administrator or your Internet service provider for help configuring and troubleshooting your dial-up network.
Using Voice Announcement Manager

Creating a Voice System Login for Voice Announcement Manager

When you add a voice system to Voice Announcement Manager and complete the Register Voice System dialog box for that system, you can use a Login Name that already exists on your voice system, or you can create one especially for Voice Announcement Manager.

Creating a login especially for Voice Announcement Manager allows you to track what Voice Announcement Manager is doing on the given voice system. You can view the Communication Manager History Log and look at the activities being performed by the Login Name that you assign to Voice Announcement Manager.

To create a new login on the voice system, you must have permissions on it to add and change logins. The login you create must be able to perform the following Communication Manager software commands:

- list configuration all
- list configuration board
- display ip-interfaces
- list node-names
- display system-parameters country-options
- list integrated-annc-boards
- change announcements
- list announcements
- list directory board
- enable filesystem board
- disable filesystem board
- enable announcement board <mediagatewaynumber>
- disable announcement board <mediagatewaynumber>
- enable filexfer
- disable filexfer
- add audio-group
- remove audio-group
- change audio-group
- list ip-interface
- list ip-interface all

Note:

If you have any difficulty with the procedure below, you can find additional, more generic instructions here.

1. Using your favorite system administration tool, log in to the voice system.
2. At the command line, enter add login <name>

Where <name> is the word you want to use as the login.
3. Enter your password.
   - Verify that the Login Type: field is set to **customer**.
   - Verify that the Service Level: field is set to **super-user**.

4. In the Login’s password: field, enter the password that you want to associate with the administrative login.

5. In the Reenter Login’s password: field, enter the password again.

6. If you want this login to use ASG, then in the Access Security Gateway?: field, enter a y and complete the fields on page 2 of the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blocked</td>
<td>Enter y to temporarily disable the login ID from accessing the voice system through ASG.</td>
</tr>
<tr>
<td>System Generated Secret Key?</td>
<td>To use ASG, either you or the voice system must generate a Secret Key, which you must enter on the voice system and in Voice Announcement Manager when you are configuring it. Enter a y to have the voice system generate the Secret Key.</td>
</tr>
</tbody>
</table>
| Secret Key                 | If you want to create your own Secret Key, enter it in this field. Be sure to note the Secret Key; you will need it to configure Voice Announcement Manager and/or any response generation devices. The Secret Key must conform to the following requirements:  
   - It must be 20 digits long.  
   - Each digit must be between 0 (zero) and 7, inclusive.  
   - The last number must be 0 (zero).  
   - The next-to-last number must be 0 (zero), 2, 4, or 6. |
| Expiration Date            | To disable this login after a certain date, enter the date in this field. If you enter a value in the Number of Sessions field, then the login will be disabled based on whichever criteria is satisfied first. |
| Number of Sessions         | Enter the number of times this login ID can be used to access the voice system (between 1 and 999). If you enter a value in the Expiration Date field, then the login will be disabled based on whichever criteria is satisfied first. |
| Restrict Days of Week      | Enter y to restrict this login from accessing the voice system on the specified day of the week. |
| Restrict From Time and Restrict To Time | Enter the time interval during which this login ID is blocked from accessing the voice system. |

7. Press Enter to submit the form.

8. At the command line, enter `change permissions <name>`.  

---

70
Where <name> is the word you used as the login in Step 2. The system displays the Command Permission Categories form.

9. Set the fields to \texttt{y} to enable Voice Announcement Manager to perform the listed activity. Use the table below to decide which of the fields to set to \texttt{y}.

The fields listed in the following table are for a basic voice system configuration. Your voice system may display more than the following fields. For help setting those fields, refer to the \textit{Administrator's Guide for Avaya Communication Manager Software}, 555-233-506, as described in \textit{Contacting Us for Documentation}.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Admin and Maint Data?</td>
<td>Voice Announcement Manager can issue display, list, monitor, status, and schedule (reports) commands.</td>
</tr>
<tr>
<td>System Measurements?</td>
<td>Voice Announcement Manager can issue the list measurements command.</td>
</tr>
<tr>
<td>System Mgmt Data Transfer Only?</td>
<td>This field is not relevant to Voice Announcement Manager.</td>
</tr>
<tr>
<td>Administer Stations?</td>
<td>Voice Announcement Manager can issue add, change, duplicate, or remove commands for stations, data modules, and associated features, such as abbreviated dialing, vectors, and routing tables.</td>
</tr>
<tr>
<td>Administer Trunks?</td>
<td>Voice Announcement Manager can issue commands to administer AAR/ARS, trunk groups, remote access, and route patterns.</td>
</tr>
<tr>
<td>Administer Features?</td>
<td>Voice Announcement Manager can issue commands to administer feature-related system parameters, such as coverage paths, class of service, class of restriction, system parameters, authorization codes, and security.</td>
</tr>
<tr>
<td>Administer Permissions?</td>
<td>Voice Announcement Manager can issue commands to administer logins and command permissions.</td>
</tr>
<tr>
<td>Restricted Objects?</td>
<td>You can list any objects that Voice Announcement Manager cannot access, like stations, trunks, or hunt groups.</td>
</tr>
</tbody>
</table>

10. Press Enter.
Creating a New Announcement

Voice Announcement Manager does not offer announcement recording or editing functionality. However, using other applications, you can record an announcement for callers to hear when they dial a specific extension or as part of call vectoring.

The procedure for recording a new announcement is different depending on what recording method you use. Specifically, if you are recording a new announcement using a system phone, you MUST administer the announcement properties before you record the audio file.

1. **Administer the announcement properties.**
   
   This step must occur first only if you will be recording the audio using a system phone. Otherwise, you can administer announcement properties after you record the audio.

2. Record new announcements using one of the following methods:
   
   - **Record using a professional studio**
   - **Record using a computer recording application**
   - **Record using a system phone**

   Note:

   All audio files **MUST** conform to the VAL Audio File Format Requirements.

3. Copy the announcement's audio file to the Voice Announcement Manager computer, as follows:
   
   - If you recorded the file using a studio or third-party software, copy the file to the Voice Announcement Manager computer using Windows File Explorer.
   - If you recorded the file using your telephone, copy the file from the voice system to the Voice Announcement Manager computer using the instructions in Copying Audio Files to and from a voice system.
Copying Audio Files to and from a Voice System

To copy audio files to or from your voice system, complete the following steps:

1. Using the Voice Announcement Manager Tree, navigate to the appropriate voice system.
2. Right-click the appropriate VAL board and choose **Copy/Delete Audio Files**.
   Voice Announcement Manager displays the Copy and Delete Audio Files dialog box.
3. Complete the dialog box and click **Close**.

![CAUTION!](image)

When you copy an audio file to the VAL board, it first goes to the dynamic read-only memory (RAM) on the board before being transferred to FLASH memory on the VAL board. During the 5 minutes that it takes for this to occur, if someone were to remove the VAL board or if the voice system were to lose power, then the audio file would be lost and you would have to copy it to the VAL board again. For more information, see "Non-volatile storage of announcements on VAL" in the chapter called "Managing Announcements" in the *Administrator's Guide for Avaya Communication Manager Software*, 555-233-506. Search for it as described in *Contacting Us for Documentation*. 
Viewing Announcement Properties

To view the information pertaining to a particular announcement on your voice system, complete the following steps:

1. Right-click the appropriate VAL board in the Voice Announcement Manager Tree and select **View Announcement Properties**.

   You can also double-click the appropriate VAL board. Voice Announcement Manager displays the Announcement Properties window in the right pane.

2. In the Announcement Properties window, right-click an announcement and choose **Edit** from the popup menu.

   Voice Announcement Manager displays the Announcement Property dialog box.
Entering New Announcement Properties

To enter properties for a new announcement in Voice Announcement Manager, complete the following steps:

1. Using the Voice Announcement Manager Tree, navigate to the voice system where you want the new announcement to go.
2. Right-click the appropriate VAL board and choose View Announcement Properties from the popup menu.
   Voice Announcement Manager displays the Announcement Properties table in the right pane.
3. Right-click anywhere in the table and choose New.
   Voice Announcement Manager displays an empty Announcement Property dialog box.
4. Complete the Announcement Property dialog box and click OK.
   For help completing these fields, click the Help button on this dialog box.
Changing Announcement Names

To change the name of an announcement, you must do two things:

- Change the value of the ‘name’ field in the announcement properties
- Change the name of the file on the VAL board.

To do so, complete the following steps:

1. Follow these steps to change the name in the announcement properties window.

2. Do one of the following:
   - Record a new audio file, professionally, using your computer, or using your phone, and give the file the new name. (If you use your phone, you can skip the rest of this topic.)
   - Make a copy of an old audio file (if it contains the audio content you want), and then rename it with the new name, as follows:
     d. Right-click the VAL board that contains the audio file you want to copy.
     e. Choose Copy/Delete Audio files.
     f. Highlight the audio file that you want to copy in the list on the right.
     g. Click the < button.

     If the folder listed on the left happens to be the location where Voice Announcement Manager stores "backup" files for this board, then Voice Announcement Manager will indicate this and ask if you want to proceed.

     - If you click Yes, Voice Announcement Manager adds the file to the backup folder for that board. (Or overwrites it, if it has the same name as a file already in the backup folder.)
     - If you click No, the copy action is cancelled.

     You don’t have to copy the file to the same folder you put backups in. If you prefer this option, then change the folder into which the file would be copied, as follows:

     i. Click Change Folder.
     ii. Navigate to the folder where you want to copy the file.

     If the folder that you want to copy to DOES NOT EXIST, you can create it using Microsoft File Explorer. Then, return to the Voice Announcement Manager Copy/Delete Audio Files dialog box and repeat these two steps.

     iii. Repeat step c. and d. (above).

     This time, you should NOT get the message. Voice Announcement Manager should copy the selected file over to the left box. If Voice Announcement Manager displays a message that the file has been successfully copied, and you click OK, and the file does not appear in the left box, it’s there anyway. (You can see it if you use Microsoft File Explorer).

     h. Once the file has been copied, change the name of the file using Microsoft File Explorer.
i. Return to the Copy/Delete Audio Files dialog box,
j. Highlight the file on the left and then click > to move it back to the VAL board.
   Doing so places a copy of the audio file with the **new** name on the VAL board.
k. (Optional): If you no longer need the old audio file on the VAL board, either:
   - Delete it, or
   - Copy it to the Voice Announcement Manager computer, and then delete it from the VAL board.
Changing Announcement Properties

You can change any of the "properties" associated with a given announcement.

Note:

Changing announcement properties does NOT change any aspect of the audio file associated with the announcement. That is a separate activity.

To change announcement properties, complete the following steps:

1. Right-click the appropriate VAL board in the Voice Announcement Manager Tree and select View Announcement Properties.

   Voice Announcement Manager displays the Announcement Properties window for the selected VAL board in the right pane.

2. Do one of the following:

   ○ Double-click in a cell and enter the change. Some fields are display-only and do not respond to the cursor.
   ○ Click in a cell and select a value.
   ○ Right-click the appropriate row in the Announcement Properties window, and choose Edit from the popup menu. The Announcement Property dialog box appears. Enter the change(s), and then click OK to save your changes.

3. If necessary, click in another row to move the highlight bar away from the edited row.

4. From the File menu, select Save Announcement Properties.

   The changed announcement properties are saved to the Voice Announcement Manager computer and to the selected voice system.
Deleting Audio Files

To delete audio files from your voice system, complete the following steps:

1. Using the Voice Announcement Manager Tree, navigate to the appropriate voice system.
2. Right-click the appropriate VAL board and choose **Copy/Delete Audio Files**.
   Voice Announcement Manager displays the Copy/Delete Audio Files dialog box.
3. Be sure that the correct VAL board is listed at the top of the Files on VAL Board box.
   If it is not the correct VAL board, click **Close** and start again.
4. Select the audio file you want to delete from the box on the right and click **Delete File**.
   A confirmation dialog box appears prompting whether you want to delete the corresponding announcement property.
5. Perform one of the following steps:
   - If you want to delete the announcement property also, click **Yes**.
   - If you do not want to delete the announcement property, click **No**.
6. Click **Yes** to delete the audio file.
   Voice Announcement Manager deletes the selected audio file from the VAL board.
Deleting Announcement Properties

Voice Announcement Manager lets you delete announcement properties from either your Voice Announcement Manager computer or from your voice system.

To delete announcement properties, complete the following steps:

1. Using the Voice Announcement Manager Tree, navigate to the voice system containing the announcement properties that you want to delete.

2. Right-click the appropriate VAL board and choose View Announcement Properties from the popup menu.

   Voice Announcement Manager displays a table of announcement properties in the right pane.

3. In the table, select the announcement that you want to delete.

4. Right-click and choose Delete from the popup menu.

   Voice Announcement Manager displays a confirmation message.

   If the on board status of the announcement property is set to Y, (that is, the announcement is administered), you will have the option of deleting the associated audio file. Click Yes if you want to delete the audio file also.

5. To delete the announcement, click Yes to the confirmation message.

6. From the File menu, select Save Announcement Properties to delete the announcement properties from the Voice Announcement Manager computer and the selected voice system.
Deleting Voice Systems from Voice Announcement Manager

Deleting a voice system from Voice Announcement Manager does not remove it anywhere else. It only affects what you see in the Voice Announcement Manager application.

To remove a voice system from Voice Announcement Manager, complete the following steps:

1. In the Voice Announcement Manager main window, perform one of the following steps:
   - Right-click a voice system in the Voice Announcement Manager tree, and choose Delete Voice System from the popup menu.
   - Select the voice system from the Voice Announcement Manager tree, and choose Delete Voice System from the System menu.

   Voice Announcement Manager displays a confirmation message.

2. To delete the voice system from Voice Announcement Manager, click Yes.
Backing Up

With Voice Announcement Manager, you can:

- back up announcement properties and audio files for a single VAL/virtual VAL board
- back up announcement properties and audio files for selected VAL/virtual VAL boards on a voice system that you select. (This voice system must be registered with Voice Announcement Manager.)
- back up announcement properties and audio files for all VAL/virtual VAL boards on all of your voice systems (just the ones that Voice Announcement Manager knows about).

With Voice Announcement Manager, you cannot back up based on a group of voice systems.

Backing Up a Single VAL/Virtual VAL Board

To back up announcement properties and audio files for a single VAL board, complete the following steps:

1. From Voice Announcement Manager’s main window, do one of the following:
   - Right-click the VAL board in the Voice Announcement Manager tree and choose Back Up.
   - Select the VAL board in the Voice Announcement Manager tree, and choose Back Up from the Actions menu.

   Voice Announcement Manager displays the Back Up dialog box.

2. Complete the Back Up dialog box.

Backing Up Selected VAL/Virtual VAL Boards

To back up announcement properties and audio files for selected VAL/virtual VAL boards on a voice system registered with Voice Announcement Manager, complete the following steps:

1. From Voice Announcement Manager’s main window, do one of the following:
   - Right-click the voice system in the Voice Announcement Manager tree and choose Back Up.
   - Select the voice system in the Voice Announcement Manager tree, and choose Back Up from the Actions menu.

   Voice Announcement Manager displays the Backup Selected VAL Boards dialog box.

2. Complete the Backup Selected VAL Boards dialog box.

Backing Up All VAL Boards

⚠️ CAUTION!
Using Voice Announcement Manager

This feature overwrites audio files and announcement properties on the Voice Announcement Manager computer when there are audio files or announcement properties with a matching name on the VAL board. (This will NOT overwrite them if there are no matching audio files or announcement properties on the voice system.)

Because the timestamp on audio files that are copied to the VAL board changes every time the files are copied (rather than showing the original creation date), comparing the timestamp of an audio file on the Voice Announcement Manager computer to the one on the VAL board does not accurately reflect which file is most recent. For this reason, Voice Announcement Manager does not present you with timestamp information, and does not compare timestamps before copying.

For this reason, before you use this feature, be absolutely certain that audio files and announcement properties on the voice system are the most recent. Otherwise you might overwrite more-recent files on the Voice Announcement Manager computer with old files from the voice system.

To back up announcement properties and audio files on all voice systems that Voice Announcement Manager knows about, do one of the following:

- Right-click the Voice Systems node in the Voice Announcement Manager tree, and choose Back Up All.
- Select the Voice System node in the Voice Announcement Manager tree, and choose Back Up All Voice Systems from the Actions menu.
Restoring

With Voice Announcement Manager, you can:

- restore announcement properties and audio files for a single VAL/virtual VAL board
- restore announcement properties and audio files for selected VAL/virtual VAL boards on a voice system that you select. (This voice system must be registered with Voice Announcement Manager.)
- restore announcement properties and audio files for all VAL/virtual VAL boards on all of your voice systems (just the ones that Voice Announcement Manager knows about).

With Voice Announcement Manager, you cannot restore based on a group of voice systems.

Restoring from a Single VAL Board

To restore announcement properties and audio files from a single VAL/virtual VAL board, complete the following steps:

1. From Voice Announcement Manager’s main window, do one of the following:
   - Right-click the VAL board in the Voice Announcement Manager tree, and choose Restore.
   - Select the VAL board in the Voice Announcement Manager tree, and choose Restore from the Actions menu.

A warning dialog box appears.

2. Click Yes.

Voice Announcement Manager displays the Restore Audio Files and Announcements Properties dialog box.

3. Complete the Restore Audio Files and Announcements Properties dialog box.

For help understanding the dialog box, click Help on that dialog box.

Restoring from Selected VAL/Virtual VAL Boards

To restore announcement properties and audio files from selected VAL/virtual VAL boards, complete the following steps:

1. From Voice Announcement Manager’s main window, do one of the following:
   - Right-click the voice system in the Voice Announcement Manager tree, and choose Restore.
   - Select the voice system in the Voice Announcement Manager tree, and choose Restore from the Actions menu.

A warning dialog box appears.

2. Click Yes.

Voice Announcement Manager displays the Select VAL Boards To Be Restored dialog box.

3. Complete the Select VAL Boards To Be Restored dialog box.

For help understanding the dialog box, click Help on that dialog box.
Restoring all VAL Boards

**CAUTION!**

This feature overwrites audio files and announcement properties on the VAL board when there are audio files or announcement properties with a matching name on the Voice Announcement Manager computer. (This will NOT overwrite them on the VAL board if there are no matching audio files or announcement properties on the Voice Announcement Manager computer.)

Because the timestamp on audio files that are copied to the VAL board changes every time the files are copied to the VAL board (rather than reflecting the original creation date), comparing the timestamp of an audio file on the Voice Announcement Manager computer to the one on the VAL board does not accurately reflect which file is most recent. For this reason, Voice Announcement Manager does not present you with timestamp information, and does not compare timestamps before copying.

For this reason, before you use this feature, be absolutely certain that matching audio files and announcement properties on the Voice Announcement Manager computer are the most recent. Otherwise you might overwrite more-recent files on the voice system with old files from the Voice Announcement Manager computer.

To restore announcement properties and audio files on all voice systems registered with Voice Announcement Manager, perform the following step:

From Voice Announcement Manager’s main window, do one of the following:

- Right-click the Voice Systems node in the Voice Announcement Manager tree, and choose **Restore All.**
- Select the Voice Systems node in the Voice Announcement Manager tree, and choose **Restore All Voice Systems** from the **Actions** menu.
Viewing the Activity Log

The activity log contains details of the actions that Voice Announcement Manager performs. This information is also displayed in the Status pane.

To view the activity log, complete the following steps:

1. Perform one of the following steps:
   - From the View menu, select View Logs.
   - Click the View Logs button on the toolbar.

   A WordPad window appears displaying the contents of the activity log. The oldest record is displayed on the first line of the file, and the newest record is displayed on the last line of the file.

2. When you are finished, close the WordPad window.
Viewing the Size of Audio Files

The procedure describes how to view the properties for the audio files on the VAL/virtual VAL board you select. For each audio file, the following information is displayed:

- name
- size
- length (in seconds)
- time stamp

To view a list of all audio files on a VAL/virtual VAL board, complete the following steps:

1. Perform one of the following steps:
   - Right-click a VAL/virtual VAL board in the Voice Announcement Manager tree, and then choose View/Rename Audio Files Properties from the popup menu.
   - Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then choose View Audio Files Properties from the View menu.
   - Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then choose View/Rename Audio Files from the Actions menu.

   Voice Announcement Manager displays the View Audio Files Properties dialog box.

2. When finished, click Cancel.
Moving Announcements between VAL Boards

The procedure describes how to move announcement files from a VAL/virtual VAL board to another VAL board on the same voice system. You can also move the corresponding announcement property file.

Note:

You can also move announcement files from the Search Results window.

To move announcements from a VAL/virtual VAL board, complete the following steps:

1. Perform one of the following steps:
   - Right-click a VAL/virtual VAL board in the Voice Announcement Manager tree, and then choose Move Audio Files from the popup menu.
   - Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then choose Move Audio Files from the Actions menu.

   Voice Announcement Manager displays the Move Announcement Files - Select Files To Move dialog box.

2. Complete the Move Announcement Files - Select Files to Move dialog box, and click Next.

   The Move Announcement Files – Select Destination VAL Board dialog box appears.

3. In the VAL Boards On box, select the VAL board to which you want to move the file, and click the > button.

   The VAL/Virtual VAL board you selected appears in the Destination VAL Board box.

4. If you want to override the protected bit, click the Override Protected Bit check box.

5. Click Finish to start the move.
Moving the Announcement Property between VAL Boards

The procedure describes how to move the announcement administration/property (and the associated announcement file) from one VAL board to another on the same voice system. In this procedure, the announcement administration/property is copied to the destination VAL board and deleted from the source VAL board.

Note:
You can also move announcement files from the Search Result dialog box.

To move an announcement property from a VAL/virtual VAL board, complete the following steps:

1. Right-click the appropriate VAL board in the Voice Announcement Manager Tree and select View Announcement Properties.
   Voice Announcement Manager displays the Announcement Properties table in the right pane.

2. Right-click the announcement you want to move, and then choose Move from the popup menu.
   Voice Announcement Manager displays the Move Announcement Property dialog box.

3. Complete the Move Announcement Property dialog box, and click OK.
   For help completing these fields, click the Help button on this dialog box.
Broadcasting Announcement Files to VAL Boards

The procedure describes how to broadcast announcement files to various VAL/virtual VAL boards on different voice systems.

To broadcast announcement files, complete the following steps:

1. From the Actions menu, select Broadcast. Voice Announcement Manager displays the Broadcast Announcement Files - Select Files dialog box.
2. Complete the Broadcast Announcement Files - Select Files dialog box, and click Next.
Viewing/Changing the Status of Virtual VAL Boards

This procedure describes how to:

- view the status of all the virtual VAL boards on a voice system
- change the status of a virtual VAL board

Note:

You can perform this procedure only if a virtual VAL board is registered with the voice system.

To view or change the status of virtual VAL boards, complete the following steps:

1. Perform one of the following steps:
   - Right-click a voice system in the Voice Announcement Manager tree, and then choose View Virtual VAL Board Status from the popup menu.
   - Select a voice system in the Voice Announcement Manager tree, and then choose View Virtual VAL Board Status from the View menu.

   Voice Announcement Manager displays the Virtual VAL Boards Status dialog box for the selected voice system.

2. If you want to change the status of a board, perform one of the following steps:
   - If you want to enable a virtual VAL board, click on the Status cell for the board, and select Enabled.
   - If you want to disable a virtual VAL board, click on the Status cell for the board, and select Disabled.

3. Click Update to save your changes.
Configuring E-mail Notification

This procedure describes how to configure the default email notification information for Voice Announcement Manager. Unless you specify email addresses when you create a task, Voice Announcement Manager will send email about the outcome of the scheduled tasks to the addresses you enter in this procedure.

To configure the default email notification information, complete the following steps:

1. From the System menu, select Email Configuration.
   The Configure Application Specific E-mail Notification dialog box appears.
2. Complete the Configure Application Specific E-mail Notification dialog box.
Viewing Voice Announcement Manager Version

To determine what version of Voice Announcement Manager you are using, choose Help> About.
Importing Announcement Properties

Voice Announcement Manager lets you import voice announcement properties from a comma-separated values (CSV) file and send that data to a voice system. The CSV file may contain the following fields:

- Number (required)
- Name
- Repeat
- Extension
- COR
- Queue
- Protect
- Rate
- TN
- Port

Note:

*If the COR, TN, Queue, Protect, Rate, or Port fields are blank, the defaults for these settings on the voice system will be used for the imported announcement properties.*

To import announcement properties from a CSV file, complete the following steps:

1. Perform one of the following steps:
   - Right-click the voice system in the Voice Announcement Manager tree, and then choose **Import Announcement Properties** from the popup menu.
   - Select the voice system in the Voice Announcement Manager tree, and then choose **Import Announcement Properties** from the **System** menu.

   The Import Data – Select Announcement Fields dialog box appears.

2. In the Available fields box, select the field you want to import from the source file.

3. Click the > button.

   The field you selected appears in the right box.

   Repeat steps 2 and 3 for each field you want to import. If you want to import all of the fields, click the >> button.

   Note:

   *If the COR, TN, Queue, Protect, Rate, or Port fields are blank, the defaults for these settings on the voice system will be used for the imported announcement properties.*

4. Click **Next**.

   Voice Announcement Manager displays the Import Announcement Properties Wizard dialog box.

5. Click **Select**.

   The Open dialog box appears.
6. Select the CSV file you want to import, and click **Open**.
   If you want to view a sample file that is set up correctly, click **View Sample File**.

7. Perform one of the following steps:
   - If you want to add the announcement properties from the selected file to the voice system, select **Add**.
   - If you want to change the fields of the existing announcement properties on the voice system with the fields in the selected file, select **Change**.
   - If you want to delete all of the announcement properties on the voice system that correspond with the announcement properties in the selected file, select **Delete**.

8. If you do not want to import the first row of data from the CSV file, click **Yes**.

9. Click **Next**.
   The Import Data - Summary dialog box appears.
   If you want to make changes to the selected file, click **View/Edit Import File**, and make your changes.
   If you want to schedule the import, click **Schedule this task**, and set the time and frequency.

10. Click **Finish**.
    If you are not scheduling this task, a status box appears showing the status of the import.
    When the import is complete, the Import Announcement Properties Task dialog box appears.
    Click **View Logs** if you want to view the Voice Announcement Manager activity log.

11. When finished, click **Close**.
Exporting Announcement Properties

Voice Announcement Manager lets you export voice announcement properties from a voice system to a comma-separated values (CSV) file. You can specify which of the following fields will be exported to the CSV file:

- Announcement Number
- Extension
- Type
- COR
- Name
- Queue
- Protect
- Rate
- Port

To export announcement properties to a CSV file, complete the following steps:

1. Perform one of the following steps:
   - Right-click the voice system in the Voice Announcement Manager tree, and then choose Export Announcement Properties from the popup menu.
   - Select the voice system in the Voice Announcement Manager tree, and then choose Export Announcement Properties from the System menu. The Export Data – Filters dialog box appears.

2. In the Value box for the field in which you are interested, enter the value you want to export from the voice system. You may enter wildcard characters.

3. Repeat Step 2 for any other fields in which you are interested.

4. Click Next.
   - The Export Data – Fields dialog box appears.

5. In the Available fields box, select the field you want to export.

6. Click the > button.
   - The field you selected appears in the right box.
   - Repeat steps 5 and 6 for each field you want to export. If you want to export all of the fields, click the >> button.

7. Click Next.
   - Voice Announcement Manager displays the Export Data – Announcement Properties dialog box.

8. In the Export File box, enter the path and name for the file to which you will export the data.

9. Select the Export Table Header check box if you want to export the table header information.
   - The Sample Export box shows the first several lines of data that will be exported.

10. Click Next.
If the file to which you are exporting the data does not exist, a dialog appears prompting you to create the file. Click **Yes**.

The Export Data – Summary dialog box appears.

If you want to schedule the import, click **Schedule this task**, and set the time and frequency.

11. Click **Finish**.

   A status box appears showing the status of the export.

   When the export is complete, the Export Announcement Properties Task dialog box appears.

   Click **View Logs** if you want to view the Voice Announcement Manager activity log.

12. When finished, click **Close**.
Printing Announcement Properties

To print a list of announcement properties, complete the following steps:

1. Right-click the appropriate VAL board in the Voice Announcement Manager Tree and select View Announcement Properties.
   Voice Announcement Manager displays the Announcement Properties table in the right pane.

2. Perform one of the following steps:
   - From the File menu, select Print Announcement Properties.
   - Click the Print button on the toolbar.

Note:
You can also print announcement properties from the Search Result dialog box.

To preview how the announcement properties will be printed, complete the following steps:

1. Right-click the appropriate VAL board in the Voice Announcement Manager Tree and select View Announcement Properties.
   Voice Announcement Manager displays the Announcement Properties table in the right pane.

2. Perform one of the following steps:
   - From the File menu, select Print Preview.
   - Click the Print Preview button on the toolbar.
Configuring the Voice Announcement Manager Properties

From the Voice Announcement Manager window, you can configure the following system settings for Voice Announcement Manager:

- the maximum file size for the activity log. By default, the file size for the activity log is 1 MB. If the file size reaches the limit you set, the file `val_status.txt` will be copied to the file `val_status.txt.old`, and Voice Announcement Manager will start logging messages in the new `val_status.txt` file. If the file `val_status.txt.old` already exists, that file will be overwritten.

- the maximum number of threads spawned per voice system at a time. The threads perform FTP operation on a VAL board. By default, the value for this property will be 10.

- the FTP mode (ACTIVE or PASSIVE). The default is ACTIVE.

- the number of messages to be displayed in the Status pane. By default, 51 messages will be displayed in the Status pane.

- the editing software you want to use to view the activity log. The default editor is WordPad.

- the audio player/editor software you want Voice Announcement Manager to start when you select Launch Audio player/Editor from the File menu.

- the maximum number of minutes that you want Voice Announcement Manager to maintain its connection to the voice system.

- the maximum number of seconds that you want Voice Announcement Manager to maintain its connection to the voice system after the last communication to the voice system.

- the number of seconds that you want to elapse before Voice Announcement Manager logs into a voice system. This delay is the number of seconds that elapse from when you request information from the voice system to when Voice Announcement Manager logs into that voice system.

- whether you have to log into Voice Announcement Manager via a password. You can set Voice Announcement Manager to prompt you for a password every time you start Voice Announcement Manager. If you password protect Voice Announcement Manager, you must also specify an email address so Voice Announcement Manager can email you a copy of your password on request (for example, if you forget your password).

If you enter the wrong password five consecutive times, Voice Announcement Manager will close. If you are unable log into Voice Announcement Manager (that is, you cannot remember your password), you must delete the file "ValManager.dat" and then start Voice Announcement Manager. Your tasks, templates, and other settings are preserved, but all of the voice system information is removed. You must re-enter the voice system information.

Note:

If you want to password protect Voice Announcement Manager, you must first configure the outgoing mail server information for Voice Announcement Manager.

To configure the Voice Announcement Manager properties, complete the following steps:

1. From the File menu, select Edit Application Properties.
The Edit Application Properties dialog box appears.

2. In the Log Limit (in MB) box, enter the maximum file size for the activity log. The range is 1 to 5 MB.

3. In the FTP Thread Limit box, enter the maximum number of threads spawned per voice system at a time. The range is 1 to 25.

4. From the FTP Connect Mode box, select the FTP mode.

5. If you want detailed logs of FTP/SFTP activities, check the FTP Log option.

6. In the Status Pane Messages box, enter the maximum number of messages to be displayed in the Status pane. The range is 1 to 250.

7. From the Log Editor box, select the editing software that will be used to view the activity log.

8. From the Audio Player/Editor box, select the audio player/editor software you want Voice Announcement Manager to start when you select Launch Audio player/Editor from the File menu.

9. In the Login Duration box, enter the maximum number of minutes that you want Voice Announcement Manager to maintain its connection to the voice system.

10. In the Connection Timeout box, enter the maximum number of seconds that you want Voice Announcement Manager to maintain its connection to the voice system after the last communication to the voice system.

11. In the Login Delay box, enter the number of seconds that must elapse before Voice Announcement Manager logs into a voice system. This delay is the number of seconds that elapse from when you request information from the voice system to when Voice Announcement Manager logs into that voice system.

12. If you want to configure Voice Announcement Manager to prompt you for a password when you start Voice Announcement Manager, perform the following steps:
   - Click the Authentication Required check box.
   - In the Password box, enter the password you want to use to log into Voice Announcement Manager.
   - In the Re-enter Password box, enter the password you want to use to log into Voice Announcement Manager.
   - In the E-mail ID box, enter the email address to which you want Voice Announcement Manager to email your password. This setting is valuable if you forget your password.

12. Click **Save**.

**Note:**

*If you tried to configure a password for Voice Announcement Manager, but you did not configure the outgoing mail server information for Voice Announcement Manager previously, an error message appears. Perform the following steps:*

1. Click **OK** to close the error message box.

m. Uncheck the **Authentication Required** check box.

n. **Configure the outgoing mail server information for Voice Announcement Manager.**

o. Perform Steps 11 and 12 in this procedure to password protect Voice Announcement Manager.
Using the Online Help System

The online help system you are reading explains how to perform the most common Voice Announcement Manager and announcement-related tasks.

To Access the Online Help

- Choose Help>Contents to open the help system.

To Use the Online Help

- Choose Help> About to learn which version of Voice Announcement Manager you are using.
- Once the online help system is open:
  - Click the Contents tab to view a table of contents of help topics.
  - Click the Index tab and type a word to search for a help topic
  - Click the Search tab to search the entire online help system for a particular word or phrase.

Note:

The first time you click Search, a wizard takes you through the steps to create a database of all the words in the help system.
Exiting Voice Announcement Manager

To exit the application, choose **File>Exit**.

If you have changed information in the Announcement Properties table but forgot to save, Voice Announcement Manager will ask if you want to save your changes before exiting.
Creating and Converting Audio Files

VAL Audio File Format Requirements

In order to be compatible with the TN2501AP circuit pack and the voice system, announcement recordings must have the following parameters:

- CCITT A-Law or CCITT Mu-Law companding format (do not use PCM)
- 8KHz sample rate
- 8-bit resolution (bits per sample)
- Mono (channels = 1)

Announcements that are recorded in this format occupy 8K Bytes per second of file space. For example, a 10-second announcement creates an 80KB wave file.

Note:

*Mu-Law companding is used in the United States, while A-Law is used internationally. Ensure that you use the same companding format as the administered format on page 1 of the system-parameters country-options form.*
Recording Audio Files Professionally

You may want to have your announcement files professionally recorded. Many studios record audio at CD-quality level (44 kbps, 16 bits/sample). This sampling rate will not work with the VAL board. If you are recording new announcements professionally, be sure to inform the studio about the audio file format requirements.

If you already have recorded announcement files professionally at CD-level quality, do not convert the file to the VAL formats as the quality will not be satisfactory. You must re-record the announcement to meet the required VAL formats.
Recording Audio Files Using a Phone

Before you start

- Look up the feature access code (FAC) for recording announcements.
- At the SAT type `display feature-access-codes` and press ENTER.
- The Feature Access Codes screen displays.
- Find the Announcement Access Code field and note the code.

Instructions

To record the announcement named "Closed" to extension 1234 (or change the announcement already recorded there), you must use a phone with console permissions. In this example, the announcement feature access code is *05.

To record or change the announcement from a system phone:

1. Dial *05 from a phone or console.
   
   You hear dial tone.

2. Dial the announcement extension 1234.
   
   You hear dial tone indicating that your announcement session has started.
   
   or
   
   You hear a fast busy signal (reorder tone) indicating that:
   
   - another announcement session is in progress.
   - a save or restore command is in progress.

   If the telephone session port is in use, then the you will hear a reorder tone followed by silence. This indicates that the port is reserved for an announcement session. Redial the FAC and extension every 45 seconds to gain access to the port.

3. Dial 1 to begin recording.
   
   - If you hear a beep, begin speaking to record the announcement.
   - If you hear a stutter dial tone, this means that the circuit pack memory is more than 90% full or an existing announcement is playing. Even if you hear stutter dial tone, begin speaking to record the announcement. If the circuit pack memory becomes full during recording,
     - you hear a fast busy signal (reorder tone).
     - the system drops the announcement access session.
     - the system retains whatever was recorded.
     - If you hear intercept tone (French siren), then an existing message is administered as read-only (Protect field is y on the Announcement Properties window).

4. If you are using a digital phone, press # to end the recording. Do not hang up.
   
   Pressing # returns dial tone, after which you can:
   
   - play back the announcement (go to Step 5).
   - delete or re-record the announcement (see Step 7).

   If you are using an analog phone, hang up. If your analog phone is not connected through lineside DS1, the system records an electrical "click" at the end of the recording.
5. To listen to the announcement that you just recorded (using a digital phone), do not hang up. Press 2.
   The recording plays back through the handset.

6. If you are satisfied with the announcement, hang up.

7. If you are not satisfied with the announcement,
   - press 1 to re-record the announcement.
   - press 3 to delete the announcement and end the recording session.

8. If you want to listen to the announcement after you have hung up, dial the extension from any phone or console.
   In this example, dial 1234.
   The announcement plays through the handset.

Note:
You have to wait 15 seconds after you record the announcement before you can dial the extension to hear your announcement. During this 15-second window
   - you cannot record a new announcement.
   - no one can play this announcement.
   - you can re-record this announcement. Dial the feature access code, dial the extension, and press 2 before the 15-second timer expires.
Recording Audio Files Using Your Computer

To record an announcement at a computer:

1. At the computer open the application that you use to record .wav files.
2. Set the recording parameters.
3. Record the announcement by speaking into a microphone connected to the computer.
4. Play the announcement back at the computer before transferring the file to the VAL board.
Converting Audio Files

You may need to convert previously-recorded audio files for one of the following reasons:

- The current file is not in the correct format.
- You need to convert an audio file from an S8100 (DEFINITY ONE) format and DEFINITY ECS format or vice versa.

There are several ways you can convert audio files:

- Convert using a sound recording application.
- Convert using an S8100 (DEFINITY ONE) conversion utility.
Converting Audio Files Using a Sound Recording Application

To convert a previously-recorded (or an S8100 (DEFINITY ONE)-compatible) announcement file to Avaya Communication Manager-compatible formats:

1. Open the sound recording application on your computer (for example, Microsoft Windows Sound Recorder).
2. Open the file you want to convert.
3. Check the file properties to see if you need to change the parameters.
4. If you need to change the recording parameters, look for a conversion tool (some have a "Convert Now" option, others use "Save As").
5. Change the file parameters to meet the audio file requirements.

Note:

In some applications, assigning the format (for example, CCITT μ-Law) sets the remainder of the default parameters. Check each parameter carefully, perhaps changing default settings to match the parameters. CCITT μ-Law or A-Law may be referred to as ITU G.711 μ-Law or ITU G.711 A-Law, respectively.
Converting Audio Files Using S8100 (DEFINITY ONE) Conversion Utility

S8100 (DEFINITY ONE) has a recording conversion utility that supports file formats that are similar to those required by VAL. However, the conversion utility can only read PCM-format announcement files.

Converting to SSP

If you are converting an announcement file for use on S8100 (DEFINITY ONE) systems:

1. If the file’s companding format is already PCM, go to Step 5.
   
   If you are not sure what the file format is, proceed with Step 2.

2. At a computer, open the sound recording application (for example, Microsoft Windows Sound Recorder).

3. Open the file that you want to convert.

4. Save ("Convert Now" or "Save As") the announcement with these formats:
   
   - Format: PCM
   - Bits/Sample: 8
   - Sample Rate: 8KHz
   - Mono (channels = 1)

   **Note:**
   
   The S8100 (DEFINITY ONE) recording conversion utility requires that announcement files are in PCM format.

5. Open the file in S8100’s (DEFINITY ONE) recording conversion utility.

6. Convert the file to SSP format.

Converting from SSP to another audio file format

1. Open the SSP file in the S8100’s (DEFINITY ONE) recording conversion utility.

2. Convert the file from SSP to PCM.

3. At a computer, open the sound recording application (for example, Microsoft Windows Sound Recorder).

4. Open the file that you want to convert.

5. Save ("Convert Now" or "Save As") the announcement with the μ-Law or A-Law formats you want.
Working with Audio Groups and Folders

Creating an Audio Group Folder

To create an audio group folder, complete the following steps:

1. Right-click on Audio Sources or Audio Groups in the Voice Announcement Manager tree, and then choose Create New Folder from the popup menu.

   The new folder appears in the Voice Announcement Manager tree. It is labeled "New Folder."

2. To change the name of this folder, right-click on this folder, and then choose Rename from the popup menu.

   The cursor appears at the end of the folder name. You can now change the name of this folder.

3. Enter the name for this folder.

4. When finished, click the mouse outside the name for this folder.
Renaming an Audio Group Folder

To rename an audio group folder, complete the following steps:

1. Right-click on the audio group folder you want to rename in the Voice Announcement Manager tree, and then choose **Rename** from the popup menu.

   The cursor appears at the end of the folder name. You can now change the name of this folder.

2. Enter the name for this folder.

3. When finished, click the mouse outside the name for this folder.
Deleting an Audio Group Folder

Note:

You can only delete an audio group folder that is empty.

To delete an existing audio group folder, complete the following steps:

1. Right-click on the audio group folder you want to delete from the Voice Announcement Manager tree, and then choose Delete from the popup menu.

   A warning dialog box appears.

2. Click Yes to delete the folder.
Creating an Audio Group

To create an audio group, complete the following steps:

1. Perform one of the following steps:
   - Right-click on an audio group (if any) in the Voice Announcement Manager tree, and then choose **Create/Edit Group** from the popup menu.
   - Select an audio group (if any) in the Voice Announcement Manager tree, and then choose **Create/Edit Group** from the **Actions** menu.

   The Create/Edit Group dialog box appears.

2. Click the **Create New Group** option button.

3. From the Group No. box, select the number for this group.

4. In the Group Name box, enter the name for this group.

5. In the Available Announcement Sources box, select the announcement sources you want to add to this group, and click the > button. If you want to add all of the announcement sources, click the >> button.

   The announcement sources you selected appear in the Group Members box.

   If you make a mistake, highlight the mistake in the Group Members box and click the < button, or click **Cancel** to start over.

6. Click **OK**.

   After the group is created, the Create Group Task dialog box appears.
Modifying an Audio Group

To modify an existing audio group, complete the following steps:

1. Perform one of the following steps:
   - Right-click on an audio group (if any) in the Voice Announcement Manager tree, and then choose **Create/Edit Group** from the popup menu.
   - Select an audio group (if any) in the Voice Announcement Manager tree, and then choose **Create/Edit Group** from the **Actions** menu.

   The Create/Edit Group dialog box appears.

2. Click the **Edit Group** option button.

3. From the Group No. box, select the number of the group you want to modify.

   The information for the selected group appears.

4. Make your changes.

5. When finished, click **OK**.

   After the group is modified, the Edit Group Task dialog box appears.
Deleting an Audio Group

To delete an existing audio group, complete the following steps:

1. Perform one of the following steps:
   - Right-click on an audio group (if any) in the Voice Announcement Manager tree, and then choose Create/Edit Group from the popup menu.
   - Select an audio group (if any) in the Voice Announcement Manager tree, and then choose Create/Edit Group from the Actions menu.

   The Create/Edit Group dialog box appears.

2. Click the Edit Group option button.

3. From the Group No. box, select the number of the group you want to delete.

   The information for the selected group appears.

4. Click Delete.

   A warning dialog box appears.

5. Click Yes to delete the group.

   After the group is deleted, the Delete Group Task dialog box appears.
Moving Audio Groups into Different Folders

Use this procedure to move an audio group to a different audio group folder. By default, all audio groups are located in the Default Folder.

To move an audio group into a different folder, complete the following steps:

1. Click and hold down the mouse on the audio group you want to move into a different folder in the Voice Announcement Manager tree.

2. Drag the mouse onto the destination audio group folder, and release the mouse.

   The selected audio group appears in the destination folder.
Searching

Searching for Audio Files

Voice Announcement Manager lets you search for audio files on your voice system. During this search, Voice Announcement Manager will "search" the names of the audio files on the voice system you specify. You can specify to search all of your voice systems.

To search for an audio file, complete the following steps:

1. Perform one of the following steps:
   - Right-click Voice Systems in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the popup menu.
   - Select Voice Systems in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the System menu.
   - Right-click the voice system you want to search in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the popup menu.
   - Select the voice system you want to search in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the System menu.

   Voice Announcement Manager displays the Search Task dialog box.

2. From the Voice System box, select the voice system you want to search. If you want to search all of the voice systems, select All Voice Systems.

3. From the Announcement box, select File.

4. From the box, specify how you want to perform the search. Choices are equals, contains, starts with, and ends with.

5. In the Value box, enter the information you want to find.

6. Click Search.

   Voice Announcement Manager displays a status box that shows the status of the search.

   When the search is completed, the Search Results dialog box appears.

7. Click OK.

   The audio files that match your search criteria are displayed.
Searching for Announcement Property Files

Voice Announcement Manager lets you search for announcement property files on your voice system. You can specify up to two of the following search criteria:

- Name
- Extension
- Type
- COR
- TN
- Queue
- Protected
- Board/Ann. Group
- Length
- On Board

You can specify to search all of your voice systems.

To search for an announcement property file, complete the following steps:

1. Perform one of the following steps:
   - Right-click Voice Systems in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the popup menu.
   - Select Voice Systems in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the System menu.
   - Right-click the voice system you want to search in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the popup menu.
   - Select the voice system you want to search in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the System menu.

   Voice Announcement Manager displays the Search Task dialog box.

2. From the Voice System box, select the voice system you want to search. If you want to search all of the voice systems, select All Voice Systems.

3. From the Announcement box, select Property.

4. From the Property Name box, select the first search criterion you want to use.

5. From the next box, specify how you want to perform the search. Choices are equals, contains, starts with, and ends with.

6. In the Value box, enter the information you want to find.

7. If you want to use a second search criterion, perform the following steps:
   - From the next box, select whether the second search criterion is required. Select either AND or OR. If you select NONE, the second search criterion will not be used.
   - From the next Property Name box, select the second search criterion you want to use.
   - From the next box, specify how you want to perform the search. Choices are equals, contains, starts with, and ends with.
   - From the next Value box, enter the information you want to find.

8. Click Search.
Using Voice Announcement Manager

Voice Announcement Manager displays a status box that shows the status of the search. When the search is completed, the Search Results dialog box appears.

9. Click **OK**.

The announcement property files that match your search criteria are displayed.
Searching for VAL Sources in an Audio Group

Voice Announcement Manager lets you search for a VAL source within audio groups in a voice system.

To find a VAL source, complete the following steps:

1. Perform one of the following steps:
   - Right-click the voice system in the Voice Announcement Manager tree, and then choose **Search/Replace VAL Sources in Group** from the popup menu.
   - Select the voice system in the Voice Announcement Manager tree, and then choose **Search/Replace VAL Sources in Group** from the **Actions** menu.

2. Click the **Find** option button.

3. In the Available VAL Sources box, select the VAL source you want to find and click the **>** button.
   
   The VAL source you selected appears in the VAL Sources to be searched box.

4. Click **OK**.
   
   The Search Results for groups dialog box appears and displays the number and name of the group that contains this VAL source.
Replacing VAL Sources in an Audio Group

Voice Announcement Manager lets you find and replace a VAL source within audio groups in a voice system.

To find and replace a VAL source, complete the following steps:

1. Perform one of the following steps:
   - Right-click the voice system in the Voice Announcement Manager tree, and then choose Search/Replace VAL Sources in Group from the popup menu.
   - Select the voice system in the Voice Announcement Manager tree, and then choose Search/Replace VAL Sources in Group from the Actions menu.

2. Click the Find and Replace option button.

3. In the Available VAL Sources box, select the VAL source you want to find and replace, and click the > button.
   
   The VAL source you selected appears in the VAL Sources to be searched box.

4. Click Next.

5. In the Available VAL Sources box, select the VAL source you want to use as the replacement, and click the > button.

   The VAL source you selected appears in the VAL Sources to be replaced box.

6. Click Finish.

   The Search and Replace VAL Sources Success dialog box appears.

7. Click Close.
Scheduling

Creating a Task

The procedure describes how to create a task that you can schedule to run at a specified date, time, and frequency. For example, you can create a task that will back up the announcement files from different VAL/virtual VAL boards on a voice system on regular basis.

You can create tasks to perform the following actions:

- back up selected VAL boards
- back up all voice systems
- broadcast announcements
- import voice announcement properties from a comma-separated values (CSV) file and send that data to a voice system
- export voice announcement properties from a voice system to a comma-separated values (CSV) file

To create a task, complete the following steps:

1. From the Actions menu, choose Scheduler.
   The Task Editor dialog box appears.

2. Click Add.
   The Create Task dialog box appears.

3. Complete the Create Task dialog box, and click OK.
   For help completing these fields, click the Help button on this dialog box.
Modifying a Task

To modify a task, complete the following steps:

1. From the Actions menu, choose Scheduler.
   The Task Editor dialog box appears.
2. Select the task you want to modify, and then click Modify.
3. Make your changes to the task.
   For help completing these fields, click the Help button on this dialog box.
Deleting a Task

To delete a task, complete the following steps:

1. From the **Actions** menu, choose **Scheduler**.
   The Task Editor dialog box appears.

2. Select the task you want to delete, and then click **Delete**.
   For help, click the **Help** button on this dialog box.
Stopping a Scheduled Task
To stop a scheduled task from being performed, complete the following steps:

1. From the Actions menu, choose Scheduler.
   The Task Editor dialog box appears.
2. Select the task you want to stop, and then click Abort.
   For help, click the Help button on this dialog box.
Deleting Completed Tasks

To delete all of the completed tasks (that is, tasks that completed successfully and tasks that completed with errors), complete the following steps:

1. From the Actions menu, choose Scheduler.
   
   The Task Editor dialog box appears.

2. Click Clear.

   All of the completed tasks are deleted.
Using Templates

Creating a Template

This procedure describes how to create a new template that will perform one of the following actions:

- back up selected VAL boards
- back up all voice systems
- broadcast announcements
- import voice announcement properties from a comma-separated values (CSV) file and send that data to a voice system
- export voice announcement properties from a voice system to a comma-separated values (CSV) file

Once you create a template, you can modify it and easily create tasks that you can schedule.

When creating a template, you can specify that you do not want this template to be scheduled by selecting the **Template only: Do not schedule** check box in the Create Template dialog box.

To create a template, complete the following steps:

1. From the **Actions** menu, choose **Template Editor**.
   The Template Editor dialog box appears.
2. Click **Add**.
   The Create Template dialog box appears.
3. Complete the Create Template dialog box.
   If you do not want this template to be scheduled, click the **Template only: Do not schedule** check box.
   For help completing the fields in this dialog box, click the **Help** button on this dialog box.
4. When finished, click **Next**.
Modifying a Template

To modify a template, complete the following steps:

1. From the **Actions** menu, choose **Template Editor**.
   The Template Editor dialog box appears.

2. Select the template you want to modify, and then click **Edit**.

3. Make your changes to the template.
   If you do not want this template to be scheduled, click the **Template only: Do not schedule** check box.
   For help completing these fields, click the **Help** button on this dialog box.

4. When finished, click **Next**.
Deleting a Template

To delete a template, complete the following steps:

1. From the **Actions** menu, choose **Template Editor**.
   The Template Editor dialog box appears.

2. Select the template you want to delete, and then click **Delete**.
   For help, click the **Help** button on this dialog box.

   OR

   i. In the Task Editor, click the **Add** button.
      The Create Task dialog box appears, displaying a list of templates.

   j. Select the templates you want to delete, and then click **Delete**.
      For help, click the **Help** button on this dialog box.
Screen Reference

Voice Announcement Manager Toolbar

The Toolbar lets you perform common activities with the click of a button.

<table>
<thead>
<tr>
<th>Button</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Register Button]</td>
<td>Click this button to register a new voice system with Voice Announcement Manager.</td>
</tr>
<tr>
<td>![Add Announcement Button]</td>
<td>Click this button to add a new announcement to the VAL board that you select in the Voice Announcement Manager tree.</td>
</tr>
<tr>
<td>![Make Changes Button]</td>
<td>Click this button to make changes to the properties of the selected announcement in the Voice Announcement Manager window.</td>
</tr>
<tr>
<td>![Move Properties Button]</td>
<td>Click this button to move the properties of the selected announcement in the Voice Announcement Manager window.</td>
</tr>
<tr>
<td>![Rename Button]</td>
<td>Click this button to rename the selected announcement property in the Voice Announcement Manager window.</td>
</tr>
<tr>
<td>![Delete Property Button]</td>
<td>Click this button to delete the selected announcement property in the Voice Announcement Manager window.</td>
</tr>
<tr>
<td>![Save Changes Button]</td>
<td>After you make changes to the properties of any announcement associated with a VAL board, click this button to save your changes.</td>
</tr>
<tr>
<td>![Refresh Screen Button]</td>
<td>Click this button to refresh the screen and display any updates to the data on screen.</td>
</tr>
<tr>
<td>![Print Announcement Properties Button]</td>
<td>Click this button to print the announcement properties.</td>
</tr>
<tr>
<td>![View Printing Button]</td>
<td>Click this button to view how the announcement properties will be printed.</td>
</tr>
<tr>
<td>![Tasks Button]</td>
<td>Click this button to create, modify, delete, and manage tasks that you can schedule to be performed at specific times and intervals.</td>
</tr>
<tr>
<td>**</td>
<td>**</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>![Button]</td>
<td>Click this button to create, modify, and delete templates.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Click this button to broadcast announcement files on to various VAL boards on different voice systems.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Click this button to view the Voice Announcement Manager log file.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Click this button to view the release number of the Voice Announcement Manager software you are using.</td>
</tr>
</tbody>
</table>
### Menus

<table>
<thead>
<tr>
<th>File Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>File&gt;Save Announcement Properties</td>
<td>This option saves changed data in the announcement table to the Voice Announcement Manager computer and to the selected voice system.</td>
</tr>
<tr>
<td>File&gt;Print Announcement Properties</td>
<td>This option prints the announcement properties.</td>
</tr>
<tr>
<td>File&gt;Print Preview Announcement Properties</td>
<td>This option enables you to see the format in which the announcement properties will be printed.</td>
</tr>
<tr>
<td>File&gt;Edit Application Properties</td>
<td>This option enables you to configure the following settings in the Voice Announcement Manager properties file:</td>
</tr>
<tr>
<td></td>
<td>• the maximum size for the activity log.</td>
</tr>
<tr>
<td></td>
<td>• the maximum number of threads spawned per voice system at a time.</td>
</tr>
<tr>
<td></td>
<td>• the FTP mode (ACTIVE or PASSIVE).</td>
</tr>
<tr>
<td></td>
<td>• the FTP log option (check to show detailed logs of FTP/SFTP operations)</td>
</tr>
<tr>
<td></td>
<td>• the number of messages to be displayed in the Status pane.</td>
</tr>
<tr>
<td></td>
<td>• the editing software you want to use to view the activity log.</td>
</tr>
<tr>
<td></td>
<td>• the audio player/editor software you want Announcement Manager to start when you select</td>
</tr>
<tr>
<td></td>
<td><strong>Launch Audio player/Editor</strong> from the File menu.</td>
</tr>
<tr>
<td></td>
<td>• the maximum number of minutes that you want Voice Announcement Manager to maintain its connection to the voice system.</td>
</tr>
<tr>
<td></td>
<td>• the timeout interval for which you want Voice Announcement Manager to try connecting to the voice system.</td>
</tr>
<tr>
<td></td>
<td>• whether you have to log into Voice Announcement Manager via a password. You can set Voice Announcement Manager to prompt you for a password every time you start Voice Announcement Manager. If you password protect Voice Announcement Manager, you must also specify an email address so Voice Announcement Manager can email you a copy of your password on request (for example, if you forget your password).</td>
</tr>
<tr>
<td></td>
<td>If you enter the wrong password five consecutive times, Voice Announcement Manager will close. If you are unable log into Voice Announcement Manager</td>
</tr>
</tbody>
</table>
(that is, you cannot remember your password), you must delete the file "ValManager.dat" and then start Voice Announcement Manager. Your tasks, templates, and other settings are preserved, but all of the voice system information is removed. You must re-enter the voice system information.

**Note:**

If you want to password protect Voice Announcement Manager, you must first configure the outgoing mail server information for Voice Announcement Manager.

<table>
<thead>
<tr>
<th>File&gt;Edit SCP Server Configuration</th>
<th>This option enables you to configure the settings to use SCP for secure file transfer.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>SCP is only supported for G450, G350, G250, G250-DCP, G250-DS1, J2320, J2340, J4350, J4360, and Samsung AMRB media gateways.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File&gt;Launch Audio player/Editor</th>
<th>This option opens the audio player/editor application you specified in the Edit Application Properties dialog box.</th>
</tr>
</thead>
<tbody>
<tr>
<td>File&gt;Exit</td>
<td>This option closes the application. Voice Announcement Manager displays a warning if you have changed any data in the announcement table but forgotten to save it.</td>
</tr>
</tbody>
</table>

**View Menu**

**Description**

<table>
<thead>
<tr>
<th>View&gt;Refresh Announcement Properties</th>
<th>This option makes Voice Announcement Manager contact the voice system, update the announcement table with any changes, and re-display the table.</th>
</tr>
</thead>
<tbody>
<tr>
<td>View&gt;Edit Properties</td>
<td>Select this option to view the VAL Board Properties dialog box for the VAL board that you selected in the Voice Announcement Manager tree.</td>
</tr>
<tr>
<td>View&gt;View Logs</td>
<td>Select this option to view the Voice Announcement Manager activity log.</td>
</tr>
</tbody>
</table>

| View>View Audio Files Properties    | In the Voice Announcement Manager tree, select the specific VAL board associated with the announcement properties you want to view, and then select this option. When you do, Voice Announcement Manager will display these announcement... |
| **View>View Announcement Properties** | In the Voice Announcement Manager tree, select the specific VAL board, and then select this option. The Voice Announcement Manager presents the Announcement Properties window, which you can use to create new announcements, modify existing announcements, delete announcements, or transfer announcement files corresponding to the announcements. |
| **View>View Virtual VAL Boards Status** | In the Voice Announcement Manager tree, select the voice system, and then select this option. Voice Announcement Manager presents a dialog box that displays the status each virtual VAL board on the selected voice system. From this dialog box, you can change the status of the VAL boards. |
| **View>View Voice System Tree** | This option lets you display or hide the left pane (the Tree) of the main window. |
| **View>View Status Pane** | This option lets you display or hide the bottom pane (the Status pane) of the main window. |

| **Edit Menu** | **Description** |
| Edit>New Announcement Property | Select this option to add a new announcement to the selected voice system. |
| Edit>Edit Announcement Property | Select this option to modify the properties of the selected announcement in the Voice Announcement Manager window. |
| Edit>Move Announcement Property | Select this option to move the properties of the selected announcement in the Voice Announcement Manager window. |
| Edit>Rename Announcement Property | Select this option to rename the selected announcement property in the Voice Announcement Manager window. |
| Edit>Delete Announcement Property | Select this option to delete the selected announcement in the Voice Announcement Manager window. |

| **System Menu** | **Description** |
| System:Register Voice System | Select this option to add a new voice system to Voice Announcement Manager. |
| System>Delete Voice | In the Voice Announcement Manager tree, select the voice system you want to remove, and then select this option. |
### System
Deleting a voice system using this option does not affect the voice system.

### System>Get VAL Board Information
In the Voice Announcement Manager tree, select a VAL board, and select this option. The Edit VAL Board Properties dialog box appears, displaying the properties for the selected board.

### System>Connect At Startup Configuration
Select this option if you want to specify which voice systems Voice Announcement Manager should connect to upon startup.

### System>Email Configuration
Select this option to configure the default email addresses to which Voice Announcement Manager will send email when scheduled tasks are performed.

### System>Search Announcement Property/File
Select this option to search for announcement properties and audio files on a voice system. You can specify to search all of your voice systems.

### System>Import Announcement Properties
Select this option to import voice announcement properties from a comma-separated values (CSV) file.

### System>Export Announcement Properties
Select this option to export voice announcement properties to a comma-separated values (CSV) file.

### System>Sort Voice Systems By Name
Select this option to display the voice systems in alphabetical order.

<table>
<thead>
<tr>
<th>Actions Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions&gt;Back Up</td>
<td>In the Voice Announcement Manager tree, select the voice system that contains the announcement properties and audio files you want to copy to the Voice Announcement Manager computer, and then select this menu option.</td>
</tr>
<tr>
<td>Actions&gt;Back Up All Voice Systems</td>
<td>This option lets you copy announcement properties from all of the voice systems to Voice Announcement Manager’s “persistent storage” and lets you copy audio files from all of the VAL boards (that you have registered with Voice Announcement Manager) to the directories that you associated with these VAL boards.</td>
</tr>
<tr>
<td>Actions&gt;Restore</td>
<td>In the Voice Announcement Manager window, select the voice system to which you want to copy the announcements from the Voice Announcement Manager computer, and then select this menu option.</td>
</tr>
<tr>
<td>Actions&gt; Restore All</td>
<td>This option copies all announcement properties from the</td>
</tr>
<tr>
<td>Voice Systems</td>
<td>Voice Announcement Manager's &quot;persistent storage&quot; to the appropriate Communication Manager forms, and copies all audio files from the Voice Announcement Manager computer to the appropriate VAL boards.</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Actions&gt;Copy/Delete Audio Files</td>
<td>In the Voice Announcement Manager window, select the VAL board to which you want to copy audio files from the Voice Announcement Manager computer or vice versa, and then select this menu option. Using this menu option, you can also delete audio files.</td>
</tr>
<tr>
<td>Actions&gt;Move Audio Files</td>
<td>In the Voice Announcement Manager tree, select the VAL board that contains announcement files you want to move, and then select this option. Voice Announcement Manager presents the Move Announcement Files - Select Files To Move dialog box.</td>
</tr>
<tr>
<td>Actions&gt;View/Rename Audio Files</td>
<td>In the Voice Announcement Manager tree, select the VAL board that contains announcement files you want to move, and then select this option. Voice Announcement Manager presents the Move Announcement Files - Select Files To Move dialog box.</td>
</tr>
<tr>
<td>Actions&gt;Enable Virtual VAL Board</td>
<td>In the Voice Announcement Manager tree, select the virtual VAL board you want to enable, and then select this option.</td>
</tr>
<tr>
<td>Actions&gt;Disable Virtual VAL Board</td>
<td>In the Voice Announcement Manager tree, select the virtual VAL board you want to disable, and then select this option</td>
</tr>
<tr>
<td>Actions&gt;Create/Edit Group</td>
<td>Using this menu option, you can create a new audio group or modify an existing audio group for the selected voice system.</td>
</tr>
<tr>
<td>Actions&gt;Search/Replace VAL Sources in Group</td>
<td>Using this menu option, you can find VAL sources in an audio group in a voice system and replace VAL sources in an audio group in a voice system.</td>
</tr>
<tr>
<td>Actions&gt;Move Announcement Properties</td>
<td>This option enables you to move the announcement/administration/properties (and the associated announcement file) from one VAL board to another on the same voice system. In the Voice Announcement Manager tree, select the specific VAL board, and then select this option.</td>
</tr>
<tr>
<td>Actions&gt;Broadcast</td>
<td>Using this menu option, you can broadcast announcement files onto various VAL boards on different voice systems.</td>
</tr>
<tr>
<td>Actions&gt;Scheduler</td>
<td>Using this menu option, you can create, modify, delete, and manage tasks that you can schedule to be performed at specific times and intervals.</td>
</tr>
</tbody>
</table>
### Actions>Template Editor
Using this menu option, you can create, modify, and delete templates.

### Window Menu

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window&gt;Cascade</td>
</tr>
<tr>
<td>Overlaps the Announcement Properties windows and displays the title bar of each window.</td>
</tr>
<tr>
<td>Window&gt;Tile Horizontally</td>
</tr>
<tr>
<td>Displays each Announcement Properties window from left to right.</td>
</tr>
<tr>
<td>Window&gt;Tile Vertically</td>
</tr>
<tr>
<td>Displays each Announcement Properties window from top to bottom.</td>
</tr>
<tr>
<td>Window&gt;Close All</td>
</tr>
<tr>
<td>Closes all of the Announcement Properties windows.</td>
</tr>
<tr>
<td>Window&gt;Open Announcement Properties</td>
</tr>
<tr>
<td>Displays the title of each Announcement Properties window that is currently open. A check mark indicates that the corresponding window has focus. Select the title of the window you want to view.</td>
</tr>
</tbody>
</table>

### Help Menu

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help&gt;Contents</td>
</tr>
<tr>
<td>Select this option to view the Voice Announcement Manager online help system.</td>
</tr>
<tr>
<td>Help&gt;About</td>
</tr>
<tr>
<td>Select this option to view the version number and other pertinent data about this release of Voice Announcement Manager.</td>
</tr>
</tbody>
</table>
Voice Announcement Manager Tree

This area of the main Voice Announcement Manager window lets you see:

- the voice systems you have added to Voice Announcement Manager
- the audio sources (VAL boards) on those voice systems
- the audio groups on those voice systems
- the audio group folders that you created on those voice systems

What can I do with this tree?

- Change voice system information
- Delete a voice system from Voice Announcement Manager
- Create an audio group
- Modify an audio group
- Delete an audio group
- Back up announcement properties and audio files
- Restore announcement properties and audio files
- Search for audio files
- Search for announcement property files
- View or change the status of a virtual VAL board
- Import announcement properties
- Export announcement properties
# Keyboard Shortcuts

While using Voice Announcement Manager, keep in mind the following keyboard shortcuts.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt-R</td>
<td>Refresh Announcement Properties</td>
</tr>
<tr>
<td>Ctrl-P</td>
<td>Print Announcement Properties</td>
</tr>
<tr>
<td>Ctrl-T</td>
<td>Print Preview Announcement Properties</td>
</tr>
<tr>
<td>Ctrl-S</td>
<td>Save Announcement Properties</td>
</tr>
<tr>
<td>Ctrl-N</td>
<td>New Announcement Property</td>
</tr>
<tr>
<td>Ctrl-I</td>
<td>Edit Announcement Property</td>
</tr>
<tr>
<td>Ctrl-M</td>
<td>Move Announcement Property</td>
</tr>
<tr>
<td>Ctrl-R</td>
<td>Rename Announcement Property</td>
</tr>
<tr>
<td>Ctrl-D</td>
<td>Delete Announcement Property</td>
</tr>
<tr>
<td>Ctrl-E</td>
<td>Exit</td>
</tr>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>Shift-R</td>
<td>Register Voice System</td>
</tr>
<tr>
<td>Shift-C</td>
<td>Connect At Startup Configuration</td>
</tr>
<tr>
<td>Shift-E</td>
<td>Email Configuration</td>
</tr>
<tr>
<td>Shift-S</td>
<td>Search Announcement Property/ File</td>
</tr>
<tr>
<td>Shift-I</td>
<td>Import Announcement Properties</td>
</tr>
<tr>
<td>Shift-X</td>
<td>Export Announcement Properties</td>
</tr>
<tr>
<td>Shift-O</td>
<td>Sort Voice System by Name</td>
</tr>
</tbody>
</table>
**Announcement Properties Window**

This window displays the values from the following Communication Manager fields for each announcement on the selected VAL board/virtual VAL board. You can also view these fields by accessing the selected voice system with your favorite system administration tool and entering `change announcements` at the command line to display the Announcements/Audio Sources screen.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>27-character alpha-numeric filename for the audio file (no ., /, :, *, ?, &lt;, &gt;, , or blanks).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> In Voice Announcement Manager, the &quot;.wav&quot; file extension, which is part of the filename stored on the circuit pack, does appear. You must enter &quot;.wav&quot; as part of the filename.</td>
</tr>
<tr>
<td>Repeat</td>
<td>A yes/no field that indicates whether the announcement is repeating.</td>
</tr>
<tr>
<td>Music</td>
<td>A yes/no field that indicates whether the announcement property is for music.</td>
</tr>
<tr>
<td>Ext</td>
<td>Valid extension number for the announcement.</td>
</tr>
<tr>
<td>COR</td>
<td>The class of restriction (COR) associated with this announcement. (0-95)</td>
</tr>
<tr>
<td>Protect</td>
<td>Default is n, meaning that the announcement file read-write. Use this value when you initially administer the announcement. After an announcement file resides on the circuit pack (recorded or FTP transfer), you can set this field to y to protect the file (read-only).</td>
</tr>
</tbody>
</table>
| Queue| Announcement queuing/charge-in  
  n (default), means that the announcement does not play if a port is not available.  
  y means that the request queues when all ports on the circuit pack are busy. The announcement plays when a port becomes available. This setting is recommended for most call center applications.  
  b means that you can connect callers to the announcement at any time while it is playing. With n or y, the caller is always connected to the beginning of the announcement. |
| TN    | The Tenant Number (if any). (0-20) |
Rate
If the VAL board is administered on the circuit packs form, then 64 (64Kbps) automatically displays in the Rate field.

Size
The size of the audio file in kilobytes.

Timestamp
The date and time the audio file was created or modified. This changes each time the audio file is put on the VAL board using FTP.

On Board
This yes/no field indicates whether the announcement’s audio file exists on the VAL board.

Length
The length in seconds of the announcement.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Saves the announcement properties and closes the Announcement Properties window.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Announcement Properties window without saving any changes.</td>
</tr>
<tr>
<td>Browse</td>
<td>Opens the Browse Extension dialog box so that an available extension can be selected.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays this help topic.</td>
</tr>
</tbody>
</table>

What do you want to do?
- Change Announcement Properties
- Change VAL Board Properties
- Change voice system information in Voice Announcement Manager
- What I want to do isn't listed here
## Announcement Property Dialog Box

This dialog box displays (for the announcement that you selected) the values from the following Communication Manager fields. You can also view these fields by accessing the selected voice system with your favorite system administration tool and entering `change announcements` at the command line to display the Announcements/Audio Sources screen.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Audio Filename</strong></td>
<td>27-character alpha-numeric filename for the audio file (no <code>\</code>, <code>/</code>, <code>:</code>, <code>*</code>, <code>?</code>, <code>&lt;</code>, <code>&gt;</code>, <code>\</code>, or blanks).</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>In Voice Announcement Manager, the &quot;.wav&quot; file extension, which is part of the filename stored on the circuit pack, does not appear. You must enter &quot;.wav&quot; as part of the filename.</td>
</tr>
<tr>
<td><strong>Repeating</strong></td>
<td>A yes/no field that indicates whether the announcement is repeating.</td>
</tr>
<tr>
<td><strong>Extension</strong></td>
<td>Valid extension number for the announcement. Extension numbers may not include punctuation.</td>
</tr>
<tr>
<td><strong>Location</strong></td>
<td>The location of the VAL board (TN2501AP)/virtual VAL board, in the format UUCSS.</td>
</tr>
<tr>
<td></td>
<td>- UU = cabinet (1-44)</td>
</tr>
<tr>
<td></td>
<td>- C = carrier (A-E)</td>
</tr>
<tr>
<td></td>
<td>- SS = slot (0-20)</td>
</tr>
<tr>
<td></td>
<td>For example, a circuit pack number might be 01A01.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The Port field is the cabinet-carrier-slot location of the TN2501AP circuit pack (UUCSS), and is not extended to the port level.</td>
</tr>
<tr>
<td><strong>COR</strong></td>
<td>The class of restriction (COR) associated with this announcement. (0-95)</td>
</tr>
<tr>
<td><strong>TN</strong></td>
<td>The Tenant Number (if any). (0-20)</td>
</tr>
<tr>
<td><strong>Queue</strong></td>
<td>Announcement queuing/barge-in n (default), means that the announcement does not play if a port is not available.</td>
</tr>
<tr>
<td></td>
<td>y means that the request queues when all ports on the circuit pack are busy. The announcement plays when a port becomes available. This setting is recommended for most call center applications.</td>
</tr>
<tr>
<td></td>
<td>b means that you can connect callers to the announcement at any time. (Recommended for emergency announcements)</td>
</tr>
</tbody>
</table>
time while it is playing. With n or y, the caller is always connected to the beginning of the announcement.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protected</td>
<td>Default is n, meaning that the announcement file read-write. Use this value when you initially administer the announcement. After an announcement file resides on the circuit pack (recorded or FTP transfer), you can set this field to y to protect the file (read-only).</td>
</tr>
<tr>
<td>Music</td>
<td>This yes/no field indicates whether the announcement property is for music.</td>
</tr>
<tr>
<td>Rate</td>
<td>If the VAL board is administered on the circuit packs form, then 64 (64Kbps) automatically displays in the Rate field.</td>
</tr>
<tr>
<td>Length</td>
<td>The length in seconds of the announcement.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the audio file in kilobytes.</td>
</tr>
<tr>
<td>Timestamp</td>
<td>The date and time the audio file was created or modified. This changes each time the audio file is put on the VAL board using FTP.</td>
</tr>
<tr>
<td>On Board</td>
<td>This yes/no field indicates whether the announcement’s audio file exists on the VAL board.</td>
</tr>
</tbody>
</table>

**What do you want to do?**

- [Change Announcement Properties](#)
- [Change VAL Board Properties](#)
- [Change voice system information in Voice Announcement Manager](#)
- [What I want to do isn't listed here](#)
Back Up Audio Files and Announcements Properties Dialog Box

This dialog box lets you back up your announcements files from VAL/virtual VAL boards you select to a location on your Voice Announcement Manager computer.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

- Right-click a VAL board in the Voice Announcement Manager tree, and then choose Backup from the popup menu.
- Select a VAL board in the Voice Announcement Manager tree, and then choose Backup from the Actions menu.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. At the top of the Files to Back Up box, be sure the location where you want to back files up to is displayed.
   
   If it is not, click Change Folder and select the location where you want the files to go.

2. At the top of the File on VAL Board box, be sure the correct voice system and VAL/virtual VAL board is displayed (Voice system: VAL/virtual VAL board).
   
   If it is not, click Cancel and start over, being sure to select the correct VAL board first.

3. In the File on VAL Board box, highlight the announcements that you want to back up and click the < button.
   
   The prefix "AF" indicates that both the announcement property and the .wav file are present for that announcement. Prefix "F" indicates that only .wav file is present and prefix "A" indicates that only announcement property file is present.
   
   If you make a mistake, highlight the mistake in the Files to Back Up box and click the > button, or click Cancel to start over.

4. Repeat Step 3 until you have specified all of the announcements on this board that you want to back up to the specified location on the Voice Announcement Manager computer.

5. Click one of the following:
   - OK to execute the backup and close the dialog box
   - Apply to execute the backup and leave the dialog box open.
   - Cancel to abort the backup and close the dialog box.
   - Help for assistance understanding this dialog box.

What do you want to do?

- Restore files
- What I want to do isn't listed here
Back Up Selected VAL Boards and Groups Dialog Box

This dialog box lets you back up your announcements from the VAL/virtual VAL boards and groups you select to a location you select on your Voice Announcement Manager computer.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

- Right-click a voice system in the Voice Announcement Manager tree, and then choose Back Up from the popup menu.
- Select a voice system in the Voice Announcement Manager tree, and then choose Back Up from the Actions menu.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. At the top of the Administered VAL Boards box, be sure the correct voice system is displayed.
   - If it is not, click Cancel and start over, being sure to select the correct voice system first.
2. In the Administered VAL Boards box, highlight the VAL/virtual VAL boards that you want to back up and click the > button. If you want to back up all of the boards, either click the >> button or select the voice system and click the > button.
   - The files you select appear in the Selected VAL Boards to Back Up box.
   - If you make a mistake, highlight the mistake in the Selected VAL Boards to Back Up box and click the < button, or click Cancel to start over.
3. Repeat Step 2 until you have specified all of the boards that you want to back up to the specified location on the Voice Announcement Manager computer.
4. If you use the same file in multiple VAL sources, select the Use file from first available source for all sources check box. Voice Announcement Manager will copy the file from the first member in the group that has the file to each member. This option reduces the time to back up files to all members.
5. Click one of the following:
   - OK to execute the backup and close the dialog box
   - Apply to execute the backup and leave the dialog box open.
   - Cancel to abort the backup and close the dialog box.
   - Help for assistance understanding this dialog box.

What do you want to do?

- Restore files
- What I want to do isn’t listed here
Broadcast Announcement Files - Select Files by Extension Dialog Box

This dialog box lets you select the extensions that you want to use to broadcast announcement files to a group of VAL sources.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by performing either of the following steps:

To perform a broadcast now:

1. Choose Broadcast from the Actions menu.
   The Broadcast Announcement Files - Select Files dialog box appears.
2. Click Broadcast by Ext.

To schedule a broadcast:

1. From the Actions menu, choose Scheduler.
   The Task Editor dialog box appears.
2. Click Add.
   The Create Task dialog box appears.
3. Click the Create New Task option button, and click OK.
   The Create New Task dialog box appears.
4. Enter the appropriate information, click the Broadcast option button, and then click Next.
5. Click Broadcast by Ext.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. From the Voice System box, select the voice system that contains the extensions you want to broadcast.
2. In the Extension box, enter the extension you want to broadcast, and click Add.
   The corresponding audio file appears in the Select Files to Broadcast box. You can select more than one file to broadcast from different voice systems.
3. Repeat Steps 1 and 2 for each extension you want to broadcast.
4. When finished, click OK.
   The Broadcast Announcement Files – Select Files dialog box appears. The audio files you selected appear in the Selected Files to Broadcast box.

What do you want to do?

- Broadcast announcement files to VAL boards
- What I want to do isn't listed here
Broadcast Announcement Files - Select Files Dialog Box

This dialog box lets you select the announcement files that you want to broadcast to other VAL/virtual VAL boards.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by performing either of the following steps:

To perform a broadcast now, choose Broadcast from the Actions menu. The Broadcast Announcement Files - Select Files dialog box appears.

To schedule a broadcast task, perform the following steps:

1. From the Actions menu, choose Scheduler.
   The Task Editor dialog box appears.
2. Click Add.
   The Create Task dialog box appears.
3. Click the Create New Task option button, and click OK.
   The Create New Task dialog box appears.
4. Enter the appropriate information, click the Broadcast option button, and then click Next.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. At the top of the Local Files box, be sure the correct folder is displayed.
   If it is not, click Select Files to select the folder that has the files you want to broadcast.
2. In the Local Files box, select the files you want to broadcast, and click the > button. If you want to broadcast all of the files, click the >> button.
   The files you selected appear in the Selected Files to Broadcast box.
   If you make a mistake, highlight the mistake in the Selected Files to Broadcast box and click the < button, or click Cancel to start over.
3. If you want the files to overwrite the protected announcement files, select the Override Protected Bit check box.
   For example, suppose an administered announcement titled hello.wav is present on a VAL board 01A05. (Both the audio file and the announcement property for hello.wav are present on the VAL board 01A05.) Also, the protected bit for the announcement property is set to y (that is, the announcement is protected).
   Now, you try to broadcast hello.wav onto VAL boards, including the VAL board 01A05, which already contains the administered announcement hello.wav. If you selected the Override Protected Bit check box, the property on VAL board 01A05 will be unprotected, hello.wav will be copied, and the property for that announcement will be protected again.
4. If you want to select extensions to broadcast announcement files to a group of VAL sources, perform the following steps:
k. Select the **Broadcast by Ext** button.  
   The Broadcast Announcement Files – Select Files by Extension dialog box appears.

l. From the Voice System box, select the voice system that contains the extensions you want to broadcast.

m. In the Extension box, enter the extension you want to broadcast, and click **Add**.  
   The VAL board and audio group of the extension you entered appear in the Select Files to Broadcast box.

n. Repeat Steps B and C for each extension you want to broadcast.

o. When finished, click **OK**.  
   The Broadcast Announcement Files – Select Files dialog box appears. The VAL board and audio group of the selected extensions appear in the Selected Files to Broadcast box.

5. Click one of the following:
   - **Next** to access the Broadcast Announcement Files - Select Voice System dialog box so you can select the destination VAL/virtual VAL board(s).
   - **Cancel** to ignore the information and close the dialog box.
   - **Back** to access the previous dialog box.
   - **Help** for assistance understanding this dialog box.

**What do you want to do?**

- Broadcast announcement files to VAL boards
- What I want to do isn't listed here
Broadcast Announcement Files - Select Voice System Dialog Box

This dialog box lets you select the VAL/virtual VAL boards to which you want to broadcast the announcement files.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by performing either of the following steps:

To perform a broadcast now, perform the following steps:

1. From the Actions menu, choose Broadcast.
   The Broadcast Announcement Files – Select Files dialog box appears.
2. Select the files you want to broadcast from the Broadcast Announcement Files – Select Files dialog box, and then click Next.

To schedule a broadcast task, perform the following steps:

1. From the Actions menu, choose Scheduler.
   The Task Editor dialog box appears.
2. Click Add.
   The Create Task dialog box appears.
3. Click the Create New Task option button, and click OK.
   The Create New Task dialog box appears.
4. Enter the appropriate information, click the Broadcast option button, and then click Next.
   The Broadcast Announcement Files - Select Files dialog box appears.
5. Select the files you want to broadcast from the Broadcast Announcement Files – Select Files dialog box, and then click Next.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. In the Registered Voice Systems box, select the VAL/virtual VAL boards to which you want to broadcast the announcement files, and click the > button. If you want to select all of boards, click the >> button.
   The boards you selected appear in the Selected VAL Board box.

   If you make a mistake, highlight the mistake in the Selected VAL Board box and click the < button, or click Cancel to start over.

   If you want to broadcast announcement files to extensions, click Broadcast to Ext. The Broadcast Announcement Files – Select Boards by Extension dialog box appears. Select the destination using an extension on the voice system, and then click Add. The corresponding VAL boards and audio groups appear in the Select Boards to Broadcast box. You can select multiple extensions on multiple voice systems. When you are finished, click OK. The selected boards and audio groups appear in the Selected VAL Board box.
2. If you want to change the name of the file you want to broadcast, click the **Change Filename to** check box, and then enter the new file name in the corresponding box. **This option is available only when you select a single file for broadcast.**

3. Click one of the following:
   - **Next** to access the next dialog box.
   - **Back** displays the previous dialog box.
   - **Cancel** to ignore the information and close the dialog box.
   - **Help** for assistance understanding this dialog box.

**What do you want to do?**

- Broadcast announcement files to VAL boards
- What I want to do isn't listed here
Broadcast Announcement Files - Select Boards by Extension Dialog Box

This dialog box lets you select the extensions to which you want to broadcast announcement files. You can select multiple extensions on multiple voice systems.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by performing either of the following steps:

To perform a broadcast now:

1. Choose Broadcast from the Actions menu.
   
   The Broadcast Announcement Files - Select Files dialog box appears.

2. Select the Files you want to broadcast, and then click Next.
   
   The Broadcast Announcement Files – Select Voice System dialog box appears.

3. Click Broadcast to Ext.

Perform the following steps:

1. From the Actions menu, choose Scheduler.
   
   The Task Editor dialog box appears.

2. Click Add.
   
   The Create Task dialog box appears.

3. Click the Create New Task option button, and click OK.
   
   The Create New Task dialog box appears.

4. Enter the appropriate information, click the Broadcast option button, and then click Next.
   
   The Broadcast Announcement Files – Select Files dialog box appears.

5. Select the files you want to broadcast, and then click Next.
   
   The Broadcast Announcement Files – Select Voice System dialog box appears.

6. Click Broadcast to Ext.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. From the Voice System box, select the voice system that contains the extensions to which you want to broadcast.

2. In the Extension box, enter the extension to which you want to broadcast, and click Add.
   
   The VAL board and audio group of the extension you entered appear in the Select Boards to Broadcast box. You can select more than one extension on more than one voice system.

3. Repeat Steps 1 and 2 for each extension to which you want to broadcast.

4. When finished, click OK.
The Broadcast Announcement Files – Select Voice System dialog box appears. The VAL board and audio group of the selected extensions appear in the Selected VAL Board box.

**What do you want to do?**

- [Broadcast announcement files to VAL boards](#)
- [What I want to do isn't listed here](#)
Browse Extension Dialog Box

This dialog box lets you select a range of extensions applicable to the selected announcement and then (using the Next button), select a specific extension for the announcement.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unused Extensions</td>
<td>Folder Extensions expands to show all available extension ranges that have at least one available extension that is valid for the announcement.</td>
</tr>
<tr>
<td>Selected Extensions</td>
<td>Folder Extensions expands to show all selected extension ranges.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>Moves selected extension range from the Unused Extensions pane to the Selected Extensions pane.</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>Moves all extension ranges from the Unused Extensions pane to the Selected Extensions pane. (Select all.)</td>
</tr>
<tr>
<td>&lt;</td>
<td>Moves selected extension range from the Selected Extensions pane to the Unused Extensions pane.</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>Moves all extension ranges from the Selected Extensions pane to the Unused Extensions pane. (Select none.)</td>
</tr>
<tr>
<td>OK</td>
<td>Saves the changes you have made and closed the dialog box.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog box without changing any changes.</td>
</tr>
<tr>
<td>Next</td>
<td>Opens the List of Unused Extensions dialog box to select the final extension.</td>
</tr>
<tr>
<td>Help</td>
<td>Shows this help topic.</td>
</tr>
</tbody>
</table>
Configure Application Specific E-mail Notification Dialog Box

This dialog box lets you configure the Email notification information for Voice Announcement Manager.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by selecting Email Configuration from the System menu.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. In the SMTP Server IP Address/Name box, enter the IP address of the SMTP server.
2. In the From Address in the Notification E-mail box, enter the email address that you want to appear in the From: address for a notification email.
3. If the outgoing mail server requires authentication, perform the following steps in the Outgoing Mail Server area:
   p. Select the My server requires Authentication check box.
   q. In the Login Name box, enter your login name.
   r. In the Password box, enter your password.
   s. In the Re-Enter Password box, re-enter your password.
4. In the E-mail Event Configuration area, perform one of the following steps:
   - If you want the system to send email when the task is performed successfully, click the Send E-mail for Successful Task Completion only option button.
   - If you want the system to send email when the task fails, click the Send E-mail for Task Failure only option button.
   - If you want the system to send email when the task is modified or deleted, click the Send E-mail when a Task is Modified/Deleted option button.
   - If you want the system to send email when the task is performed successfully, fails, or is modified or deleted, click the Send E-mail when any of the Above Events Occur option button.
5. In the Notification Recipient Address area, perform one of the following steps:
   - If you want to add an email address to receive notification, click Add and enter the appropriate information.
   - If you want to remove an email address, select that email address and click Remove.
6. Click one of the following:
   - OK to save the information and close the dialog box.
   - Cancel to ignore the information and close the dialog box.
   - Apply to save the information and keep the dialog box open.
   - Test E-mail settings to send an email message to the email addresses listed in the Notification Recipient Address area to make sure that the email notification feature is administered properly.
What do you want to do?

- Configure email notification
- What I want to do isn't listed here

Help for assistance understanding this dialog box.
Configure E-mail Notification Dialog Box

This dialog box lets you set

- the type of event for which email will be sent
- the email addresses to which email will be sent for the task

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by performing the following steps:

1. From the Actions menu, choose Scheduler.
   The Task Editor dialog box appears.
2. Click Add.
   The Create Task dialog box appears.
3. Click the Create New Task option button, and click OK.
   The Create New Task dialog box appears.
4. Select the Create Task Specific Notification configuration option.
5. Complete the task-related dialog boxes.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. In E-mail Event Configuration area, perform one of the following steps:
   ○ If you want the system to send email when the task is performed successfully, click the Send E-mail for Successful Task Completion only option button.
   ○ If you want the system to send email when the task fails, click the Send E-mail for Task Failure only option button.
   ○ If you want the system to send email when the task is modified or deleted, click the Send E-mail when the Task is Modified/Deleted option button.
   ○ If you want the system to send email when the task is performed successfully, fails, or is modified or deleted, click the Send E-mail when any of the Above Events Occurs option button.
2. In the Notification Recipient Address area, perform one of the following steps:
   ○ If you want to add an email address to receive notification, click Add and enter the appropriate information.
   ○ If you want to add the default notification email list, click Load.
   ○ If you want to remove an email address, select that email address and click Remove.
3. Click one of the following:
   ○ Finish to complete the task and close the dialog box.
   ○ Back displays the previous dialog box.
   ○ Cancel to ignore the information and close the dialog box.
   ○ Help for assistance understanding this dialog box.
What do you want to do?

- [ ] Create a task
- [ ] What I want to do isn't listed here
Connect At Startup Dialog Box

This dialog box lets you specify which voice systems you want Voice Announcement Manager to connect to automatically when you start Voice Announcement Manager. Only the voice systems that you have added to Voice Announcement Manager are displayed.

- Put a check mark in each box next to the name of the systems you want Voice Announcement Manager to connect to when it is launched.
- If you want to select all of the voice systems, click the Select All Voice Systems check box.
- To remove one from the list of voice systems that Voice Announcement Manager should connect to on startup, clear the check box next to that voice system.
- When finished, click OK.
Copy/Delete Announcement Files Dialog Box

This dialog box lets you copy audio files, which may or may not yet be associated with announcement properties, from the Voice Announcement Manager computer to a voice system or from the voice system to the Voice Announcement Manager computer. When you open this dialog box, Voice Announcement Manager automatically queries the appropriate voice system and displays (in the right box) the audio files on that system.

Note:
The Copy/Delete Announcement Files dialog box lets you copy ONLY audio files. If you want to copy announcement properties, use the Announcement Properties table in the right pane of the Voice Announcement Manager main window.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

- Right-click a VAL board in the Voice Announcement Manager tree, and then choose Copy/Delete Audio Files from the popup menu.
- Select a VAL board in the Voice Announcement Manager tree, and then choose Copy/Delete Audio Files from the Actions menu.

How do I use this dialog box?

To use this dialog box to copy files, complete the following steps:

Tip:

Check the name displayed at the top of the Files on VAL Board box. If it is not the voice system and VAL board that you intended, click Close and then re-select the appropriate voice system and VAL board from the Voice Announcement Manager Tree. Also check the name displayed at the top of the Files From Local PC box. If it is not the folder you intended, click Change Folder and navigate to the correct one.

1. Select files and move them to the appropriate box.

   - To copy audio files to the voice system, select an audio file in the Files From Local PC box and use the > button to move it to the Files on VAL Board box.
   - To copy audio files from the voice system, select an audio file in the Files on VAL Board box and use the < button to move it to the Files From Local PC box.

Note:

When you select an audio file from the Files on VAL Board box (the voice system) and move it to the Files From Local PC box (the Voice Announcement Manager computer) beware that you could be overwriting backup files on the Voice Announcement Manager computer.

Tips:

- Shift-click or Ctrl-click to select more than one file in a box.
- Click >> or << to move all of the files from one box to the other.
If you moved something from the Files on VAL Board box to the Files From Local PC box mistakenly, go to your Windows Explorer and delete the file. If you moved something from the Files From Local PC box to the Files on VAL Board box by mistake, highlight it in the Files on VAL Board box and click the Delete File button.

2. While copying audio files to the VAL board, if you want to override the protected bit, select the Override Protected Bit check box.

For example, suppose an administered announcement titled hello.wav is present on a VAL board 01A05. (Both the audio file and the announcement property for hello.wav are present on the VAL board 01A05.) Also, the protected bit for the announcement property is set to y (that is, the announcement is protected).

Now, you try to copy hello.wav onto VAL boards, including the VAL board 01A05, which already contains the administered announcement hello.wav. If you selected the Override Protected Bit check box, the property on VAL board 01A05 will be unprotected, hello.wav will be copied, and the property for that announcement will be protected again.

3. Click one of the following:
   - Close to close this dialog box.
   - Help for assistance understanding this dialog box.

To use this dialog box to delete files, complete the following steps:

1. In the Files on VAL Board box, select the files you want to delete from the VAL/virtual VAL board.

2. Click Delete File.

   A confirmation dialog box appears prompting whether you want to delete the corresponding announcement property.

3. Perform one of the following steps:
   - If you want to delete the announcement property also, click Yes.
   - If you do not want to delete the announcement property, click No.

4. Click Yes to delete the audio file.

   Voice Announcement Manager deletes the selected audio file from the VAL board.

5. Click one of the following:
   - Close to close this dialog box.
   - Help for assistance understanding this dialog box.

What do you want to do?

- Change Announcement Properties
- Delete Announcement Properties
- Copy Audio Files
- What I want to do isn't listed here
Create/Edit Group Dialog Box

This dialog box lets you

- Create a new audio group.
- Modify an existing audio group.
- Delete an audio group.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by performing one of the following steps:

- Right-click an audio group in the Voice Announcement Manager tree, and then choose Create/Edit Group from the popup menu.
- Select an audio group in the Voice Announcement Manager tree, and then choose Create/Edit Group from the Actions menu.

How do I use this dialog box?

If you want to create a new audio group, complete the following steps:

1. Click the Create New Group option button.
2. From the Group No. box, select the number for this group.
3. In the Group Name box, enter the name for this group.
4. In the Available Announcement Sources box, select the announcement sources you want to add to this group, and click the > button. If you want to add all of the announcement sources, click the >> button. The announcement sources you selected appear in the Group Members box.
   - If you make a mistake, highlight the mistake in the Group Members box and click the < button, or click Cancel to start over.
5. Click OK.
   - After the group is created, the Create Group Task dialog box appears.

If you want to modify an existing audio group, complete the following steps:

1. Click the Edit Group option button.
2. From the Group No. box, select the number of the group you want to modify.
   - The information for the selected group appears.
3. Make your changes.
4. When finished, click OK.
   - After the group is modified, the Edit Group Task dialog box appears.

If you want to delete an audio group, complete the following steps:

1. Click the Edit Group option button.
2. From the Group No. box, select the number of the group you want to delete.
   - The information for the selected group appears.
3. Click Delete.
A warning dialog box appears.

4. Click **Yes** to delete the group.

   After the group is deleted, the Delete Group Task dialog box appears.
Create New Task Dialog Box

This dialog box lets you create a new task that will perform one of the following actions:

- back up selected VAL boards
- back up all voice systems
- broadcast announcements
- import voice announcement properties from a comma-separated values (CSV) file and send that data to a voice system
- export voice announcement properties from a voice system to a comma-separated values (CSV) file

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by performing the following steps:

1. From the Actions menu, choose Scheduler.
   The Task Editor dialog box appears.
2. Click Add.
   The Create Task dialog box appears.
3. Click the Create New Task option button, and click OK.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. In the Name box, enter the name or description for this task.
2. In the Create New area, perform one of the following steps:
   - If you want to create a task that will back up selected VAL boards, click the Backup option button, and then click the Backup Selected VAL Boards option button.
   - If you want to create a task that will back up all voice systems, click the Backup option button, and then click the Backup All Voice Systems option button.
   - If you want to create a task that will broadcast announcements, click the Broadcast option button.
   - If you want to create a task that will import voice announcement properties from a CSV file and send that data to a voice system, click the Import option button.
   - If you want to create a task that will export voice announcement properties from a voice system to a CSV file, click the Export option button.
3. In the E-mail Notification area, perform one of the following steps:
   - If you want the system to send email to the default email address you specified when the task is performed, click the Use Default Notification Configuration option button.
   - If you want the system to send email to a specific email address (that is, an email address other than the default) when the task is performed, click the Create Task Specific Notification Configuration option button.
   - If you do not want the system to send email when the task is performed, click the Do Not Send Notification option button.
4. If you want to use this task as a template, select the **Save this Task for use as a Template** check box.

5. Click one of the following:
   - **Next** to access the next dialog box and close this dialog box
   - **Cancel** to ignore this information and close the dialog box.
   - **Help** for assistance understanding this dialog box.

**What do you want to do?**

- [ ] Create a task
- [ ] What I want to do isn't listed here
Create Task Dialog Box

This dialog box lets you:

- create a new task using a template that you created previously
- create a new task without using a template
- delete an existing template

How can I view this dialog box?
If you aren’t viewing this dialog box already, you can access it by performing the following steps:

1. From the Actions menu, choose Scheduler.
   The Task Editor dialog box appears.
2. Click Add.

How do I use this dialog box?
To use this dialog box, complete the following steps:

1. Perform one of the following steps:
   - If you want to create a new task without using a template, click the Create New Task option button.
   - If you want to create a new task using a template, click the Use Template option button, and then select a template from the list box.
   - If you want to delete a template, click the Use Template option button, select the template you want to delete from the list box, and click Delete.
2. Click OK.

What do you want to do?

- Create a task
- What I want to do isn’t listed here
Create Template Dialog Box

This dialog box lets you create a new template that will perform one of the following actions:

- back up selected VAL boards
- back up all voice systems
- broadcast announcements
- import voice announcement properties from a comma-separated values (CSV) file and send that data to a voice system
- export voice announcement properties from a voice system to a comma-separated values (CSV) file

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by performing the following steps:

1. From the Actions menu, choose Template Editor.
   The Template Editor dialog box appears.
2. Click Add.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. In the Name box, enter the name for this template.
2. In the Create New area, perform one of the following steps:
   - If you want to create a template that will back up selected VAL boards, click the Backup option button, and then click the Backup Selected VAL Boards option button.
   - If you want to create a template that will back up all voice systems, click the Backup option button, and then click the Backup All Voice Systems option button.
   - If you want to create a template that will broadcast announcements, click the Broadcast option button.
   - If you want to import voice announcement properties from a CSV file and send that data to a voice system, click the Import option button.
   - If you want to export voice announcement properties from a voice system to a CSV file, click the Export option button.
3. In the E-mail Notification area, perform one of the following steps:
   - If you want the system to send email to the default email address you specified when the task is performed, click the Use Default Notification Configuration option button.
   - If you want the system to send email to a specific email address (that is, an email address other than the default) when the task is performed, click the Create Task Specific Notification Configuration option button.
   - If you do not want the system to send email when the task is performed, click the Do Not Send Notification option button.
4. If you do not want this task to be scheduled, click the Template only: Do not schedule check box.
5. Click one of the following:
   - **Next** to access the next dialog box and close this dialog box
   - **Cancel** to ignore this information and close the dialog box.
   - **Help** for assistance understanding this dialog box.

When you complete the template, you will have the option of creating a task from this new template (that is, a task with the same properties as the template can be created).

**What do you want to do?**

- [ ] **Modify a template**
- [ ] **Delete a template**
- [ ] **What I want to do isn't listed here**
Edit Application Properties Dialog Box

This dialog box lets you configure the following system settings for Voice Announcement Manager:

- the maximum file size for the activity log. By default, the file size for the activity log is 1 MB. If the file size reaches the limit you set, the file `val_status.txt` will be copied to the file `val_status.txt.old`, and Voice Announcement Manager will start logging messages in the new `val_status.txt` file. If the file `val_status.txt.old` already exists, that file will be overwritten.
- the maximum number of threads spawned per voice system at a time. The threads perform FTP operation on a VAL board. By default, the value for this property will be 10.
- the FTP mode (ACTIVE or PASSIVE). By default, the FTP mode is ACTIVE.
- the FTP log option (check to show detailed logs of FTP/SFTP operations).
- the number of messages to be displayed in the Status pane. By default, 51 messages will be displayed in the Status pane.
- the editing software you want to use to view the activity log. The default editor is WordPad.
- the audio player/editor software you want Voice Announcement Manager to start when you select Launch Audio player/Editor from the File menu.
- the maximum number of minutes that you want Voice Announcement Manager to maintain its connection to the voice system.
- the maximum number of seconds that you want Voice Announcement Manager to maintain its connection to the voice system after the last communication to the voice system.
- the number of seconds that you want to elapse before Voice Announcement Manager logs into a voice system. This delay is the number of seconds that elapse from when you request information from the voice system to when Voice Announcement Manager logs into that voice system.
- whether you have to log into Voice Announcement Manager via a password. You can set Voice Announcement Manager to prompt you for a password every time you start Voice Announcement Manager. If you password protect Voice Announcement Manager, you must also specify an email address so Voice Announcement Manager can email you a copy of your password on request (for example, if you forget your password).

If you enter the wrong password five consecutive times, Voice Announcement Manager will close. If you are unable to log into Voice Announcement Manager (that is, you cannot remember your password), you must delete the file “ValManager.dat” and then start Voice Announcement Manager. Your tasks, templates, and other settings are preserved, but all of the voice system information is removed. You must re-enter the voice system information.

Note:

If you want to password protect Voice Announcement Manager, you must first configure the outgoing mail server information for Voice Announcement Manager.

How can I view this dialog box?

If you aren't viewing this dialog box already, you can access it by selecting Edit Application Properties from the File menu.
**How do I use this dialog box?**

To use this dialog box, complete the following steps:

a. In the Log Limit (in MB) box, enter the maximum file size for the activity log. The range is 1 to 5 MB.

b. In the FTP Thread Limit box, enter the maximum number of threads spawned per voice system at a time. The range is 1 to 25.

c. From the FTP Connect Mode box, select the FTP mode. The default is ACTIVE.

d. Check the FTP log option to show detailed logs of FTP/SFTP operations.

e. In the Status Pane Messages box, enter the maximum number of messages to be displayed in the Status pane. The range is 1 to 250.

f. From the Log Editor box, select the editing software that will be used to view the activity log.

g. From the Audio Player/Editor box, select the audio player/editor software you want Voice Announcement Manager to start when you select Launch Audio Player/Editor from the File menu.

h. In the Login Duration box, enter the maximum number of minutes that you want Voice Announcement Manager to maintain its connection to the voice system.

i. In the Connection Timeout box, enter the maximum number of seconds that you want Voice Announcement Manager to maintain its connection to the voice system after the last communication to the voice system.

j. In the Login Delay box, enter the number of seconds that must elapse before Voice Announcement Manager logs into a voice system. This delay is the number of seconds that elapse from when you request information from the voice system to when Voice Announcement Manager logs into that voice system.

k. If you want to configure Voice Announcement Manager to prompt you for a password when you start Voice Announcement Manager, perform the following steps:

   t. Click the Authentication Required check box.

   u. In the Password box, enter the password you want to use to log into Voice Announcement Manager.

   v. In the Re-enter Password box, enter the password you want to use to log into Voice Announcement Manager.

   w. In the E-mail ID box, enter the email address to which you want Voice Announcement Manager to email your password. This setting is valuable if you forget your password.

12. Click Save.

**Note:**

If you tried to configure a password for Voice Announcement Manager, but you did not configure the outgoing mail server information for Voice Announcement Manager previously, an error message appears. Perform the following steps:

x. Click OK to close the error message box.

y. Uncheck the Authentication Required check box.

z. Configure the outgoing mail server information for Voice Announcement Manager.
aa. Perform Steps 10 and 11 in this procedure to password protect Voice Announcement Manager.

What do you want to do?

- Configure the Voice Announcement Manager properties
- What I want to do isn't listed here
**Edit Voice System Properties Dialog Box**

This dialog box lets you view or change the information that Voice Announcement Manager needs about a voice system.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice System Name</td>
<td>Enter the name of the voice system you want Voice Announcement Manager to support.</td>
</tr>
<tr>
<td>FQDN or IP Address</td>
<td>Enter the IP Address of the C-LAN board that you want to use to connect to this voice system. There may be many C-LAN boards on your voice system; you need to know which one you are using for administration. If you don't know it, you can ask your LAN/WAN administrator, or you can <a href="#">get this information from the voice system</a>.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the number of the IP Network Port that this voice system's C-LAN board will be using to communicate with Voice Announcement Manager. If you don't know it, you can ask your LAN/WAN administrator or you can <a href="#">get this information from the voice system</a>.</td>
</tr>
<tr>
<td>Login Name</td>
<td>Enter the Login Name of the account on the voice system that you want Voice Announcement Manager to use to access this voice system.</td>
</tr>
<tr>
<td>Password</td>
<td>If this voice system uses a password, select this option button and enter the password associated with the Login Name you specified in the previous field.</td>
</tr>
<tr>
<td>Access Security Gateway (ASG)</td>
<td>ASG is an optional security feature available on your voice system. Select this option button only if this voice system uses ASG and if this login uses ASG. Then, enter the ASG Secret Key associated with the login you entered in the Login Name field.</td>
</tr>
<tr>
<td>Companding Mode</td>
<td>This display-only field does not appear for voice systems you are first adding. This field appears only for voice systems you have already added to Voice Announcement Manager, and displays data that has been retrieved from the voice system. Companding Mode indicates the method by which the signal will be compressed for economical transmission and then decompressed at the receiving end.</td>
</tr>
<tr>
<td>Connect At Startup</td>
<td>Put a check in this box if you want Voice Announcement Manager to attempt to connect to this voice system automatically when you start Voice Announcement Manager.</td>
</tr>
</tbody>
</table>
What do you want to do?

- Add a new voice system to Voice Announcement Manager
- Change voice system information in Voice Announcement Manager
- What I want to do isn't listed here
Edit VAL Board Properties Dialog Box

This dialog box displays (for the VAL board that you selected) the values from the following Communication Manager fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Slot location of the VAL board</td>
</tr>
<tr>
<td>Name</td>
<td>Node name of the VAL board</td>
</tr>
<tr>
<td>Type</td>
<td>The Media Gateway type (for example, G700 or G350)</td>
</tr>
<tr>
<td>IP Address</td>
<td>IP address of the VAL board</td>
</tr>
<tr>
<td>Time Remaining</td>
<td>Time remaining to record on the VAL board</td>
</tr>
<tr>
<td>Audio Files Folder</td>
<td>Location where audio files will be stored on the computer.</td>
</tr>
</tbody>
</table>

If the media gateway is a G450, G350, G250, G250-DCP, G250-DS1, J2320, J2340, J4350, J4360, or Samsung AMRB, the media gateway SNMPv3 credentials that you entered in the SCP Configuration tab in the Register/Edit Voice System Properties dialog box are also displayed.

What do you want to do?

- [Change VAL Board Properties](#)
- [Change voice system information in Voice Announcement Manager](#)
- [Change Announcement Properties](#)
- [What I want to do isn't listed here](#)
Export Data - Filters Dialog Box

This dialog box lets you select the data that you want to retrieve from a voice system and export that information to a file. For example, you may want to retrieve a list of all announcement properties that have a class restriction of 1.

Using this dialog box, you specify the range of values you want to retrieve. You can specify lists, such as **1000-1999,2000,2002-2010**. For example, if you want a list of all announcements with extensions from 1000 to 2000, you would enter **1000-2000** in the Extension field.

**About wildcards, ranges and delimiters**

- **Wildcards (\* and \?)**
  
  Wildcards are used to match non-numeric values. The \? character matches any one character. The \* character matches zero or more characters.

  **Example:** The filter **01?01\*** will match **01A01**, **01A0101**, **01B0115** and **01D01**. The filter **01?01\*** will not match **0101**, **02A0101** or **01AA01**.

- **Ranges**

  Ranges are used to match numbers that fall within a range, or characters that come within a range. Character ranges are specified within square brackets.

  **Example:** The filter **100-200** will match any numeric value between 100 and 200. The filter **01[A-B]\*** will match any string beginning with **01A** or **01B**.

- **Delimiters**

  Sometimes you will need to match something that looks like a range or wildcard, but is not. You will need to surround the filter in quotes so that it is not misinterpreted.

  **Example:** "**01[A-B]\*\*" matches the string **01[A-B]\*\* exactly, but it will not match the string **01A01**.

**How can I view this dialog box?**

If you aren't viewing this dialog box already, you can access it in any of the following ways:

- Right-click the voice system in the Voice Announcement Manager tree, and then choose **Export Announcement Properties** from the popup menu.
- Select the voice system in the Voice Announcement Manager tree, and then choose **Export Announcement Properties** from the **System** menu.

**How do I use this dialog box?**

To use this dialog box, complete the following steps:

1. In the **Value** box for the field in which you are interested, enter the value you want to export from the voice system. You may enter wildcard characters.

2. Repeat Step 1 for any other fields in which you are interested.

3. Click one of the following:
   - **Next** to access the next dialog box.
   - **Cancel** to abort the export and close the dialog box.
   - **Help** for assistance understanding this dialog box.
What do you want to do?

- Export announcement properties
- What I want to do isn't listed here
Export Data - Fields Dialog Box

This dialog box lets you select the fields you want to export from the selected voice system.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

1. Perform one of the following steps:
   - Right-click the voice system in the Voice Announcement Manager tree, and then choose Export Announcement Properties from the popup menu.
   - Select the voice system in the Voice Announcement Manager tree, and then choose Export Announcement Properties from the System menu.

      The Export Data – Filters dialog box appears.

2. Enter the appropriate information in the Export Data – Filters dialog box, and then click Next.

      The Export Data – Fields dialog box appears.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. In the Available fields box, select the field you want to export from the voice system.

2. Click the > button.

      The field you selected appears in the Selected fields in record order box.

      Repeat steps 1 and 2 for each field you want to export. If you want to export all of the fields, click the >> button.

Note:

If the voice system is CM 4.0 system and if the user selects the announcement number field to be exported, VAM displays a warning dialog informing the user that the announcement number field selected is an invalid field and will not be exported.

3. Click one of the following:
   - Next to access the next dialog box.
   - Back to access the previous dialog box.
   - Cancel to abort the export and close the dialog box.
   - Help for assistance understanding this dialog box.

What do you want to do?

- Export announcement properties
- What I want to do isn't listed here
Export Data - Announcement Properties Dialog Box

This dialog box lets you specify

- the name of the CSV file to which voice announcement properties will be exported.
- whether the table header information will be exported to the CSV file.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

1. Perform one of the following steps:
   - Right-click the voice system in the Voice Announcement Manager tree, and then choose Export Announcement Properties from the popup menu.
   - Select the voice system in the Voice Announcement Manager tree, and then choose Export Announcement Properties from the System menu.

   The Export Data – Filters dialog box appears.

2. Enter the appropriate information in the Export Data – Filters dialog box, and then click Next.

   The Export Data – Fields dialog box appears.

3. Enter the appropriate information in the Export Data – Fields dialog box, and then click Next.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. In the Export File box, enter the path and name for the CSV file to which you will export the data.

2. Select the Export Table Header check box if you want to export the table header information to the CSV file.

   The Sample Export box shows the first several lines of data that will be exported.

3. Click one of the following:
   - Next to access the Export Data – Summary dialog box and complete this task.
   - Back to close the dialog box and display the Export Data – Fields dialog box.
   - Cancel to abort the export and close the dialog box.
   - Help for assistance understanding this dialog box.

What do you want to do?

- Export announcement properties
- What I want to do isn’t listed here
Export Data - Summary Dialog Box

This dialog box describes the task that will be performed and lets you complete the task.

How do I use this dialog box?

To use this dialog box, perform one of the following steps:

- To complete the task, click Finish.
- To schedule this task, click Schedule this task and then set the time and frequency.
- To access the previous dialog box, click Back.
- To abort the task and close the dialog box, click Cancel.
- To get assistance understanding this dialog box, click Help.
File Transfer Connections Dialog Box

This dialog box lets you view or change the file transfer connections between Voice Announcement Manager and the VAL boards on a voice system.

- SFTP Configuration
- SCP Configuration

**SFTP Configuration Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFTP Enabled Boards</td>
<td>Folder <em>Selected VAL Boards</em> expands to show all selected physical or virtual VAL boards on the selected voice system.</td>
</tr>
<tr>
<td>Non SFTP Enabled Boards</td>
<td>Folder <em>Available VAL Boards</em> expands to show all non-selected physical or virtual VAL boards on the selected voice system.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>Moves selected VAL boards from the SFTP Enabled Boards pane (left) to the Non SFTP Enabled Boards pane (right).</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>Moves all VAL boards from the SFTP Enabled Boards pane (left) to the Non SFTP Enabled Boards pane (right).  (Select none.)</td>
</tr>
<tr>
<td>&lt;</td>
<td>Moves selected VAL boards from the Non SFTP Enabled Boards pane (right) to the SFTP Enabled Boards pane (left).</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>Moves all VAL boards from the Non SFTP Enabled Boards pane (right) to the SFTP Enabled Boards pane (left). (Select all.)</td>
</tr>
<tr>
<td>OK</td>
<td>Saves the changes you have made and closed the dialog box.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog box without changing any changes.</td>
</tr>
<tr>
<td>Apply</td>
<td>Saves the changes you have made but leaves the dialog box open.</td>
</tr>
</tbody>
</table>
Help | Shows this help topic.

Select SFTP file transfer protocol for VAL boards
1. To select the SFTP file transfer protocol for VAL boards on a voice system you have already added to Voice Announcement Manager, right-click on a voice system in the Voice Announcement Manager tree and choose File Transfer Modes.
   Voice Announcement Manager will then display the File Transfer Connections dialog box.
2. Click the SFTP Configuration tab.
3. Select the VAL boards you wish to add from the Non SFTP Enabled Boards pane and move them to the SFTP Enabled Boards pane.
4. Click OK.

Remove SFTP File transfer protocol for VAL boards
1. To remove the SFTP file transfer protocol for VAL boards on a voice system you have already added to Voice Announcement Manager, right-click on a voice system in the Voice Announcement Manager tree and choose File Transfer Modes.
   Voice Announcement Manager will then display the File Transfer Connections dialog box.
2. Click the SFTP Configuration tab.
3. Select the VAL boards you wish to remove from the SFTP Enabled Boards pane and move them to the Non SFTP Enabled Boards pane.
4. Click OK.

SCP Configuration tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCP Enabled Boards</td>
<td>Folder Selected VAL Baords expands to show all selected physical or virtual VAL boards on the selected voice system.</td>
</tr>
<tr>
<td>Non SCP Enabled Boards</td>
<td>Folder Available VAL Boards expands to show all non-selected physical or virtual VAL boards on the selected voice system.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>Moves selected VAL boards from the SCP Enabled Boards pane (left) to the Non SCP Enabled Boards pane (right).</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>Moves all VAL boards from the <strong>SCP Enabled Boards</strong> pane (left) to the <strong>Non SCP Enabled Boards</strong> pane (right). (Select none.)</td>
</tr>
<tr>
<td>&lt;</td>
<td>Moves selected VAL boards from the <strong>Non SCP Enabled Boards</strong> pane (right) to the <strong>SCP Enabled Boards</strong> pane (left).</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>Moves all VAL boards from the <strong>Non SCP Enabled Boards</strong> pane (right) to the <strong>SCP Enabled Boards</strong> pane (left). (Select all.)</td>
</tr>
<tr>
<td>OK</td>
<td>Saves the changes you have made and closed the dialog box.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog box without changing any changes.</td>
</tr>
<tr>
<td>Apply</td>
<td>Saves the changes you have made but leaves the dialog box open. Use this button when you intend to proceed to SNMP next.</td>
</tr>
<tr>
<td>Proceed to SNMP</td>
<td>Opens the <strong>SNMP User Editor</strong> dialog box.</td>
</tr>
<tr>
<td>Help</td>
<td>Shows this help topic.</td>
</tr>
</tbody>
</table>

### Select SCP file transfer protocol for VAL boards

1. To select the SCP file transfer protocol for VAL boards on a voice system you have already added to Voice Announcement Manager, right-click on a voice system in the Voice Announcement Manager tree and choose **File Transfer Modes**.
   Voice Announcement Manager will then display the **File Transfer Connections** dialog box.
2. Click the **SCP Configuration** tab.
3. Select the VAL boards you wish to add from the **Non SCP Enabled Boards** pane and move them to the **SCP Enabled Boards** pane.
4. Click **OK** if you do not need to set the SNMP information, otherwise click **Proceed to SNMP** to open the **SNMP User Editor** dialog box.

### Remove SCP File transfer protocol for VAL boards

1. To remove the SCP file transfer protocol for VAL boards on a voice system you have already added to Voice Announcement Manager, right-click on a voice system in the Voice Announcement Manager tree and choose **File Transfer Modes**.
   Voice Announcement Manager will then display the **File Transfer Connections** dialog box.
2. Click the **SCP Configuration** tab.
3. Select the VAL boards you wish to remove from the **SCP Enabled Boards** pane and move them to the **Non SCP Enabled Boards** pane.
4. Click **OK**.
Import Announcement Properties Wizard Dialog Box

This dialog box lets you specify
- the CSV file you will import.
- how the announcement properties from the CSV file will be added to the voice system.
- whether the first row of data from the CSV file will be imported.

How can I view this dialog box?
If you aren’t viewing this dialog box already, you can access it in any of the following ways:
1. Perform one of the following steps:
   - Right-click the voice system in the Voice Announcement Manager tree, and then choose **Import Announcement Properties** from the popup menu.
   - Select the voice system in the Voice Announcement Manager tree, and then choose **Import Announcement Properties** from the **System** menu.

   The Import Data - Select Announcement Fields dialog box appears.
2. Enter the appropriate information in the Import Data - Select Announcement Fields dialog box, and then click **Next**.

How do I use this dialog box?
To use this dialog box, complete the following steps:
1. Click **Select**.

   The Open dialog box appears.
2. Select the CSV file you want to import, and click **Open**.

   If you want to view a sample file that is set up correctly, click **View Sample**.
3. Perform one of the following steps:
   - If you want to add the announcement properties from the selected file to the voice system, select **Add**.
   - If you want to change the fields of the existing announcement properties on the voice system with the fields in the selected file, select **Change**.
   - If you want to delete all of the announcement properties on the voice system that correspond with the announcement properties in the selected file, select **Delete**.

   - If you do not want to import the first row of data from the CSV file, click **Yes**.
   - Click one of the following:
     - **Next** to access the Import Data - Summary dialog box and import the selected file.
     - **Back** to close the dialog box and display the Import Data – Select Announcement Fields dialog box.
     - **Cancel** to abort the import and close the dialog box.
     - **Help** for assistance understanding this dialog box.
What do you want to do?

- Import announcement properties
- What I want to do isn't listed here
Import Data - Select Announcement Fields Dialog Box

This dialog box lets you select the fields you want to import from a CSV file.

How can I view this dialog box?
If you aren’t viewing this dialog box already, you can access it in any of the following ways:

- Right-click the voice system in the Voice Announcement Manager tree, and then choose Import Announcement Properties from the popup menu.
- Select the voice system in the Voice Announcement Manager tree, and then choose Import Announcement Properties from the System menu.

How do I use this dialog box?
To use this dialog box, complete the following steps:

1. In the Available fields box, select the field you want to import from the source file.
2. Click the > button.
   
   The field you selected appears in the Selected fields in record order box.

   Repeat steps 1 and 2 for each field you want to import. If you want to import all of the fields, click the >> button.

   **Note:**
   
   *If the COR, TN, Queue, Protect, Rate, or Port fields are blank, the defaults for these settings on the voice system will be used for the imported announcement properties.*

   **Note:**
   
   *If the voice system is CM 4.0 system and if the user selects the announcement number field to be imported, VAM displays a warning dialog informing the user that the announcement number field selected is an invalid field and will not be imported.*

3. Click one of the following:
   - **Next** to access the next dialog box and make changes to the selected file.
   - **Back** to access the previous dialog box.
   - **Cancel** to abort the import and close the dialog box.
   - **Help** for assistance understanding this dialog box.

What do you want to do?

- Import announcement properties
- What I want to do isn't listed here
**Import Data - Summary Dialog Box**

This dialog box lets you

- modify the CSV file that you want to import.
- schedule this import.
- import the CSV file.

**How can I view this dialog box?**

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

1. Perform one of the following steps:
   - Right-click the voice system in the Voice Announcement Manager tree, and then choose **Import Announcement Properties** from the popup menu.
   - Select the voice system in the Voice Announcement Manager tree, and then choose **Import Announcement Properties** from the **System** menu.

   The Import Data - Select Announcement Fields dialog box appears.

2. Enter the appropriate information in the Import Data - Select Announcement Fields dialog box, and then click **Next**.

   The Import Announcement Properties Wizard dialog box appears.

3. Enter the appropriate information in the Import Announcement Properties Wizard dialog box, and then click **Next**.

**How do I use this dialog box?**

To use this dialog box, complete the following steps:

1. If you want to make changes to the selected file, click **View\Edit Import File**, and make your changes.

2. If you want to schedule this import, click **Schedule this task** and specify the frequency.

3. Click one of the following:
   - **Finish** to import the selected file.
   - **Back** to close the dialog box and display the Import Announcement Properties Wizard dialog box.
   - **Cancel** to abort the import and close the dialog box.
   - **Help** for assistance understanding this dialog box.

**What do you want to do?**

- [Import announcement properties](#)
- [What I want to do isn’t listed here](#)
List of Unused Extensions

This dialog box lets you select a single extension for an announcement from the list of available extensions in each range applicable to the selected announcement.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Extensions&gt;</td>
<td>A list of extensions within the current range. (From the Browse Extension dialog box.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>Displays the list of extensions available in the next selected range. (From the Browse Extension dialog box.)</td>
</tr>
<tr>
<td>&lt;</td>
<td>Displays the list of extensions available in the previous selected range. (From the Browse Extension dialog box.)</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog box without saving any changes.</td>
</tr>
<tr>
<td>Finish</td>
<td>Assigns the selected extension to the announcement.</td>
</tr>
<tr>
<td>Help</td>
<td>Shows this help topic.</td>
</tr>
</tbody>
</table>
Move Announcement Files - Select Destination VAL Board Dialog Box

This dialog box lets you select the VAL/virtual VAL board to which you want to move the selected announcement.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by:

1. Perform one of the following steps:
   - Right-click a VAL/virtual VAL board in the Voice Announcement Manager tree, and then choose Move Audio Files from the popup menu.
   - Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then choose Move Audio Files from the Actions menu.

   The Move Announcement Files - Select Files To Move dialog box appears.

2. Enter the appropriate information in the Move Announcement Files - Select Files To Move dialog box, and then click Next.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. At the top of the VAL Boards On box, be sure the correct voice system is displayed.
   If it is not, click Cancel and start over, being sure to select the correct voice system first.

2. In the VAL Boards On box, highlight the VAL/virtual VAL board to which you want to move the announcement. (This is the destination VAL/ virtual VAL board.) You can only select one VAL/virtual VAL board at a time.

3. If you want to override the protected bit, click the Override Protected bit check box.

4. Click the > button.
   The VAL/virtual VAL board you selected appears in the Destination VAL Board box.
   If you make a mistake, highlight the mistake in the Destination VAL Board box and click the < button, or click Cancel to start over.

5. Click one of the following:
   - Finish to move the announcement and close the dialog box
   - Back to close the dialog box and display the Move Announcement Files - Select Files to Move dialog box.
   - Cancel to abort the moving of the announcement and close the dialog box.
   - Help for assistance understanding this dialog box.

What do you want to do?

- Move announcements between VAL boards
- What I want to do isn't listed here
Move Announcement Files - Select Files To Move Dialog Box

This dialog box lets you select the announcement that you want to move from a VAL/virtual VAL board to another VAL/virtual VAL board on the same voice system.

**How can I view this dialog box?**

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

- Right-click a VAL/virtual VAL board in the Voice Announcement Manager tree, and then choose **Move Audio Files** from the popup menu.
- Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then choose **Move Audio Files** from the **Actions** menu.

**How do I use this dialog box?**

To use this dialog box, complete the following steps:

1. At the top of the File on VAL Board box, be sure the correct voice system is displayed. If it is not, click **Cancel** and start over, being sure to select the correct voice system first.
2. In the File on VAL Board box, highlight the announcement that you want to move to another VAL/virtual VAL board. You can only move one announcement at a time.
3. If you want to move the associated announcement property for the selected announcement, click the **Move Associated Announcement Property** check box.
4. Click the > button. The announcement you selected appears in the File To Be Moved box.
   - If you make a mistake, highlight the mistake in the right box and click the < button, or click **Cancel** to start over.
5. Click one of the following:
   - **Next** to access the Move Announcement Files - Select Destination VAL Board dialog box so you can select the destination VAL/virtual VAL board.
   - **Cancel** to abort the moving of the announcement and close the dialog box.
   - **Help** for assistance understanding this dialog box.

**What do you want to do?**

- **Move announcements between VAL boards**
- **What I want to do isn't listed here**
Move Announcement Properties Dialog Box

This dialog box lets you select the announcement administration/properties (and the associated announcement file) you want to move from one VAL board to another on the same voice system. In this procedure, the selected announcement administration/properties are copied to the destination VAL board and deleted from the source VAL board.

How can I view this window?

If you aren’t viewing this dialog box already, you can access it by performing the following steps:

1. Right-click the appropriate VAL board in the Voice Announcement Manager Tree and select Move Announcement Properties.

How do I use this window?

To use this window, complete the following steps:

1. Select the check box for each announcement property you want to move.

2. From the Move to board box, select the VAL board to which you want to move the selected announcement properties.

3. If you want to move the associated audio file, select the Move Associated Audio File check box.

Note:

The Move Associated Audio File check box will be enabled only if the corresponding audio file is present on the VAL board.

4. If you want to override the protected bit, make sure the Override Protected Bit check box is selected.

5. Click one of the following:
   - OK to move the selected announcement properties and close the window.
   - Cancel to abort the procedure and close the window.
   - Help for assistance understanding this window.

What do you want to do?

- Move the announcement property between VAL boards
- What I want to do isn’t listed here
Move Announcement Property Dialog Box

This dialog box lets you move the announcement administration/property (and the associated announcement file) from one VAL board to another on the same voice system. In this procedure, the announcement administration/property is copied to the destination VAL board and deleted from the source VAL board.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by performing the following steps:

1. Right-click the appropriate VAL board in the Voice Announcement Manager Tree and select View Announcement Properties.
   Voice Announcement Manager displays the Announcement Properties table in the right pane.
2. Right-click the announcement you want to move, and then choose Move from the popup menu.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. From the Select Destination VAL Board box, select the VAL board to which you want to move the announcement property.
2. If you want to move the associated audio file, select the Move Associated Audio File check box.

   Note:
   The Move Associated Audio File check box will be enabled only if the corresponding audio file is present on the VAL board.

3. If you want to override the protected bit, make sure the Override Protected Bit check box is selected.
4. Click one of the following:
   - OK to move the announcement property and close the dialog box.
   - Cancel to abort the procedure and close the dialog box.
   - Help for assistance understanding this dialog box.

What do you want to do?

- Move the announcement property between VAL boards
- What I want to do isn’t listed here
Register Voice System Dialog Box

This dialog box enables you to add a voice system to Voice Announcement Manager.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice System Name</td>
<td>Enter the name of the voice system you want Voice Announcement Manager to support.</td>
</tr>
<tr>
<td>FQDN or IP Address</td>
<td>Enter the IP Address of the C-LAN board that you want to use to connect to this voice system. There may be many C-LAN boards on your voice system; you need to know which one you are using for administration. If you don’t know it, you can ask your LAN/WAN administrator, or you can get this information from the voice system.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the number of the IP Network Port that this voice system’s C-LAN board will be using to communicate with Voice Announcement Manager. If you don’t know it, you can ask your LAN/WAN administrator or you can get this information from the voice system.</td>
</tr>
<tr>
<td>Login Name</td>
<td>Enter the Login Name of the account on the voice system that you want Voice Announcement Manager to use to access this voice system.</td>
</tr>
<tr>
<td>Password</td>
<td>If this voice system uses a password, select this option button and enter the password associated with the Login Name you specified in the previous field.</td>
</tr>
<tr>
<td>Access Security Gateway (ASG)</td>
<td>ASG is an optional security feature available on your voice system. Select this option button only if this voice system uses ASG and if this login uses ASG. Then, enter the ASG Secret Key associated with the login you entered in the Login Name field.</td>
</tr>
<tr>
<td>Companding Mode</td>
<td>This display-only field does not appear for voice systems you are first adding. This field appears only for voice systems you have already added to Voice Announcement Manager, and displays data that has been retrieved from the voice system. Companding Mode indicates the method by which the signal will be compressed for economical transmission and then decompressed at the receiving end.</td>
</tr>
<tr>
<td>Connect At Startup</td>
<td>Put a check in this box if you want Voice Announcement Manager to attempt to connect to this voice system automatically when you start Voice Announcement Manager.</td>
</tr>
</tbody>
</table>
What do you want to do?

- Add a new voice system to Voice Announcement Manager
- Change voice system information in Voice Announcement Manager
- What I want to do isn't listed here
Rename Announcement Property Dialog Box

This dialog box lets you rename the selected announcement property.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by selecting Edit Application Properties from the File menu.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. In the New Property Name box, enter the new name for the announcement property.
2. If you want to rename the associated audio file, click the Rename Associated Audio File check box.
3. If you want to override the protected bit, click the Override Protected Bit check box.
4. Click OK.
Rename Audio File Dialog Box

This dialog box lets you rename the selected audio file.

**How do I use this dialog box?**

To use this dialog box, complete the following steps:

1. In the New Audio File Name box, enter the new name for the audio file.
2. If you want to rename the associated announcement property, click the **Rename Associated Announcement Property** check box.
3. If you want to override the protected bit, click the **Override Protected Bit** check box.
4. Click **OK**.
Restore Audio Files and Announcements Properties Dialog Box

This dialog box lets you restore your announcement files and announcement property files from a location on your Voice Announcement Manager computer to a VAL/virtual VAL board you select.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

- Right-click a VAL board in the Voice Announcement Manager tree, and then choose Restore from the popup menu.
- Select a VAL board in the Voice Announcement Manager tree, and then choose Restore from the Actions menu.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. At the top of the Files From Local PC box, be sure the location that contains the files you want to restore is displayed.
   - If it is not, click Change Folder and select the location where the files should come from.
2. At the top of the Selected Files to Restore box, be sure the correct VAL/virtual VAL board is displayed.
   - If it is not, click Cancel and start over, being sure to select the correct VAL board first.
3. In the Files From Local PC box, highlight the announcements that you want to restore and click the > button.
   - The prefix “AF” indicates that both the announcement property and the .wav file are present for that announcement. Prefix “F” indicates that only .wav file is present and prefix “A” indicates that only announcement property file is present.
   - If you make a mistake, highlight the mistake in the right box and click the < button, or click Cancel to start over.
4. Repeat Step 3 until you have specified all of the announcements that you want to restore from the Voice Announcement Manager computer.
5. If you want the announcement you are restoring to override the existing announcement on that board, click the Override Protected Bit check box.
6. Click one of the following:
   - OK to execute the restore and close the dialog box
   - Apply to execute the restore and leave the dialog box open.
   - Cancel to abort the restore and close the dialog box.
   - Help for assistance understanding this dialog box.

What do you want to do?

- Back Up files
- What I want to do isn't listed here
SCP Server Configuration Dialog Box

This dialog box lets you view or change the information for the SCP server.

Note:

SCP is only supported for G450, G350, G250, G250-DCP, G250-DS1, J2320, J2340, J4350, J4360, and Samsung AMRB media gateways.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local</td>
<td>Select this option button if the SCP server is installed on the local PC.</td>
</tr>
<tr>
<td>Remote</td>
<td>Select this option button in the SCP server is installed on a different PC.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Enter the IP address of the SCP server. If you selected the Local option button, the IP address of the local PC appears.</td>
</tr>
<tr>
<td>Login</td>
<td>Enter the login for an account on the SCP server.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password associated with the login you entered in the Login box.</td>
</tr>
<tr>
<td>Home Directory</td>
<td>Enter the path for the home directory. Use the Browse button to select this directory.</td>
</tr>
</tbody>
</table>
Search and Replace VAL Sources Dialog Box

This dialog box lets you:

- find VAL sources in an audio group in a voice system
- replace VAL sources in an audio group in a voice system

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

- Right-click the voice system in the Voice Announcement Manager tree, and then choose Search/Replace VAL Sources in Group from the popup menu.
- Select the voice system in the Voice Announcement Manager tree, and then choose Search/Replace VAL Sources in Group from the Actions menu.

How do I use this dialog box?

To find a VAL source, complete the following steps:

1. Click the Find option button.
2. In the Available VAL Sources box, select the VAL source you want to find and click the > button.
   The VAL source you selected appears in the VAL Sources to be searched box.
3. Click OK.
   The Search Results for groups dialog box appears and displays the number and name of the group that contains this VAL source.

To find and replace a VAL source, complete the following steps:

1. Click the Find and Replace option button.
2. In the Available VAL Sources box, select the VAL source you want to find and replace, and click the > button.
   The VAL source you selected appears in the VAL Sources to be searched box.
3. Click Next.
4. In the Available VAL Sources box, select the VAL source you want to use as the replacement, and click the > button.
   The VAL source you selected appears in the VAL Sources to be replaced box.
5. Click Finish.
   The Search and Replace VAL Sources Success dialog box appears.
6. Click Close.

What do you want to do?

- Search for VAL sources in an audio group
- Replace VAL sources in an audio group
- What I want to do isn't listed here
Search Results Dialog Box

This dialog box displays the results of your search for announcement property files or audio files on a voice system.

If you performed a search for announcement property files, you can:

- Move announcement properties
- Edit announcement properties
- Rename announcement properties
- Delete announcement properties
- Print announcement properties

If you performed a search for audio files, you can:

- Move audio files
- Copy audio files
- Rename audio files
- Delete audio files
- Print audio files

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

1. Perform one of the following steps:
   - Right-click Voice Systems in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the popup menu.
   - Select Voice Systems in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the System menu.
   - Right-click a voice system in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the popup menu.
   - Select a voice system in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the System menu.

   The Search Task dialog box appears.

2. Enter the appropriate information in the Search Task dialog box, and then click Search.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. Perform one of the following steps:
   - If you performed a search for an announcement property, perform one of the following steps:

     - If you want to move an announcement property, right-click the announcement property, and then choose Move from the popup menu.
     - If you want to edit an announcement property, right-click the announcement property, and then choose Edit from the popup menu.
     - If you want to rename an announcement property, right-click the announcement property, and then choose Rename from the popup menu.
If you want to delete an announcement property, right-click the announcement property, and then choose **Delete** from the popup menu.

If you want to view how the announcement properties will be printed, click **PrintPreview**.

If you want to print the announcement properties, click **Print**.

If you performed a search for an audio file, perform one of the following steps:

- If you want to move an audio file, right-click the audio file, and then choose **Move** from the popup menu.
- If you want to copy an audio file, right-click the audio file, and then choose **Copy** from the popup menu.
- If you want to rename an audio file, right-click the audio file, and then choose **Rename** from the popup menu.
- If you want to delete an audio file, right-click the audio file, and then choose **Delete** from the popup menu.
- If you want to view how the audio files will be printed, click **PrintPreview**.
- If you want to print the audio files, click **Print**.

2. When you are finished, click **Cancel**.

**What do you want to do?**

- [ ] Search for audio files
- [ ] Search for announcement property files
- [ ] What I want to do isn't listed here
Search Results for Groups Dialog Box

This dialog box displays the results of your search for a VAL source.

**How can I view this dialog box?**

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

- Right-click the voice system in the Voice Announcement Manager tree, choose **Search/Replace VAL Sources in Group** from the popup menu, and search for a VAL source.
- Select the voice system in the Voice Announcement Manager tree, choose **Search/Replace VAL Sources in Group** from the **Actions** menu, and search for a VAL source.

**How do I use this dialog box?**

To print the information displayed in the Search Results for group dialog box, click **Print**.

**What do you want to do?**

- [Search for VAL sources in an audio group](#)
- [Replace VAL sources in an audio group](#)
- [What I want to do isn't listed here](#)
Search Task Dialog Box

This dialog box lets you search for
- announcement property files on a voice system
- audio files on a voice system

You can specify to search all of your voice systems.

How can I view this dialog box?

If you aren't viewing this dialog box already, you can access it in any of the following ways:
- Right-click Voice Systems in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the popup menu.
- Select Voice Systems in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the System menu.
- Right-click a voice system in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the popup menu.
- Select a voice system in the Voice Announcement Manager tree, and then choose Search Announcement Property/File from the System menu.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. Perform one of the following steps:
   - If you want to search for an announcement property file:
     p. From the Voice System box, select the voice system you want to search. If you want to search all of the voice systems, select All Voice Systems.
     q. From the Announcement box, select Property.
     r. From the Property Name box, select the first search criterion you want to use.
     s. From the next box, specify how you want to perform the search. Choices are equals, contains, starts with, and ends with.
     t. In the Value box, enter the information you want to find.
   - If you want to use a second search criterion, perform the following steps:
     iv. From the next box, select whether the second search criterion is required. Select either AND or OR. If you select NONE, the second search criterion will not be used.
     v. From the next Property Name box, select the second search criterion you want to use.
     vi. From the next box, specify how you want to perform the search. Choices are equals, contains, starts with, and ends with.
     vii. From the next Value box, enter the information you want to find.
   - If you want to search for an audio file:
     v. From the Voice System box, select the voice system you want to search. If you want to search all of the voice systems, select All Voice Systems.
     w. From the Announcement box, select File.
x. From the box, specify how you want to perform the search. Choices are **equals**, **contains**, **starts with**, and **ends with**.

y. In the Value box, enter the information you want to find.

2. Click **Search**.

Voice Announcement Manager displays a status box that shows the status of the search.

When the search is completed, the Search Result dialog box appears.

3. Click **OK**.

The files that match your search criteria are displayed.

**What do you want to do?**

- [ ] Search for audio files
- [ ] Search for announcement property files
- [ ] What I want to do isn’t listed here
Select Frequency Dialog Box

This dialog box lets you specify the following settings for a task:

- the date and time the task will start
- the frequency the task will be performed (that is, once, frequent, daily, weekly, and monthly)

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by performing the following steps:

1. From the **Actions** menu, choose **Scheduler**.
   The Task Editor dialog box appears.
2. Click **Add**.
   The Create Task dialog box appears.
3. Click the **Create New Task** option button, and click **OK**.
4. Complete the task-related dialog boxes.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. From the Date box, select the date when you want this task to be performed.
2. In the Time area, enter the time when you want this task to be performed.
3. In the Frequency area, click the appropriate option button to specify how often you want this task to be performed.
4. Click one of the following:
   - **Finish** to complete the task and close the dialog box.
   - **Next** displays the next dialog box.
   - **Back** displays the previous dialog box.
   - **Cancel** to ignore the information and close the dialog box.
   - **Help** for assistance understanding this dialog box.

What do you want to do?

- **Create a task**
- **What I want to do isn't listed here**
Select VAL Boards to be Backed Up Dialog Box

This dialog box lets you select the VAL/virtual VAL boards you want to back up via a task. You can select VAL boards from different voice systems.

How can I view this dialog box?
If you aren't viewing this dialog box already, you can access it by performing the following steps:

1. From the Actions menu, choose Scheduler.
   The Task Editor dialog box appears.
2. Click Add.
   The Create Task dialog box appears.
3. Click the Create New Task option button, and click OK.
   The Create New Task dialog box appears.
4. Enter the appropriate information.
5. Click the Backup option button, click the Backup Selected VAL Boards option button, and then click Next.

How do I use this dialog box?
To use this dialog box, complete the following steps:

1. In the Administered VAL Boards box, select the VAL/virtual VAL boards you want to back up, and click the > button. If you want to select all of the boards for a voice system, select the voice system, and then click the > button. If you want to select all of boards for all of the voice systems, click the >> button.
   The boards you selected appear in the Selected VAL Boards to Backup box.
   If you make a mistake, highlight the mistake in the right box and click the < button, or click Cancel to start over.
2. Click one of the following:
   - Next to access the Select Frequency dialog box.
   - Back displays the previous dialog box.
   - Cancel to ignore the information and close the dialog box.
   - Help for assistance understanding this dialog box.

What do you want to do?

- Restore files
- What I want to do isn't listed here
Select VAL Boards/Groups to be Restored Dialog Box

This dialog box lets you restore your announcements to VAL/virtual VAL boards or groups on a voice system you select.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

- Right-click a voice system in the Voice Announcement Manager tree, and then choose Restore from the popup menu.
- Select a voice system in the Voice Announcement Manager tree, and then choose Restore from the Actions menu.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. At the top of the Administered VAL Boards box, be sure the correct voice system is displayed.
   
   If it is not, click Cancel and start over, being sure to select the correct voice system first.

2. In the Administered VAL Boards box, highlight the VAL/virtual VAL boards that you want to restore and click the > button. If you want to restore all of the boards, either click the >> button or select the voice system and click the > button.
   
   The files you select appear in the Selected VAL Boards to Restore box.
   
   If you make a mistake, highlight the mistake in the right box and click the < button, or click Cancel to start over.

3. Repeat Step 2 until you have specified all of the boards that you want to restore.

4. If you want the restore files to override the protected bit, select the Override Protected Bit check box.

5. If you use the same file in multiple VAL sources, select the Use file from first available source directory check box. Voice Announcement Manager will use the file from the first available source directory to restore all members. This option reduces the time to restore files to all members.

6. Click one of the following:
   
   - OK to execute the restore and close the dialog box
   - Apply to execute the restore and leave the dialog box open.
   - Cancel to abort the restore and close the dialog box.
   - Help for assistance understanding this dialog box.

What do you want to do?

- Back Up files
- What I want to do isn't listed here
SNMP User Editor

This dialog box lets you view or change the list of SNMP v3 users and their connections to SCP enabled VAL boards.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>System assigned user ID.</td>
</tr>
<tr>
<td>User Name</td>
<td>Administered user name.</td>
</tr>
<tr>
<td>All the Applicable Boards</td>
<td>A list of all boards connected via this user’s credentials.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Adds a new SNMP v3 user.</td>
</tr>
<tr>
<td>Modify</td>
<td>Modifies the credentials or list of boards for a user.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes an SNMP user.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes this dialog box.</td>
</tr>
<tr>
<td>Help</td>
<td>Shows this help topic.</td>
</tr>
</tbody>
</table>

Add an SNMP v3 User

1. To add an SNMP v3 user to a voice system you have already added to Voice Announcement Manager, right-click on a voice system in the Voice Announcement Manager tree and choose SNMP User Configuration.

   Voice Announcement Manager displays the SNMP User Editor screen.

2. Click Add.

   Voice Announcement Manager displays the SNMP User Configuration dialog box.

3. Enter the user credentials in the upper portion of the dialog box.

4. Select one or more boards in the SCP Enabled Boards field and move them to the SNMP Parameters Set Boards field.

5. Click OK.

6. Click Close.
View or Modify an SNMP v3 User Credentials or List of Boards

1. To modify an SNMP v3 user to a voice system you have already added to Voice Announcement Manager, right-click on a voice system in the Voice Announcement Manager tree and choose SNMP User Configuration.

   Voice Announcement Manager displays the SNMP User Editor screen.

2. Select and existing SNMP user by clicking on that row.

3. Click Modify.

4. Modify the user credentials in the upper portion of the dialog box as necessary.

5. Move one or more boards between the SCP Enabled Boards field and the SNMP Parameters Set Boards field.

6. Click OK.

7. Click Close.

Delete an SNMP v3 User

1. To delete an SNMP v3 user to a voice system you have already added to Voice Announcement Manager, right-click on a voice system in the Voice Announcement Manager tree and choose SNMP User Configuration.

   Voice Announcement Manager displays the SNMP User Editor screen.

2. Select and existing SNMP user by clicking on that row.

3. Click Delete.

4. Confirm the deletion when requested.

   **Note:**

   *All boards assigned to this user’s credentials will be unassigned and returned to the SCP Enabled Boards list.*

5. Click Close.
SNMP User Configuration

This dialog box lets you view or change the SNMP user credentials and the list of boards using those credentials on a voice system.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>The administered user name.</td>
</tr>
<tr>
<td>Security Model</td>
<td>Select Authentication, Privatization, or both.</td>
</tr>
<tr>
<td>Authentication Password</td>
<td>Enter the authentication password.</td>
</tr>
<tr>
<td>Privacy Password</td>
<td>Enter the privacy password.</td>
</tr>
<tr>
<td>SNMP Parameters Set Boards</td>
<td>Folder Selected VAL Boards expands to show all physical or virtual VAL boards on the selected voice system that are assigned to this user's credentials.</td>
</tr>
<tr>
<td>SCP Enabled Boards</td>
<td>Folder Available VAL Boards expands to show all physical or virtual VAL boards on the selected voice system that use SCP and are not assigned to any user's credentials.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>Moves selected VAL boards from the SNMP Parameters Set Boards pane (left) to the SCP Enabled Boards pane (right).</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>Moves all VAL boards from the SNMP Parameters Set Boards pane (left) to the SCP Enabled Boards pane (right). (Select none.)</td>
</tr>
<tr>
<td>&lt;</td>
<td>Moves selected VAL boards from the SCP Enabled Boards pane (right) to the SNMP Parameters Set Boards pane (left).</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>Moves all VAL boards from the SCP Enabled Boards pane (right) to the SNMP Parameters Set Boards pane (left). (Select all.)</td>
</tr>
<tr>
<td>OK</td>
<td>Saves the changes you have made and closed the dialog box.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog box without changing any changes.</td>
</tr>
<tr>
<td><strong>Apply</strong></td>
<td>Saves the changes you have made but leaves the dialog box open. Use this button when you intend to proceed to SNMP next.</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Shows this help topic.</td>
</tr>
</tbody>
</table>
ssh Key Generation Dialog Box

This dialog box lets you:

- generate the key pair for connecting to a voice system using public key authentication.
- change your password for connecting to a voice system using public key authentication.

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by selecting **Generate SSH key** from the System menu.

**Note:**

*The Generate SSH key option is enabled only when the Use SSH check box is enabled in the Edit Voice System Properties dialog box for the selected voice system.*
Task Editor Dialog Box

This dialog box lets you

• create tasks that you can schedule to run at a specified date, time, and frequency
• modify tasks that you created
• delete tasks that you created
• stop a task from being performed

You can create tasks to perform the following actions:

• back up selected VAL boards
• back up all voice systems
• broadcast announcements
• import voice announcement properties from a comma-separated values (CSV) file and send that data to a voice system
• export voice announcement properties from a voice system to a comma-separated values (CSV) file

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it by choosing Scheduler from the Actions menu.

How do I use this dialog box?

This dialog box displays the following information for each task:

• Id (which is assigned to the task automatically by the Scheduler)
• name (which you created for the task)
• type (that is, backup task, backup all task, broadcast task, import task, or export task)
• the next time this task will be performed
• the last time this task was performed
• the current status. The possible status states are:
  ○ Pending: The task will be performed in the future.
  ○ Running: The task is currently running.
  ○ Completed without errors: The task was performed successfully and will not run in the future.
  ○ Completed with errors: The task was performed with errors and will not run in the future.
  ○ Aborted: The task was aborted and will not be performed unless it is modified.
• the frequency of this task

To use this dialog box, perform any of the following steps:

• If you want to create a new task, click Add.
• If you want to modify an existing task, select the task, and click Modify.
• If you want to delete a task, select the task, and click Delete.
• If you want to stop a task, select the task, and click Abort.
• If you want to clear all completed tasks, and click Clear.
If you want to access the Template Editor dialog box, click View.
If you want to close this dialog box, click Close.

What do you want to do?

- Create a task
- Modify a task
- Delete a task
- Stop a scheduled task
- Clear a task
- What I want to do isn't listed here
Template Editor Dialog Box

This dialog box lets you

- create new templates
- modify existing templates
- delete templates

How can I view this dialog box?

If you aren't viewing this dialog box already, you can access it by choosing Template Editor from the Actions menu.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. Perform any of the following steps:
   - If you want to create a new template, click Add.
   - If you want to view the contents of a template, select the template in the Templates box. The contents of the selected template are displayed in the Task Summary box.
   - If you want to modify an existing template, select the template in the Templates box, and then click Edit.
   - If you want to delete a template, select the template in the Templates box, and then click Delete.

2. Click one of the following:
   - Cancel to close the dialog box.
   - Help for assistance understanding this dialog box.

What do you want to do?

- Create a template
- Modify a template
- Delete a template
- What I want to do isn't listed here
View Audio File Properties Dialog Box

This dialog box lets you view and print the properties for the audio files on the VAL/virtual VAL board you select. From this dialog box, you can also rename the audio file.

For each audio file, the following information is displayed:

- name
- size
- length (in seconds)
- time stamp

How can I view this dialog box?

If you aren't viewing this dialog box already, you can access it in any of the following ways:

- Right-click a VAL/virtual VAL board in the Voice Announcement Manager tree, and then choose View/Rename Audio Files Properties from the popup menu.
- Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then choose View Audio Files Properties from the View menu.
- Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then choose View/Rename Audio Files from the Actions menu.

How do I use this dialog box?

This dialog box displays the properties for each audio file on the selected VAL/virtual VAL board. Perform any of the following:

- To rename the audio file:
  - Highlight the file you want to rename, and click Rename.
    - The Rename Audio File dialog box appears.
  - Complete the Rename dialog box, and then click OK.
- To preview how the audio file properties will appear when printed, click Print Preview.
- To print the audio file properties, click Print.
- To close the dialog box, click Close.
- To get assistance understanding this dialog box, click Help.

What do you want to do?

- View the size of audio files
- What I want to do isn't listed here
Virtual VAL Boards Status Dialog Box

This dialog box lets you

- view the status of all the virtual VAL boards on a voice system
- change the status of a virtual VAL board

How can I view this dialog box?

If you aren’t viewing this dialog box already, you can access it in any of the following ways:

- Right-click a voice system in the Voice Announcement Manager tree, and then choose View Virtual VAL Board Status from the popup menu.
- Select a voice system in the Voice Announcement Manager tree, and then choose View Virtual VAL Board Status from the View menu.

How do I use this dialog box?

To use this dialog box, complete the following steps:

1. Perform one of the following steps:
   - If you want to enable a virtual VAL board, click on the Status cell for the board, and select Enabled.
   - If you want to disable a virtual VAL board, click on the Status cell for the board, and select Disabled.

2. Click one of the following:
   - Update to change the status for the virtual VAL board.
   - Cancel to close the dialog box.
   - Help for assistance understanding this dialog box.

What do you want to do?

- View or change the status of a virtual VAL board
- What I want to do isn’t listed here
Contacting Us

Notice

Copyright Avaya Inc. 2006 ALL RIGHTS RESERVED

The products, specifications, and other technical information regarding the products contained in this document are subject to change without notice. All information in this document is believed to be accurate and reliable, but is presented without warranty of any kind, express or implied, and users must take full responsibility for their application of any products specified in this document. Avaya disclaims responsibility for errors which may appear in this document, and it reserves the right, in its sole discretion and without notice, to make substitutions and modifications in the products and practices described in this document.

All trademarks identified by the ® or ™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the property of their respective owners.
Before You Call

Before you call, please have the following information available:

- your name and number (in case we need to call you back)
- your installation location (IL) number
- your company’s main phone number
- the type of your voice system
- the numbers of VAL boards on your system
- the hardware and software specifications of the computer you are running Voice Announcement Manager on
- the location (directory) where you installed Voice Announcement Manager on the computer
- the name of a person at your location who can help execute troubleshooting activities
- whether or not you have pcAnywhere installed on the Voice Announcement Manager computer
- the file val_status.txt from the directory where you installed Voice Announcement Manager (if you installed Voice Announcement Manager in the default directory, look for this file in C:\Program Files\avaya\val).

Remember, if the problem is with equipment or service outside of your own equipment, you need to call your vendor or service provider. If you determine that the problem is with your own equipment, such as on your own stations, voice system, or trunks, give Avaya a call.

Be ready to talk about:

- the problem you want to solve
- a log of the steps you took and the information you gathered while performing your diagnosis of the problem.
- if the problem is with a new component or feature
- if something that used to work now does not work
- any numbers involved with the problem (for example, extensions or phone numbers, trunk group numbers, phone types, or report types)
- the contents of any recorded messages received
- error messages from the voice system
- type of ringback tones received on phones
- the names and numbers of your vendors
- any other pertinent information

Related Topics

- [General Contact Information](#)
- [Technical Support](#)
- [Giving us your feedback](#)
# General Contact Information

<table>
<thead>
<tr>
<th>For</th>
<th>Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avaya’s Home Page</td>
<td><a href="http://www.avaya.com">www.avaya.com</a></td>
</tr>
</tbody>
</table>
| Avaya products                           | [www.avaya.com](http://www.avaya.com)  
  click Solutions, Products & Services |
| Online product catalog                   | [www.avaya.com](http://www.avaya.com)  
  Then click How to Buy.                |
| International Alliance of Avaya Users (InAAU) | [www.inaau.org](http://www.inaau.org) |

## Related Topics

- [Technical Support](#)
- [Giving us your feedback](#)
Technical Support

Before you call, prepare the information that the helpline needs.

For customers located in the US:

<table>
<thead>
<tr>
<th>For Help With...</th>
<th>Contact this Resource</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice Announcement Manager</td>
<td>Avaya’s National Customer Care Center</td>
<td>1 800 242 2121</td>
</tr>
<tr>
<td>Avaya Communication Manager software features and administration</td>
<td>Voice System Helpline of Avaya</td>
<td>1 800 225 7585</td>
</tr>
<tr>
<td>Avaya Communication Manager software maintenance and repair</td>
<td>Avaya’s National Customer Care Center</td>
<td>1 800 242 2121</td>
</tr>
<tr>
<td>Voice mail systems</td>
<td>Avaya National Customer Care Center</td>
<td>1 800 242 2121</td>
</tr>
<tr>
<td>Toll fraud</td>
<td>Avaya’s National Customer Care Center (Toll Fraud Helpline)</td>
<td>1 800 643 2353</td>
</tr>
<tr>
<td>web-based technical support</td>
<td>Avaya’s Customer Support web site</td>
<td><a href="http://www.avaya.com">http://www.avaya.com</a> Then click Support</td>
</tr>
</tbody>
</table>

For customers located outside the US

Contact your local distributor or Avaya representative.

Related Topics

- [General Contact Information](#)
- [Giving us your feedback](#)
Contacting Us

Contacting us for Documentation

<table>
<thead>
<tr>
<th>To...</th>
<th>Use this Resource</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>View documentation online</td>
<td>Recent documents</td>
<td><a href="http://www.avaya.com">http://www.avaya.com</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Then click Support.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Then click Product Documentation.</td>
</tr>
</tbody>
</table>

Related Topics

- General Contact Information
- Technical Support
- Contacting us about training
- Giving us your feedback
Contacting us about Training

For customers located in the US:

<table>
<thead>
<tr>
<th>To...</th>
<th>Use this Resource</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ask general training questions</td>
<td>Avaya University HelpDesk</td>
<td>1 800 288 5327 6:00 a.m. to 5:00 p.m. Mountain Standard Time</td>
</tr>
<tr>
<td>Search an online catalog of classes, videotapes, and computer-based training</td>
<td>Avaya training web site</td>
<td><a href="http://learning2.avaya.com/">http://learning2.avaya.com/</a></td>
</tr>
<tr>
<td>Register for classes</td>
<td>Avaya University Registration Center</td>
<td>1 800 255 8988</td>
</tr>
<tr>
<td>Order videotapes and computer-based training</td>
<td>Avaya Direct</td>
<td><a href="http://www.avaya.com/direct">www.avaya.com/direct</a></td>
</tr>
</tbody>
</table>

For customers located outside the US:
Contact your local distributor or Avaya representative.

Related Topics

- General Contact Information
- Technical Support
- Contacting us about documentation
- Giving us your feedback
Giving us Your Feedback

<table>
<thead>
<tr>
<th>To...</th>
<th>Contact...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ask questions not answered in the help</td>
<td>by phone</td>
</tr>
<tr>
<td>Offer comments on the online help</td>
<td>by email</td>
</tr>
<tr>
<td>Share information with other Avaya product users</td>
<td>over the web</td>
</tr>
</tbody>
</table>

Related Topics

- [General Contact Information](#)
- [Technical Support](#)
What I Want to do Isn't Listed Here

As the authors of this online help system, we have made every effort to anticipate your questions and information needs. However, in this instance, we have obviously missed!

You can help us improve this online help system by telling us more about the situation you are in and the precise information you were looking for. For example, feel free to send us suggested text for a new link! Or a new topic! Or just tell us what you were looking for, and we will find a way to include it.

We keep a record of all the customer comments that we receive. With each new release, we go through the list and implement fixes for as many of the comments as we can.

You can put your suggestion on our list by contacting us at the email address listed in the topic, Giving Us Your Feedback. Thanks in advance for sending us any of your comments or suggestions!
Index

A
accelerator keys ........................................ 142
Activity Log .............................................. 86
adding announcements ................................ 39, 72
adding voice system to VAL Manager ............. 39
adding ..................................................... 72
announcement properties
creating a new announcement ..................... 72
deleting .................................................. 80
entering new announcement properties ........... 75
announcement properties ............................. 72
announcement property
moving between VAL boards ....................... 89
announcement property ................................ 89
Announcement Property Files ...................... 120
announcements
broadcasting ............................................. 90
changing names ......................................... 76
changing names of ...................................... 78
changing properties .................................... 78
displaying ............................................... 74
moving ................................................... 88
announcements ........................................ 76
ASG
ASG is enabled .......................................... 52
ASG is not enabled ...................................... 53
enabling it on your voice system .................. 28
Is it on my login? ....................................... 35
Is it on my voice system? ............................ 27
ASG ..................................................... 52
audio
converting .............................................. 109
converting files through S8100/DEFINITY ONE ........................................ 111
converting using recording app .................... 110
copying to and from a voice system ............. 73
deleting files ........................................... 79
file format requirements ............................. 104
recording files using a phone ..................... 106
recording professionally ............................. 105
recording using computer ............................ 108
audio ................................................... 109
audio files ............................................. 119
audio group
creating ................................................ 115
deleting .................................................. 117
modifying ................................................ 116
audio group ............................................. 115
audio group ............................................. 116
audio group ............................................. 117
Avaya
National Customer Care Center ............... 224
Toll Fraud Helpline .................................. 224
training .................................................. 226
Avaya .................................................... 224
B
backup ................................................... 82
board
Edit VAL Board Properties screen ............. 176
properties
viewing .................................................. 41
board ..................................................... 176
boards
broadcasting announcement files .............. 90
moving announcement property between VAL boards ..................................... 89
moving announcements ............................ 88
viewing/changing the status of virtual VAL boards ............................................ 91
boards .................................................... 90
Broadcast Announcement Files - Select Files by Extension dialog box ........... 149
broadcasting ............................................ 90
C
capacities
too many users logged in ......................... 62
capacities ................................................ 62
changing
announcement names ......................... 76, 78
announcement properties ........................ 39, 78
Communication Manager administrators ....... 30
VAL board properties ................................ 41
voice system information .......................... 39
changing ................................................ 30
Communication Manager
changing administrators .......................... 30
commands used by Voice Announcement Manager ............................................. 21
help line ................................................. 224
setting up for Voice Announcement Manager.................................................26
support .........................................................224
Communication Manager .................................................................30
Configuration Overview ...............................................................25
Connect At Startup screen ...........................................................161
connecting on startup ..................................................................40
connectivity testing ......................................................................48
connectivity .................................................................................48
contacting Avaya Before you call ...............................................222
General contact information .........................................................223
contacting Avaya ..........................................................................222
converting audio files ..................................................................109
audio files through S8100/DEFINITY ONE ..................................111
audio files using recording app ......................................................110
converting ....................................................................................109
copying audio files .......................................................................73
copying .........................................................................................73
Create/Edit Group dialog box .........................................................164
creating announcements ..............................................................72
creating ..........................................................................................72
Creating an audio group ..............................................................115
Creating an audio group folder ....................................................112
documentation contacting us for .................................................225
giving us feedback on .................................................................227
documentation ..............................................................................225
E
Edit Application Properties screen ..............................................171
Edit menu ......................................................................................12, 135
editing voice system information .................................................39
editing ............................................................................................39
Electronic Library Material Online ..............................................225
E-mail Notification .........................................................................92
enabling virtual VAL boards .........................................................45
error ...............................................................................................54
exiting .........................................................................................103
Export Data - Announcement Properties screen ................................180
Export Data - Fields screen ............................................................179
Export Data - Filters dialog box ....................................................177
Export Data - Summary dialog box .................................................181
Exporting Announcement Properties ............................................96
extensions .....................................................................................143, 145
F
features ..........................................................................................1
feedback giving us .........................................................................227
feedback .......................................................................................227
File menu .......................................................................................12, 135
files converting audio .................................................................109
converting through S8100/DEFINITY ONE ..................................111
converting using recording app ....................................................110
recording audio professionally ....................................................105
recording audio using a phone .....................................................106
recording audio using computer ..................................................108
files ...............................................................................................109
format requirements .....................................................................104
G
G450 Media Gateway .................................................................1
getting started ..............................................................................8
# Index

**H**
- help
  - giving us your feedback on............................227
  - using Voice Announcement Manager..................102
- help....................................................227
- Help menu ...........................................12, 135

**I**
- IG550 Integrated Gateways..........................1
- Import Announcement Properties Wizard screen ....................................................186
- Import Data - Fields screen ..........................188
- Import Data - Summary screen ..........................189
- Importing Announcement Properties ..................94
- INDUG ...................................................223

**J**
- Juniper routers ........................................1

**K**
- keyboard shortcuts .....................................142

**L**
- limits
  - too many users logged in ............................62
- limits...................................................62
- login ....................................................99

**M**
- maintenance ............................................227
- menus ..................................................12, 135
- Modifying an audio group .............................116
- Move Announcement Properties dialog box ..............193
- Moving audio groups into different folders .............118

**N**
- names
  - changing ...................................................76
  - changing announcement ................................78
  - names .....................................................78
- new features .............................................1

**O**
- online help
  - using ......................................................102
- online help .............................................102

**P**
- password .............................................99
- passwords
  - assigning new Communication Manager logins and passwords ...........31
  - changing Communication Manager passwords ..........32
  - expired ..................................................59
  - invalid ...................................................56
  - passwords ..............................................31

**permissions**
- setting Communication Manager login permissions ..........34

**permissions** ...........................................34
- phone numbers ..........................................29
- ping .....................................................64
- port .....................................................36

**Printing Announcement Properties** ..................98

**problems**
- Before you call .......................................222
- too many users logged in ................................62

**properties**
- announcement
  - viewing ...................................................74
- Announcement Properties screen .........................143
- Announcement Property screen ........................145
Voice Announcement Manager User Reference

Communication Manager Properties .................................................. 195
Communication Manager Properties screen ................................... 174
Edit VAL Board Properties screen .................................................... 176
VAL board changing ................................................................. 41
voice system changing ............................................................... 39
entering ................................................................................. 39
properties ................................................................................. 99
properties ................................................................................. 145
properties ................................................................................. 195
Publications Catalog ................................................................... 225
Publications Center .................................................................... 225
R
recording audio files professionally ............................................. 105
audio files using a phone ............................................................. 106
audio files using computer ......................................................... 108
recording ................................................................................. 105
removing voice systems .............................................................. 81
removing ................................................................................. 81
Rename Announcement Property dialog box .................................. 197
Rename Audio File dialog box ....................................................... 198
Renaming an audio group folder ................................................... 113
Replacing VAL sources in an audio group ..................................... 123
requirements audio file format ...................................................... 104
hardware and software ............................................................... 38
requirements ............................................................................. 104
restoring .................................................................................. 84
S
S8100 converting audio files from ................................................. 111
S8100 ...................................................................................... 111
Samsung Ubigate iBG Router ....................................................... 1
scheduling creating tasks ............................................................ 124
deleting completed tasks .......................................................... 128
deleting tasks ........................................................................... 126
deleting templates ................................................................. 131
e-mail notification .................................................................... 92
modifying ................................................................................. 125
modifying templates .............................................................. 130
stopping a task .......................................................................... 127
scheduling ................................................................................. 124
SCP Server Configuration dialog box .......................................... 200
screens
Announcement Properties ......................................................... 143
Announcement Property ............................................................. 145
Back Up Audio Files and Announcement Properties ..................... 147
Backup Selected VAL Boards .................................................. 148
Broadcast Announcement Files - Select Boards by Extension ............ 154
Broadcast Announcement Files - Select Destination VAL Boards ...... 152
Broadcast Announcement Files - Select Files .................................. 150
Broadcast Announcement Files ................................................... 1
Communication Manager Properties ........................................ 174
Configure Application Specific E-mail Notification ................................ 157
Configure E-mail Notification ...................................................... 159
Connect At Startup .................................................................. 161
Copy/Delete Announcement Files .............................................. 162
Create New Task ..................................................................... 166
Create Task ............................................................................. 168
Create Template ........................................................................ 169
Edit VAL Board Properties ....................................................... 176
main
Voice Announcement Manager Tree ........................................ 18, 141
Main
Status pane .............................................................................. 20
Move Announcement Files - Select Destination VAL Board screen ... 191
Move Announcement Files - Select Files To Move ......................... 192
Move Announcement Property ................................................... 194
Register Voice System dialog box ........................................... 195
Restore Audio Files and Announcements Properties ................. 199
Select Frequency ................................................................. 207
Select VAL Boards to be backed up ........................................... 208
Select VAL Boards To Be Restored ........................................... 209
Task Editor .............................................................................. 215
Template Editor ....................................................................... 217
View Audio File Properties ....................................................... 218
Virtual VAL Boards Status ....................................................... 219
screens .................................................................................... 145
screens .................................................................................... 154
Search and Replace VAL Sources .............................................. 201
Search Results dialog box .......................................................... 202
Search Results for groups dialog box ....................................... 204
Search Task screen ................................................................. 205
Searching for VAL sources in an audio group ............................................. 122
security
assigning new Communication Manager logins and passwords .................. 31
changing Communication Manager logins .................................................. 33
setting Communication Manager login permissions ..................................... 34
Voice Announcement Manager security ..................................................... 47
security ................................................................. 99
Setting up automatic login ........................................................................... 44
shortcuts ................................................................................................. 142
ssh Key Generation dialog box .................................................................... 214
Status pane............................................................................................... 20
support
Avaya customer software admin center ..................................................... 29
general contact information ....................................................................... 223
giving us your feedback ............................................................................. 227
technical support ......................................................................................... 224
support ........................................................................................................ 29
T
tasks
creating ................................................................................................. 124
creating templates .................................................................................... 129
deleting ....................................................................................................... 126
deleting completed tasks ........................................................................... 128
deleting templates ..................................................................................... 131
modifying ................................................................................................... 125
modifying templates ................................................................................... 130
stopping a scheduled task .......................................................................... 127
tasks ........................................................................................................... 124
technical support
Avaya customer software admin center ..................................................... 29
general contact information ....................................................................... 223
technical support ......................................................................................... 224
templates
creating ................................................................................................. 129
deleting ....................................................................................................... 131
modifying ................................................................................................... 130
templates .................................................................................................... 129
testing
connection ............................................................................................... 49
testing ......................................................................................................... 48
TN760
replacing with VAL board ........................................................................... 43
TN760 .......................................................................................................... 43
Toolbar ......................................................................................................... 10, 133
Tracert ......................................................................................................... 65
training ....................................................................................................... 226
tree ............................................................................................................. 18, 141
troubleshooting
access denied .......................................................................................... 51
ASG is enabled .......................................................................................... 52
ASG is not enabled ..................................................................................... 53
Before you call ........................................................................................ 222
computer network cable .......................................................................... 66
computer network problems ..................................................................... 67
data is locked ............................................................................................. 60
general communications error ................................................................. 54
I can ' t see my VAL boards ....................................................................... 42
incorrect login ........................................................................................... 55
invalid password ....................................................................................... 56
network connection failed ......................................................................... 57
password expired ....................................................................................... 59
remote reset ............................................................................................... 61
testing a connection .................................................................................. 49
too many users .......................................................................................... 62
unexpected response ............................................................................... 63
using ping ................................................................................................... 64
using Tracert .............................................................................................. 65
Voice Announcement Manager ................................................................. 50
troubleshooting ......................................................................................... 51
U
using
ping ............................................................................................................ 64
Tracert ......................................................................................................... 65
using .......................................................................................................... 64
V
VAL
defined ..................................................................................................... 23
VAL ............................................................................................................ 23
version
viewing ..................................................................................................... 93
version ......................................................................................................... 93
View menu .................................................................................................. 12, 135
viewing
announcements ......................................................................................... 74
size of audio files ....................................................................................... 87
VAL board properties ............................................................................... 41
version ......................................................................................................... 93
virtual VAL board status ........................................................................... 46
Voice Announcement Manager version ................................................... 93
viewing ......................................................................................................... 46
virtual VAL board
status ....................................................................................................... 46
virtual VAL board ....................................................................................... 46
virtual VAL boards
  enabling and disabling ..................45
  viewing/changing the status ..........91
virtual VAL boards .....................45
Voice Announcement Manager
  adding voice systems to ..............39
  features ..................................6
  main window ............................9
  online help .............................102
Voice Announcement Manager .........39
Voice Announcement Manager properties 99

voice system
  adding to VAL Manager ...............39
  changing information ..................39
voice system ............................39
voice systems
  deleting from Voice Announcement
    Manager .................................81
voice systems ...........................81

W
What is a virtual VAL board? ..........24